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Excel is a software program developed by Microsoft for windows, macOS, android and iOS. It enables the 

users to organize, format and calculate data by using a spreadsheet system. It performs various functions that 

includes,

❖ Working with cells like Moving and copying cell data between worksheets and workbooks, Finding 

and replacing text, Sorting a range of cells etc.

❖ Formatting a Spreadsheet by Formatting text, Changing the alignment, Using borders and shading, 

Inserting/deleting columns and rows etc.

❖ Working with sheets like adding and deleting Worksheets, Moving and copying worksheets, Hiding/ 

unhiding columns and rows etc,

❖ Printing and saving a Worksheet.

❖ Creating and editing a Worksheet and so on.

ABOUT THE BOOK

The book entitled ‘Excel Foundation’ is designed for B.Com Ill-Year V-Semester students. The content provided 

in this book is strictly as per the latest (2016-17) syllabus prescribed by Osmania University.

Every concept is explained in a simple manner with sufficient number of examples so as to facilitate better 

understanding and easy learning in a shorter span of time. Keeping in view the examination pattern of B.Com 

students, this book provides the following features,

❖ List of Important Definitions and Shortcut Keys are given before the units for easy reference.

❖ Important Questions are included to help the students to prepare for Internal and External Assessment.

❖ Every unit is structured into two main sections viz., Short Questions (Part-A) and Essay Questions (Part-B) 

with solutions.

❖ Objective Type along with Very Short Answers are also given at the end of each unit.

❖ Three Model Papers are provided in order to help students to understand the paper pattern in the end 

examination.

An attempt has been made through this book to present theoretical and practical knowledge of “Excel 

Foundation”. This book is especially prepared for undergraduate students.

The table below illustrates the complete idea about the subject, which will be helpful to plan and score good marks 

in the end examinations.
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Unit No. Unit Name Unit Description

1. Introduction to Excel This unit covers the topics, Workbooks and Worksheets, Moving Around a

Worksheet, Ribbon Tabs, Types of Commands on the Ribbon, Using Shortcut

Menus, Working with Dialogue Boxes, Task Panes, Getting Started on Your

Worksheet, Creating a Chart, Printing Your Worksheet, Saving Your Worksheet, 

Exploring Data Types, Modifying Cell Contents, Deleting, Replacing, Editing

of a Cell. Some Handy Data Entry Techniques, Number Formatting.

2. Worksheet Operations This unit covers the topics, Moving and Resizing Windows, Switching Among

Windows, Activating a Worksheet, Adding, Deleting a Worksheet, Changing

a Sheet Tab Color, Rearranging Your Worksheets, Hiding, Un-hiding a

Worksheet, Worksheet View, Comparing Sheets Side by Side, Selecting 

Ranges, Complete Rows and Columns, Noncontiguous Ranges, Multi-sheet 

Ranges, Special Types of Cells. Copying or Moving Ranges. Paste Special

Dialogue Box, Adding Comments to Cells.

3. Tables and Formatting This unit covers the topics, Creating a Table, Changing the Look of a table, 

Navigating in a Table, Selecting Parts of a Table, Adding, Deleting New

Rows or Columns, Moving a Table, Working with the Total Row, Removing

Duplicate Rows from a Table, Sorting and Filtering a Table, Converting

Table into Range, Formatting Tools on the Home Tab, Mini Toolbar, Fonts,

Text Alignment, Wrapping Text to Fit a Cell, Colors and Shading, Borders

and Lines, Naming Styles.

4. Excel Files and Templates This unit covers the topics, Creating a New Workbook, Filtering Filenames, 

Saving and Auto Recovery, Password-Protecting a Workbook, Recovering 

Unsaved Work, Protect Workbook Options, Checking Compatibility, Creating 

a Excel Templates, Modifying a Template, Custom Excel Templates, Default 

Templates, Editing Your Template, Resetting the Default Workbook, Saving

Your Custom Templates, Getting Ideas for Creating Templates.

5. Printing Your Work This unit covers the topics, Normal, Page Layout, Page Break View, Choosing 

Your Printer, Specifying What You Want to Print, Changing Page Orientation, 

Specifying Paper Size, Adjusting Page Margins, Inserting a Page Break, 

Removing Manual Page Breaks, Printing Row and Column Titles, Scaling 

Printed Output, Header or Footer Options, Preventing Certain Cells, Objects

from Being Printed, Creating Custom Views of Your Worksheet. Creating

PDF Files.

It is sincerely hoped that this book will satisfy the expectations of students and at the same time helps them to score 
maximum marks in exams.

Suggestions for improvement of the book from our esteemed readers will be highly appreciated and incorporated 
in our forthcoming editions.
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UNIT-I

INTRODUCING EXCEL

Workbooks and Worksheets, Moving Around a Worksheet, Ribbon Tabs, Types of Commands on the 

Ribbon, Using Shortcut Menus, Working with Dialogue Boxes, Task Panes, Getting Started on Your 

Worksheet, Creating a Chart, Printing Your Worksheet, Saving Your Worksheet, Exploring Data Types, 

Modifying Cell Contents, Deleting, Replacing, Editing of a Cell. Some Handy Data Entry Techniques, 

Number Formatting.

UNIT-II

WORKSHEET OPERATIONS

Moving and Resizing Windows, Switching Among Windows, Activating a Worksheet, Adding, Deleting a 

Worksheet, Changing a Sheet Tab Color, Rearranging Your Worksheets, Hiding, Un-hiding a Worksheet, 

Worksheet View, Comparing Sheets Side by Side, Selecting Ranges, Complete Rows and Columns, 

Noncontiguous Ranges, Multi-sheet Ranges, Special Types of Cells. Copying or Moving Ranges. Paste 

Special Dialogue Box, Adding Comments to Cells.

UNIT-III

TABLES AND FORMATTING

Creating a Table, Changing the Look of a table, Navigating in a Table, Selecting Parts of a Table, 

Adding, Deleting New Rows or Columns, Moving a Table, Working with the Total Row, Removing 

Duplicate Rows from a Table. Sorting and Filtering a Table, Converting Table into Range. Formatting 

Tools on the Home Tab, Mini Toolbar, Fonts, Text Alignment, Wrapping Text to Fit a Cell, Colors and 

Shading, Borders and Lines. Naming Styles.
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UNIT-IV

EXCEL FILES AND TEMPLATES

Creating a New Workbook, Filtering Filenames, Saving and Auto Recovery, Password-Protecting a 

Workbook, Recovering Unsaved Work, Protect Workbook Options, Checking Compatibility. Creating 

a Excel Templates, Modifying a Template, Custom Excel Templates, Default Templates, Editing Your 

Template, Resetting the Default Workbook, Saving Your Custom Templates, Getting Ideas for Creating 

Templates.

UNIT-V

PRINTING YOUR WORK

Normal, Page Layout, Page Break View, Choosing Your Printer, Specifying What You Want to Print, 

Changing Page Orientation, Specifying Paper Size, Adjusting Page Margins, Inserting a Page Break, 

Removing Manual Page Breaks, Printing Row and Column Titles, Scaling Printed Output, Header or 

Footer Options, Preventing Certain Cells, Objects from Being Printed, Creating Custom Views of Your 

Worksheet. Creating PDF Files.



LIST OF IMPORTANT DEFINITIONS & SHORTCUTS KEYS

1. Microsoft Excel

Microsoft Excel refers to a spreadsheet application program in which data can be stored, organized, analyzed and 
manipulated.

2. Chart

A chart (or) graph is an important tool (in MS Excel) that is used to represent data in a graphical manner i.e., by 
using symbols such as bars, lines, dots, pie, etc.

3. Data Series

Data series are the set of related values which are plotted on the chart.

4. Axis

An axis refers to a reference line used for representing the dimensions of a chart.

5. Cell range

A cell range is selected group or block of cells in a worksheet.

UNIT - II

1. Range

Range refers to a set of cells selected within a worksheet

2. Active Window

An active window refers to the window on which, the user is currently working.

3. Clipboard

Clipboard refers to a memory which stores the copied data temporarily.

4. Noncontiguous

Non-contiguous ranges refer to multiple ranges that are non-adjacent to each other.

UNIT - III 5 3 ■ / :

1. Table

Arrangement of data in the form of rows and columns is referred to as “table”.

2. Filtering a Table

Filtering a table refers to the process of displaying only those records that satisfy specific criteria.

3. Font

Font can be generally defined by their typeface and size.
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LIST OF IMPORTANT DEFINITIONS & SHORTCUTS KEYS

1. Microsoft Excel

Microsoft Excel refers to a spreadsheet application program in which data can be stored, organized, analyzed and 
manipulated.

2. Chart

A chart (or) graph is an important tool (in MS Excel) that is used to represent data in a graphical manner i.e., b> 
using symbols such as bars, lines, dots, pie, etc.

3. Data Series

Data series are the set of related values which are plotted on the chart.

4. Axis

An axis refers to a reference line used for representing the dimensions of a chart.

5. Cell range

A cell range is selected group or block of cells in a worksheet.

tiggS UNIT - II

1. Range

Range refers to a set of cells selected within a worksheet

2. Active Window

An active window refers to the window on which, the user is currently working.

3. Clipboard

Clipboard refers to a memory which stores the copied data temporarily.

4. Non-contiguous

Non-contiguous ranges refer to multiple ranges that are non-adjacent to each other.
■IBIS

UNIT - III
1. Table

Arrangement of data in the form of rows and columns is referred to as “table”.

2. Filtering a Table

Filtering a table refers to the process of displaying only those records that satisfy specific criteria.

3. Font

Font can be generally defined by their typeface and size.
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L.2 EXCEL FOUNDATION

UNIT i IV

1. Template

A template is a workbook model which is used as a prototype to support other workbooks.

2. Custom Template

Custom templates refer to the templates which are created by users to make their work easier.

UNIT - V

1. Page Orientation

Page orientation deals with the way of displaying printed output on the page.

2. Margins

The blank spaces (white spaces) or non printable areas appearing at the four scales (top, bottom, left and right) of 
a printed page are referred to as margins.

SIA PUBLISHERS AND DISTRIBUTORS PVT. LTD.



IMPORTANT DEFINITIONS & SHORTCUT KEYS L.3

Shortcut Keys for MS-Office

S.No. Command Shortcut Key

1. Undo Ctrl+z

2. Redo Ctrl+y

3. Cut Ctrl+x

4. Copy Ctrl+c

5. Paste Ctrl+v

6. Left Alignment Ctrl+1

7. Right Alignment Ctrl+r

8. Find Ctrl+f

9. Replace Ctrl+h

10. File Menu Alt+f

11. Edit Menu Alt+v

12. New Ctrl+n

13. Open Ctrl+o

14. Print Ctrl+p

. 15. Print Preview Ctrl+£2

16. Save Ctrl+s

17. Spelling and Grammar F7

18. Font Ctrl+Shift+f

19. Font size Ctrl+Shift+p

20. Bold Ctrl+b

21. Underline Ctrl+u

22. Italic Ctrl+i

23. Center Ctrl+e

24. Format Painter Ctrl+Shift+c

SIA PUBLISHERS AND DISTRIBUTORS PVT. LTD.



MODELI-j
FACULTY OF COMMERCE PAPER! JL

B.Com (CBCS) Ill-Year V-Semester Examination

EXCEL FOUNDATION
( Common Paper for Computers, Computer Applications )

Time: 3 Hours Max. Marks: 80

PART - A ( 5 x 4 = 20 Marks )

Note : Answer any Five of the following questions in not exceeding 20 lines each

1. What are the steps for selecting auto formatting?

2. List the different ways of closing windows.

3. Write the steps for converting table back to range.

4. How to modify a template?

5. Discuss the steps involved in printing row and column headers in excel.

6. Write short notes on formatting numbers using the Ribbon.

7. Explain any four options present in go to special dialog box.

8. Write the steps for table creation in an empty range.

PART - B ( 5 x 12 = 60 Marks )

Note: Answer the following questions in not exceeding four pages each.

9. (a) Discuss the steps involved in creating a new chart.

OR

(b) (i) What are worksheets? Give a brief overview of worksheets.

(ii) Give a brief note on role of task panes in Excel.

10. (a) Discuss various paste options offered by excel 2013 for pasting

in special ways.

OR

(b) (i) Describe the process of adding, deleting and activating a 
worksheet in a workbook.

(ii) List the different ways of selecting range of cells and complete 
rows and columns.

(Unit-I, Page No. 3, Q7) 

(Unit-ll, Page No. 46, Q2) 

(Unit-Ill, Page No. 74, Q5) 

(Unit-IV, Page No. 119, Q6) 

(Unit-V, Page No. 141, Q7)

(Unit-I, Page No. 3, Q8) 

(Unit-ll, Page No. 47, Q5) 

(Unit-Ill, Page No. 74, Q1)

(Unit-I, Page No. 25, Q20)

(Unit-I, Page No. 7, Q11)

(Unit-I, Page No. 17, Q17)

(Unit-ll, Page No. 62, Q25)

(Unit-ll, Page No. 50, Q12)

(Unit-ll, Page No. 55, Qf7)

——----- ---------SIA PUBLISHERS AND DISTRIBUTORS PVT. LTD.
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MP.2 EXCEL FOUNDATION

11. (a) Define a table and write the steps involved in creation of a table in excel.

OR

(b) (i) How can a user select various parts of a table?

(ii) Write short notes on working with the total row in excel.

12. (a) Explain how workbooks are created and opened in Excel-2013.
Also discuss about filtering filenames.

OR

(b) Write about checking compatibility of excel files workbooks.

13. (a) Explain in detail the process of adjusting page margins.

OR

(b) (i) Discuss briefly the page layout view of excel worksheet.

(ii) List the steps involved in scaling the printed output in excel.

(Unit-Ill, Page No. 76, 09

(Unit-Ill, Page No. 84, Q11 

(Unit-Ill, Page No. 90, QU

(Unit-IV, Page No. 120, 09

(Unit-IV, Page No. 127, QU 

(Unit-V, Page No. 152, Q1'

(Unit-V, Page No. 145, Q12 

(Unit-V, Page No, 160, 02'

SIA PUBLISHERS AND DISTRIBUTORS PVT. LTD. ---------



MODEL QUESTION PAPERS WITH SOLUTIONS MP.3

FACULTY OF COMMERCE

B.Com (CBCS) Ill-Year V-Semester Examination

EXCEL FOUNDATION

( Common Paper for Computers, Computer Applications )

MODEL
PAPER !2

Time: 3 Hours Max. Marks: 80

PART - A ( 5 x 4 = 20 Marks )

Note : Answer any Five of the following questions in not exceeding 20 lines each

1. List out any four features of Ms Excel.

2. How to perform multisheet selection?

3. What are the different ways for performing sorting in excel?

4. Discuss any five options of opening a file from open dialog box.

5. What are the different views of excel worksheet?

6. List the different charts that are available in MS-Excel.

7. Discuss the process of copying and pasting using shortcut menus.

8. Write the steps for removing a filter.

PART - B ( 5 x 12 = 60 Marks )

(Unit-I, Page No. 2, Q4) 

(Unit-ll, Page No. 46, Q4) 

(Unit-Ill, Page No. 75, Q7) 

(Unit-IV, Page No. 118, Q2)

(Unit-V, Page No. 140, Q1)

(Unit-I, Page No. 3, Q6) 

(Unit-ll, Page No. 47, Q7) 

(Unit-Ill, Page No. 74, Q3)

Note: Answer the following questions in not exceeding four pages each.

9. (a) Explain the general process of creating a workbook by entering data into it. (Unit-I, Page No. 19, Q18)

OR

(b) (i) Explain how numbers can be entered and formatted in spreadsheets. (Unit-I, Page No. 38, Q26)

(ii) What are the different data types that a cell can hold in Excel? (Unit-I, Page No. 29, Q23)

10. (a) Discuss the following operations on comments,

(i) Changing shape

(ii) Reading

(iii) Printing

(iv) Hiding and unhiding

(v) Selecting

(vi) Editing

(vii) Deleting. (Unit-ll, Page No. 66, Q28)

OR
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MP.4 EXCEL FOUNDATION

(b) (i) How non-contiguous ranges can be selected in excel 2013?

(ii) Discuss about the following,

(i) Drag and drop method of copying or moving

(ii) Copying to adjacent cells

(iii) Copying a range to other sheets.

11. (a) Write about adding borders and lines in Excel.

OR

(b) (i) Write the steps involved in changing the color of a text and background, 

(ii) Where are the cell formatting tools available in Excel?

12. (a) Define a template. Discuss how a workbook can be created from a template.
Also discuss the process of modifying a template.

OR

(b) Write short notes on AutoRecover feature of Excel-2013.

13. (a) How to prevent certain cells from printing in excel?

OR

(b) (i) Explain the process of inserting a page break.

(ii) Discuss in detail the Header and Footer element codes in excel.

(Unit-ll, Page No. 56, Q18

(Unit-ll, Page No. 60, Q23 

(Unit-Ill, Page No. 103, Q24

(Unit-Ill, Page No. 102, 02: 

(Unit-Ill, Page No. 99, Q15

(Unit-IV, Page No. 128, Q15

(Unit-IV, Page No. 124, Q1' 

(Unit-V, Page No. 168, Q2~

(Unit-V, Page No. 156, Q18 

(Unit-V, Page No. 165,024

SIA PUBLISHERS AND DISTRIBUTORS PVT. LTD. -



MODEL QUESTION PAPERS WITH SOLUTIONS MP.5

FACULTY OF COMMERCE

B.Com (CBCS) Ill-Year V-Semester Examination

EXCEL FOUNDATION
( Common Paper for Computers, Computer Applications )

MODEL Q 
PAPERiO

Time: 3 Hours Max. Marks: 80

PART - A ( 5 x 4 = 20 Marks )

Note : Answer any Five of the following questions in not exceeding 20 lines each

1. Write a short note on worksheet/spreadsheet.

2. List some of the important facts regarding office clipboard.

3. What are the steps involved in inserting slicers?

4. Write short notes on custom templates.

5. How to scale the printed output?

6. Write the uses of spreadsheets/worksheets.

7. What are the steps involved in making the change shape option available?

8. Write a short note on navigation in excel.

PART - B ( 5 x 12 = 60 Marks )

Note: Answer the following questions in not exceeding four pages

9. (a) Explain the process of modifying cell contents.
»

OR

(b) (i) Explain in detail about Auto formatting and Manual formatting.

(ii) Write the steps involved in printing a worksheet.

10. (a) Write short notes on the following,

(i) Zooming worksheets

(ii) Viewing a worksheet in multiple windows

(iii) Comparing sheets side-by-side.

OR

(b) (i) Describe the process of pasting using office clipboard.

(ii) Write short notes on adding and formatting comments.

each.

(Unit-I, Page No. 2, Q1) 

(Unit-ll, Page No. 47, Q8) 

(Unit-Ill, Page No. 74, Q4) 

(Unit-IV, Page No. 119, Q8) 

(Unit-V, Page No. 142, Q9)

(Unit-I, Page No. 3, Q5) 

(Unit-ll, Page No. 48, Q10) 

(Unit-Ill, Page No. 74, Q2)

(Unit-I, Page No. 30, Q24)

(Unit-I, Page No. 39, Q27)

(Unit-I, Page No. 27,Q21)

(Unit-ll, Page No. 54, Q16)

(Unit-ll, Page No. 61,Q24) 

(Unit-ll, Page No. 65, Q27)

SIIA PUBLISHERS AND DISTRIBUTORS PVT. LTD.
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MP.6 EXCEL FOUNDATION

11. (a) Write the steps involved in,

(i) Applying styles to a cell

(ii) Modifying an existing style

(iii) Creating new styles

(iv) Merging styles from other workbooks

(v) Controlling styles with templates.

OR

(b) (i) Describe the method for moving a table to new location.

(ii) Discuss the method for removing duplicate rows from a table.

12. (a) Discuss in detail about creating and saving custom templates.

OR

(b) Discuss various ways of saving workbook.

13. (a) What are the steps considered while creating custom views for a
worksheet in excel?

OR

(b) (i) Describe the process of changing page orientation.

(ii) How to save excel worksheet in PDF or XPS format?

(Unit-Ill, Page No. 107, Q25)

(Unit-Ill, Page No. 88, Q13) 

(Unit-Ill, Page No. 91, Q15) 

(Unit-IV, Page No. 131, Q18)

(Unit-IV, Page No. 123, Q10)

(Unit-V, Page No. 175, Q29)

(Unit-V, Page No. 149, Q15) 

(Unit-V, Page No. 177, Q30)

SIA PUBLISHERS AND DISTRIBUTORS PVT. LTD.
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UNIT
INTRODUCTION TO EXCEL

SIA GROUP

f 1 A

1
( LEARNING OBJECTIVES )

After reading this unit, a student will have thorough understanding about the following key concepts,

❖ Definition of workbooks and worksheets.

❖ Use of Ribbon tabs

❖ Use of shortcut menus, task panes and dialogue boxes

❖ Process of creating a worksheet

❖ Process of creating a chart

❖ Concept of printing and saving a worksheet

❖ Types of Data Types in Excel

❖ Inserting, Deleting, Replacing and Editing a cell in a worksheet

❖ Concept of handy data entry techniques

❖ Process of Number Formatting.

( INTRODUCTION )

Microsoft excel is a spreadsheet application program in which data can be stored, organized, analyzed and 

manipulated. A spreadsheet/worksheet can be defined as a workspace that consists of interrelated columns, 

complex reports. They are built with cells arranged in the form of rows and columns. The Labels of these 

rows and columns define the address of a cell. Each individual spreadsheet file when put together forms a 

workbook. Excel provides functions which are predefined formulas that help users in performing complex 

calculations on a particular range of data.



2 EXCEL FOUNDATION

PART-A
SHORT QUESTIONS WITH SOLUTIONS

Q1. Write a short note on worksheet/spreadsheet.

Answer : Model Paper-Ill, O'

Worksheets/spreadsheets can be defined as a workspace that consists of interrelated columns and complex report 
They are built with cells arranged in the form of rows and columns. The rows are aligned horizontally across the scree: 
and columns are aligned vertically down. Usually, numbers and letters are used to design rows and columns respective. - 
Both the labels of rows and columns define the address of a cell. For example, C3 determines the third cell present in thirc 
column from the leftside of the spreadsheet. Formulas called equations can also be created in cell. A worksheet/spreadshee 
consist of tool bars such as scroll bars, menu bars, control boxes, etc. A cell in which some work is done is known as ai 
active cell whose address is displayed in the top left comer of the worksheet.

Q2. Write a short note on cell range and work book.

Answer :

Cell Range

A cell range is selected group or block of cells in a worksheet. Basically, a cell range in excel are those parameter 
which are specified in the functions of the range of the cell A1:A8 then it implies that, parameters starts from column - 
and rows 1 to 8.

Work Book

Each individual spreadsheet file when put together forms a workbook. Each workbook in Excel comprises of ore 
or more worksheets. When user opens an Excel spreadsheet program, it automatically loads empty worksheet file thi 
contains only one blank worksheets. These worksheets are accessible through the use of tabs at the bottom of the cells 
The workbooks also contain various tabs and contents that include charts, macros and custom add-ins.

Q3. Define Microsoft Excel.

Answer :

Microsoft Excel refers to a spreadsheet application program in which data can be stored, organized, analyzed anc 
manipulated. It is developed and configured by the microsoft corporation so as to provide support for the microsoft window 
and MAC operating systems. It is regarded as the most powerful spreadsheet package.

Q4. List out any four features of Ms Excel.

Answer : Model Paper-IL Q"

1. Answer Wizard

It is located in the HELP menu bar. It is used to provide answers to the queries that are asked by the users.

2. AutoCalc

It is used to automatically calculate the sum or average of a series of numbers.

3. AutoComplete

It is used to figure out the word intended by the user by just typing a few letters. That is, the words that are ahead 
been typed are displayed and from this list, the user can select the desired word.

4. AutoCorrect

It is used to automatically correct the mistakes that are made by users. Whenever required, it can be turned ON or
OFF. The users can also create their own autocorrect entries in Excel worksheet.
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Q5. Write the uses of spreadsheets/worksheets.

Answer : Model Paper-Ill, Q6

The uses of spreadsheets are as follows,

It is used for simple as well as complex tasks.

2 It is used for creating charts and graphs.

It is used for solving complicated mathematical problems, multi-step problems, taxes and so on.

- It is used in managing data like expenses, budgets, accounts and so on.

06. List the different charts that are available in MS-Excel.

.Answer : Model Paper-ll, Q6

The different types of charts that are available in MS-Excel are,

(i) Column chart

(ii) Pie chart

(iii) Bar chart

(iv) Area chart

(v) XY (Scatter) chart

(vi) Stock chart

(vii) Surface chart

(viii) Combo chart

(ix) Bubble chart

(x) Radar chart

(xi) Line chart and

Q7. What are the steps for selecting auto formatting?

Answer : Model Paper-I, Q1

The following are the steps considered so as to select a format,

(i) Select range of cells that needs to be formatted

(ii) By default “Autofbrmat” option is not available in the ribbon bar. To make it available, right click on the ribbon 
and choose customize the ribbon.

(iii) Go to format tab and select Auto format option. An Auto Format dialog box appears

(iv) Click on the option » button so as to view the extra features of a particular format.

(v) Scroll down the list under table format option so as to find the desired format

(vi) Click on the format name and view the preview of the selected format in the sample window

(vii) Select the desired format and then click the OK button

(viii) Remove certain features of table format (if required) by selecting the “Formats to Apply” section of a maximized 
Autoformat dialog box and then clearing the respective check boxes.

(ix) Click on the OK button to continue the actual formatting.

Q8. Write short notes on formatting numbers using the Ribbon.

Answer : Model Paper-I, Q6

The number group present in the home tab of the ribbon enables the user to format numbers. The number format 
drop down list includes 11 general number formats. In addition to this, there also exists accounting number format drop
down list, % button, comma(,) style button, button for increasing the number of decimal values and button for decreasing 
the number of decimal values. When the user chooses one of the above controls the current cell implements the selected 
number format. Similarly if the user selects multiple cells then the number format is applied on alFthe cells.
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PART-B

 ESSAY QUESTIONS WITH SOLUTIONS

1.1 WORKBOOKS AND WORKSHEETS, MOVING AROUND A WORKSHEET

Q9. Define Microsoft Excel. List and explain the new features included in excel.

Answer :

Microsoft Excel

Microsoft Excel refers to a spreadsheet application program in which data can be stored, organized, analyzed and 
manipulated. It is developed and configured by the Microsoft corporation so as to provide support for the Microsoft Window? 
and MAC operating systems.

Features of MS Excel

1. Answer Wizard

It is located in the HELP menu bar. It is used to provide answers to the queries that are asked by the users.

2. AutoCalc

It is used to automatically calculate the sum or average of a series of numbers.

3. AutoComplete

It is used to figure out the word intended by the user by just typing a few letters. That is, the words that are alread- 
been typed are displayed and from this list, the user can select the desired word.

4. AutoCorrect

It is used to automatically correct the mistakes that are made by users. Whenever required, it can be turned ON or
OFF. The users can also create their own autocorrect entries in Excel worksheet.

5. Autofilter with Top Ten

It is used to sort the data by selecting a column or row so that the top-ten lowest or highest values are display ac 
based on the settings made by user. Data may be monetary values or percentages. It is reached by selecting autofikr 
from data menu.

6. Better Drag-and-Drop

It is used to reposition or move the selected data by dragging with the mouse and placing in the desired position

7. Scroll Tips and Cell Tips

Scroll tips are used to provide the information about the row or column that the user is looking for. On the otfaa 
hand, cell tips are used to read the notes that are made by the user himself. This will help the user in reminding dJ 

important points about data.

8. Data Map

It is usually used by the businessmen who draw the maps of the regions of various countries in which their busines 
are located. It is also used to correlate the success of their business by representing a demographic statistics cj 
region.

9. Document Retrieval and Management

It is used to quickly retrieve the worksheets by choosing the fast find feature to easily delete or rename the files. rJ 

to preview the files before they are opened.
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10. Number Formatting

It is located in the Home menu. It is used to format the numbers by selecting the desired number style from the 
number tab. The various number formats include dates, telephone numbers and dollar amounts.

11. Shared Lists

It is used to share the worksheets that are present over a single network. Such type of sharing is also known as 
multiuser editing.

12. Templates and Template Wizard

Templates are used to design the worksheets in a fast and elegant manner. Template wizard provides a link between 
worksheets and the database so that any changes made to the database are automatically reflected in the corresponding 

work sheet.

Q10. Discuss about the various elements of the excel screen.

Answer :

The various elements of excel screen are as follows,

1. Active Cell

It is a cell where the user types in or clicks on. It contains black dark border around it.

2. File Button

This button is used to open backstage view that provides several options for setting excel attributes and operating 
with the excel document.

3. Formula Bar

It is a place where a user can enter or view formulas or text.

4. Help Button

This button is used to display excel help system window.

5. Horizontal/Vertical Scrollbar

This bar enables the user to scroll horizontally and vertically in the worksheet.

5 Macro Recorder

This icon is used to record a VBA macro and it gets modified whenever the activities are recorded in it.

Name Box

This box provides information about the selected cell or object.

New Sheet Button

This button creates a new sheet in user’s excel file.

6 Page View Buttons

This button is used to alter the way in which a worksheet is displayed.

11 Quick Access Toolbar

Quick access toolbar contains commonly used items/commands that are required to be accessed quickly. This toolbar 
s always visible in every selected tab.

Ribbon

'^hbons helps in arranging different groups of commands into categories. These categories are referred as contextual 
-irs. When a user clicks on an item in the tab list the displayed ribbon changes.
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15. Status Bar

This bar provides information regarding the status of Num Lock, Caps Lock and Scroll Lock keys on the keyboard.
It displays information such as current page or record number. A user can edit the displayed details by right clicking 

on the status bar.

17. Tab List

This icon contains various commands for displaying a different ribbon. xH

' 8. Title Bar

This bar displays the name of the program and current workbook. It contains few control buttons that enables the 

user to change the window.

19. Window Close Button

This button is used for closing the current workbook window.

20. Zoom Control

This allows the user to zoom-in and zoom-out the worksheet.

21. Window Maximize/Miximize Button

This button allows the user to minimize and maximize the workbook window.

311. What are worksheets? Give a brief overview of worksheets.

Vnswer : Model Paper-I, Q9(b)(i)

•Vorksheets/Spread Sheets

A workspace that consists of interrelated columnar and complex reports is called spreadsheets or worksheets.

Spreadsheets are built with cells arranged in the form of rows and columns. The rows are aligned horizontally across 
ne screen and columns are aligned vertically down. Usually, numbers and letters are used to design rows and columns 
espectively. Both the labels of rows and columns defines the address of a cell. For example, cell C4 determines the fourth 

; ell present in third column from the left of the spreadsheet. Formulas called equations can also be created in cells. Suppose 
f five distinct numbers have been entered from cell A1 to A5, then the cell A6 contains a formula that adds all the numbers 

- displaying the result in the cell A6 itself. The term “AutoCalc” gives the total of the numbers without creating a totals 
. lumn. By using keyboard and mouse, Excel possesses the capability of creating formulas. Also, toolbar tools, menu 
;noices and functions are provided by Excel for creating and using complex formulas.

The final work product is issued and presented by a set of formatting features. The worksheet numbers and cell 
ibels are converted into some approaches of bar charts, line graphs, pie charts, scatter charts etc.

Excel can be started in any one of the following ways,

By choosing from the start submenu.

By clicking on the Excel icon present in the office shortcut bar.

By double-clicking the Excel icon present in Windows Explorer.

By double-clicking the Excel worksheet icons and related files with the extensions such as .xlsx .xls, .xlc, .xlt, .xlm,

etc.
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A new, untitled spreadsheet is opened when any of the above ways are chosen.

Parts of a Worksheets

Name box--------

(active cell address)

Standard toolbar 

Formatting toolbar

Tip wizard toolbar

•Formula bar

■Text (labels)

The active cell

■Drawing

toolbar

Figure: Overview of Worksheet

Many conventions related to Microsoft Windows are followed by Excel. A worksheet consists of tool scroll bari. 
menu bars, control boxes, etc. Some additional tools have also been included in Excel Windows. A cell in which soon 
work is done is known as an active cell. In the above figure, cell C4 is the active cell that contains a dark border arounc r 
whenever cells are selected around it. The address of cell C4 is displayed in the left comer of the worksheet.

Uses of Worksheets

1. It is used for simple as well as complex tasks,

2. It is used for creating charts and graphs.

3. It is used for solving complicated mathematical problems, multi-step problems, taxes and so on.

4. It is used in managing data like expenses, budgets, accounts and so on._______________________________________J

Q12. What is workbook? What are the different steps that are to performed to create a new worksheet? 

Answer :

Workbooks

Each individual spreadsheet file when put together forms a workbook. Each workbook in Excel comprises of one or - t 
worksheets. When user opens an Excel spreadsheet program, it automatically loads empty worksheet file that contains one b jafc 
worksheet. These worksheets are accessible through the use of tabs at the bottom of the cells. Besides this, workbooks also cor.'-saj 
various tabs and contents that include charts, macros and custom add-ins.

Steps Involved in Creating a New Worksheet
Before starting a new project, page setup must be performed so that it determines how much information can a pad 

contain.

1. Selecting Cells

After selecting the cells, the data can be entered, edited or formatted. A single cell or multiple cells can be selecBM

(a) Selecting Cells with a Mouse

By selecting a cell with the help of mouse, it becomes active. This is done by just pointing and clicking ot 
The following techniques are used for selecting rows, columns and range of cells.
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.NIT-1 : Introduction to Excel 9
(i) A row number must be clicked so that entire row gets selected. This is shown in figure below,

A2 ▼
A BC D E FG H ▲

l
d

....... _ MHB

3

▼

4

5

\sheet 1^/Sheet^/Sheel^ < >

Figure

(ii) Similarly, the entire column of cells must be selected by pointing at the heading of the column.

(iii) The mouse pointer must be clicked and dragged for selecting a range of cells. This is shown in figure (iii).

(iv) The empty button present at the top-left comer of the worksheet must be clicked so that whole worksheet 
gets selected.

(b) Selecting Cells with the Keyboard

The following are the techniques used for selecting rows, columns and a range of cells.

(i) If some cells are already selected then with the help of SHIFT+SPACEBAR, the entire row or rows 
(wherein the cells are present) can be selected.

(ii) An entire column is selected with the help of CTRL+SPACEBAR.

(iii) The entire worksheet is selected with the help of CTRL+SHIFT+SPACEBAR.

The selections can be extended in any direction by pressing SHIFT + an appropriate arrow key. Also, 
SHIFT+CTRL+END extends the selection upto the end of the worksheet.

(c) Navigating with the Mouse and Keyboard

Navigational tools are used to move around in worksheets. The spreadsheet areas can be named by Choosing- 
Insert, Name or Define and by using the Go-To command, so that they can be found quickly. When the user 
navigates with the keyboard, each key on it assist the user in performing different tasks. The down arrow on 
the keyboard moves the active cell one row down, up arrow moves the active cell one row up, left arrow or 
shift + Tab moves the active cell one column towards the leftside, right arrow or Tab moves the active cell one 
column towards the rightside, PageUp button moves the active cell one screen up, PageDown button moves 
the active cell one screen down, Alt + PgDn shifts the active cell one screen towards right and so on. The 
functioning of keys on the numeric keypad is controlled by Num Lock key. However, the state of the Num 
Lock key doesn’t impact on these navigation keys.

When a user intends to activate specific cell and if it is not visible in the workbook window then he/she can 
navigate with mouse by scrolling the scroll bars on the window in any direction. In addition, a user can also 
zoom the worksheet by either pressing Ctrl along with mouse scroll button (or) drag with mouse the zoom 
slider present on status bar. However, by navigating through mouse the user can only scroll the worksheet but 
cannot change the active cell.

(d) Navigating with the Go To Command

The areas that are named are determined by using the Go-To command so that it becomes easy to move across 
in the large worksheets.
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10 EXCEL FOUNDATION
The Go-To Special Button

The cells that satisfy some specific criteria are selected by the Go-To special dialog box. This box contain formulas 
comments, blank cells and so on. Before using the Go-To special button, the following must be performed.

(i) The cells that are of interest must be selected, so that some cells can be examined.

(ii) A single cell must be selected, so that the entire worksheet is searched.

2. Entering and Editing Text

-♦ Cancels the entry

-*■ Concludes the text entry
■♦•Typing appears here and in the active cell

B2 ▼ x \/ ft E 2003
A B C D E F G H

1

2 E 2003

3

Activate the cell, so that the text can be entered in it. The text entered in the active cell will also appear in the Formu'.s 
bar. In order to conclude the text that has been entered in the active cell, the checkmark (L) button is clicked or 
ENTER button is pressed. To cancel the text entry, ESC key is pressed or X button is clicked in the Formula bar 
Basically, a cell can contain upto 255 characters. After entering the text, the size of cell can be increased or worc- 
wrap technique is used for the text so that the entries can be accommodated.

(a) Editing Text

If an error is seen during the text entry, then simply press the backspace button (present on the keyboard) anc 
correct it. If an error is seen after finishing the text entry then to edit the text, the cell must be activated. Th:; 
editing is done either in the activated cell or in the Formula bar. The checkmark button is clicked or the ENTER 
button is pressed whenever the corrections are completed.

(b) Replacing Text

If a new text has to be entered in a cell that already contains the text, then activate the cell and type the nev- 
text and press ENTER. This will replace the old text by the new text.

(c) Styling Text

The appearance of the text present in cells can be changed by the buttons placed on the Formatting tool ba: 
By selecting the portions of the text, they can be modified.

1.2 RIBBON TABS, TYPES OF COMMANDS ON THE RIBBON

Q13. Explain the use of Ribbon in Ms-Excel and list out the various tabs present on the Ribbon of Ms-Excel 

Answer :

Use of Ribbon

A ribbon is present at the top of the Ms-Excel window. It arranges different groups of tools and commands into 
various categories. These categories are referred to as ‘Tabs’. Each particular tab shows distinct group of commands.

Example

To display commands related to page design “page layout” tab is used. Similarly, to display commands related to 
file insertion an “Insert tab” is used and so on.
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A ribbon can be either hidden or visible. When it is hidden it appears temporarily to the user while clicking on a tab 

2nd if the user clicks on a worksheet it becomes invisible again.

The visibility of ribbon can be toggled by selecting one of the three ribbon options i.e., Auto-hide, Show Tabs and 
commands.

Ribbon Tabs

The various tabs present on the Ribbon of Ms-Excel 2013 are as follows,

1. Home Tab

The home tab defines commands that help in formatting texts, copying, pasting, inserting and deleting rows and 
columns. This tab consists of groups like Clipboard, Fonts, Alignment, Styles and Editing.

85 B a =
KW HOME INSERT PAGE LAYOUT FORMULAS DATA REVIEW MEW

■Excel

OFFICE TAB

? ffl - 3 X
Sign in

at > Wrap Text i General

B I U ’ ! ffl ’ -Y-Y g Merge Si Center • $ •% ' *8?$

9 I' * *
ai Cell „ ' " Scrta Find Si
• Styles’ S^rcnat’ £■ Filter'Select’

A A

A5 I

2. Insert Tab

The insert tab defines those commands that help in inserting objects like charts and shapes ihto a worksheet. It 
includes groups like Tables, Charts, Filters, Symbols, Text and so on.

IB W- s Book! ■ Excel 7 a - 3 X

' 'I HOME- INSERT PAGE LAYOUT FORMULAS DATA REMEW MEW OFFICE TAB Sign in

!™ SB f"8S< 1 rj) i ,|3l © gT < •sto,t if ill-s-’t- Jfa H
10 ®

. . PrvotChart Power

, View

ith, w
»|

PivotTable Recommended Table Illustrations ,

PivotTables *

Recommendefi

Charts

Line Column Win/ 

Loss

Sltcer Timeline Hyperlink Text Symbols

Tables Apps Charts G Reports Sparklines Filters Links •*

3. Page Layout Tab

The page layout tab defines those commands that help in designing a worksheet. It includes groups like Page Setup, 
Sheet Options, Scale to Fit and Arrange.

? E8J S *3’ <*' BI 4 5 Bookl-Excel

HOME INSERT j PAGE LAYOUT FORMULAS DATA REVIEW VIEW OFFICE TAB 

Colors*

a x
Sign in

Fonts’
Themes Margins Orientation Size Print Breaks Background Print
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Page Setup
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* 10^=7^ t *
Si Scale i!00% *,\ U Print

Scale to Pit Q Sheet Options r» Arrange

Titles

Bring Send Selection Align Group Rotate 
Print Forward’Backward’ Pane

B C&IH

4. Formula Tab

The formula tab contains those commands that help in inserting, controlling and auditing the excel formulas. It 
deludes groups like function library, Defined Names, Formula Auditing and Calculations.

? a9 0 *)’ <*> Si J”:.'. » BooU-Excel

HOME INSERT PAGE LAYOUT i FORMULAS \ DATA REMEW MEW OFFICE TAB 

X AutoSum ’ 00 Logical

3 X 

Sign in

A
Insert

B Recently Used ’ J Text ’

Function i Financial’ IS Date & Time’ 111 More Functions

Function Library

B Lockup & Reference* Ej Define Name * Trace Precedents §} Show Formulas

IB Math & Trig’ Use in Formula- Trace Dependents Error Checking ’ ""'
Name _ _ Watch Calculation r

Manager ©Create from Selection Remove Arrows ’ ® Evaluate Formula Win{jow Options’’

Defined Names Formula Auditing
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5. Data Tab

This tab allows the user to connect to the external data and handle the data in worksheet. It includes options like 
Power Query, Get External Data, Sort & Filter and so on.
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Filter Texttc

V Advanced Columns S Data Validation » Relationships.

Sort & Filter Data Tools
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Sign in
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Outline

6. Review Tab

The review tab defines those commands that help in reviewing a worksheet. It includes groups like Proofing, 
Language, Comments and Changes.

39 HOME INSERT PAGE LAYOUT
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Been - Excel

REVIEW «W OFFICE TAB
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Protect Protect Share 
Sheet Workbook Workbook Track Changes-

Changes

7. View Tab

The view tab defines those commands that help the users in viewing a worksheet. It includes groups like Workbook 
View, Show, Zoom, Window and Macros.
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Normal Page Break Page Custom

Preview Layout Views

Workbook Views
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8. Developer Tab

The developer tab is hidden by default. It includes commands which enable the users to display the developer tab, 
select file options and choose customize ribbon.

? H - D X 

Sign in
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Code Add-Ins Controls XML Modify *

9. Add-Ins Tab

This tab appears on screen, only when an earlier workbook is loaded. The menus and toolbars that are no longer 
available in Excel 2013 exists in Add-Ins tab.

Contextual Tabs

Besides the above conceptual tabs Ms-Excel 2013 also defines a special tab called contextual tab. This tab is visible 
only when a particular object like chart or shape is selected. These contextual tabs include commands with respect to the 
specific object the user is currently working on. For instance, when the user adds shape to a worksheet a new format tab 
appears. The contextual tab is depicted in the figure below,
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Q14. Define the various commands that are present on the Ribbon of Ms-Excel.

Answer :

The various commands present on the Ribbon of Ms-Excel 2013 are as follows,

1. Simple Buttons

Simple buttons are easy to use. These buttons carryout their task quickly and sometimes also provide a dialog box 
for entering the additional information. ‘Increase Font size’ button present in the font group of Home tab is an example of 
simple button.

2. Toggle Buttons

Toggle buttons provide some specific data by displaying two distinct colors. ‘Bold’ button in the font group of the 
home tab is an example of toggle button. A toggle button appears in its normal color when the active/current cell is not 
bold and vice versa.

3. Simple Drop-downs

A command is said to be Drop down when the ribbon command contains a small down arrow. When the user selects 
this command, it displays multiple options corresponding to conditional formatting. Conditional formatting command in 
the styles group of Home tab is an example of simple drop-down.

4. Split Buttons

A split button integrates one-click button and drop down in such a way that when the user clicks on one-click button 
command gets executed and when the user clicks on drop down arrow a list of commands are displayed. Merge & center 
command present in the alignment group of Home tab is an example of split button.
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Editing

»

14

15

1€

17

IS
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5. Check Boxes
A checkbox enables the user to easily turn off and on selections by ticking or un-ticking a box. The gridlines control 

present in the show group of view tab is an example of checkbox control. Checkboxes enable the user to select options by 
just clicking the control rather than entering a value.
6. Spinners

Spinner controls are used to increase and decrease the value of a cell. When the user clicks on the upper part of the 
spinner the value increases and similarly when the user clicks on the lower part of the spinner the value decreases.

1.3 USING SHORTCUT MENUS
Q15. Discuss about the use of shortcut menus in Excel 2013.
Answer :

Shortcut menus are the menus that appear when the user clicks on the right button of the mouse. These menus provide 
quick way to access the commonly used commands. It displays small list of actions which can be performed at some situations. 
For example, if user clicks on a table in the worksheet then a shortcut menu will appear containing all actions that can be 
performed on the table. The following figure depicts the shortcut menu that appears when the user right clicks on a cell, 8

8 B *>• rt- » >•!$’ « bmu-m ? b - a x
jUH home INSERT PAGE LAYOUT FORMULAS OATA REVIEW VIEW DEVELOPER OfFKETAB Sijnir

* seokj -
A

1
2jjohn
3 (peter

4 [Alice

5 [ Sos

ESAL EOEPT 

SOCC CSE 

70CCEEE 

60CCECE 

50GCIT

.......& - ja

EAGE ................L J A' A $ ' % * § I 

2. b i X

5 j 
9 j.
101 
nJ

12 J 
is i

14 j

15 j

16 L..
17 [

13 j 

13 J
20 J

2l| 

22 [

J61 
25 &

24.^ £opy

&> Paste Optfets.-

ft
Pasts J^edsL- 

lhsert...

...... Clear

j?3 2wck Analysis

F&sr

IQ InsertCcgjment 

forms! Cell?...

Pkfc Fr«n Orep-dettit List,. 

Define Name...

Hyperlink...

Figure
The mini toolbar present above the shortcut menu contains the commands that are used commonly from the home tab. 

This toolbar was basically developed to decrease the distance consumed by mouse while traveling around the screen for searching 
the common formatting tools. Thus, the use of shortcut menus has made the task of searching the formating tools efficient.
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1 4 WORKING WITH DIALOG BOXES
; • Write about the concept of dialog boxes in Excel.

A dialog box consists of some basic action controls but do not possess a menu bar in it. Dialog boxes are used to 
-m and finish the interactions with the other applications. They are derived always from the other windows which can 

me _er a primary or secondary window. Dialog boxes may be presented on the screen when a choice is being made or 
«r -- ■ condition appears so as to gain the user’s concentration. Generally, dialog boxes consist of ok and cancel command 
*- cermits the user to fix parameter values for the existing commands in the windows. For instance, when the user selects 
. I e .< -> Changes -> Protect sheet” then, excel displays the protect sheet dialog box as shown below where the user
a.- - ■: proceed further unless he/she specifies which part of the sheet is desired to be protected.

s--------------------©a

0 Proted worksheet and contents of locked cells 

Password to unprotect sheet:

; Allow all users of this worksheet to:

gj Select locked cells 
0 Select unlocked cells

" j Format columns 

3 Format rows 
1 Insert columns 

3 Insert rows 
3 Insert hyperlinks 

3 Delete columns 

j Delete rows

OK Cancel

Figure

Dialog boxes in excel are classified into two types,

ft Typical Dialog Box

When a typical dialog box appears on screen the user cannot perform any action unless it is terminated. It includes 
> :prions i.e., OK and cancel. On selecting the option ‘OK’ the dialog box performs, some user defined task. Similarly, 

the user selects ‘Cancel’ option the dialog box closes without carrying out any activity. The following dialog box is
r : ample of typical dialog box.

SIA PUBLISHERS AND DISTRIBUTORS PVT. LTD.



EXCEL FOUNDATION16 ___
(ii) Stay-on-top Dialog Box

1
When a stay-on-top dialog box appear on screen the user can continue working in excel. This type of dialog box 

operates similar to a toolbar. Unlike typical dialog box, it contains only close button but no ‘OK’ button. The Find and 
Replace dialog box is an example of stay-on-top or modeless dialog box. When the user clicks on Home Tab —> Find and 
Select Replace, then excel opens the Find and Replace Tab as follows,

Navigating dialog boxes is very simple task as the user has to just click on the control that he/she intends to activate. 
Moreover, the dialog box control can be accessed by not only using mouse but also via keyboard. Most of the dialog boxes 
are tabbied dialog boxes which contain tabs similar to notebooks. This type of dialog boxes are quite easy as the user can 
make multiple modifications in a single dialog box.

The format cells dialog box is an example of tabbed dialog box which occurs when the user selects a Particular Cell 
—» Right Click on the Cell —» Select Format. Then the following dialog box appears,
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1.5 TASK PANES

Q17. Give a brief note on role of task panes in Excel. 

Answer : Model Paper-I, Q9(b)(ii)

A task pane is a rectangular window that is displayed on the right side of an excel sheet. It is similar to a dialogue box 
in every manner except the fact that it appears to the user as long as the user requires it. In excel, some of the commands 
respond automatically with task panes. For instance, when the user works with an image and right clicks on it and then 
selects format picture, the excel will display format picture task pane as shown below.

(a) Inserting a picture

Ii « Picture! > Public Pictures ► Sample Pictures 

Organize ▼ New folder

J Search Sample Ptfurss>7

S’.a •

JFFICETAB

PICTURE TOOLS

FORMAT

3 X

Sign in

® Microsoft Excel

W Favorites 

fH Desktop 

iji Downloads

Recent Places

Libraries

Documents

JP Music 

S Pictures 

H ^deos

Computer

Ni
Pictures library
Sample Pictures

Arrange by: Folder ’

filename: Penguins : All Pictures

Tools Insert I Cancel

K L M N 0 P Q

’ _____ L
i

............ ....... ........................ ;..... ................ tj

. . ,.............. ’ . . I

________

(b) Picture is displayed

0 *3’ Bi I'-’©’ ? Book!-Excel PICTURE TOOLS

I HOME INSERT PAGE LAYOUT FORMULAS DATA REVIEW VIEW DEVELOPER OFFICE TAB FORMAT

C X 
Sign in

■ ' Picture 1

fl Books

A B c 0 E

ENAME ESAL EDEPT EAGE

John 8000 CSE 27

Peter 7000 EEE 26

Alice 6000 ECE 25

Bob 5000 IT 24

Vi

▼ x
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(C) Formatting a picture

SB *>’ 0 »
I HOME INSERT 

gjj Add Text’

Qi Update Table

DESIGN PAGE LAYOUT i REFERENCES MAILINGS

AB
Ifij Insert Endnote S Manage Sources

Table of

Contents ’

Table of Contents

3 Document!* - '

A5 Next Footnote

Insert

Footnote

Footnotes

APA
Insert

Citation’ Kq Bibliography-

Citations a Bibliography

Document!.-Word

REVIEW VIEW OFFICE TAB 

^InsertTable of Figures

L.S Update Table

Caption 03Cr^ Cuj

Cf„ . 
i® Copy

____J ® Paste Options:

ft,
u

Insert Mark

g Insert Index

La! Update Index

Index

(d) Format picture task pane appears on screen.

B 0 «>’ <* 8 S':’®’ •

HOME INSERT PAGE LAYOUT

Picture 1 * j

FORMULAS DATA

Book3 - Excel

REVIEW VIEW

I Save as Picture.., 

-n Change Picture.,.

§3 Hyperlink...

Insert Caption- 

Wrap Text >

Size and Position,..

Format Picture...

DEVELOPER

PICTURE TOOLS

OFFICE TAB FORMAT

S Books
A B C

1 ENAME ESAL EDEPT

2 John 8000 CSE

3 Peter 7000 EEE

4 iAlice 6000 ECE

5 Bob 5000 IT

Format Picture

fi fi H

> SHADOW

p REFLECTION

k GLOW

> SOFT EDGES

> 3-D FORMAT

» 3-D ROTATION

> ARTISTIC EFFECTS

The format picture task pane includes four icons namely fill and line, effects, size and properties and picture. Wher 
the user clicks on an icon, a command list appears below the icon tab. Now, from this list of commands when a comman: 
is selected some options corresponding to it will be displayed in a drop-down style. As there exists no “OK” button in i 
task pane the user must click on the close button for closing the task pane window. However, few task panes are not >. 
easy. Unlike dialog boxes one cannot navigate within a task pane through keyboard using Tab, Space bar, Arrow key an; 
ALT keys directly. To activate the task pane in keyboard mode the user must initially press F6 and then use the tab key, 
arrow key, spacebar and so on.
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1.6 GETTING STARTED ON YOUR WORKSHEET
Q18. Explain the general process of creating a workbook by entering data into it. 

Answer : Model Paper-ll, Q9(a)

Before starting a new project ensure that the displayed workbook is empty. Then, create a new blank workbook by 
pressing ctrl+N on keyboard or click on File -» New -» Blank workbook using the mouse pointer. Now, enter the desired 
data [e.g., sales data] into the workbook by following series of steps.

1. Selecting Cells and Entering Data into it

(a) Select a cell A1 by moving the cell pointer using the navigation keys.

(b) Enter month in cell A1 and press Enter key.

B 0 <*’ Si W’ :

HOME INSERT PAGE LAYOUT FORMULAS DATAFILE

Bookl - Excel

REVIEW VIEW DEVELOPER OFFICE TAB

; jx Month

® 0 *>’ <*’ Si - Bookl-Excel

I HOME INSERT PAGE LAYOUT FORMULAS DATA REVIEW VIEW DEVELOPER OFFICE TAB

Cl " ■ fi

G Book3* G Bookl*

1
2

A B C D E F G H I J K

Month Projected sales
'• i i’ v
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(d) Select the cell A2 and enter the name of the month [e.g., Jan] into it. Now, keep your mouse pointer over the fill 

handle, click on it and then drag down from cell A2 to cell Al3.
In this way, Excel fills name of the months automatically when you release the mouse button at cell A13.

B 0 *>’ C** S| ; Bookl-Excel

HOME INSERT PAGE LAYOUT FORMULAS DATA REVIEW VIEW DEVELOPER OFFICE TABFILE

Al fx Month

S'- Book3 * O'ESookl’ “i

A B C D E F G H I J
1 Month Projected sales
2 January
3 February
4 March
5 April
6 May
7 June
8 July
$ August
10 September
11 October
12 November
13 December
14
15

2. Entering the Sales Data
(a) Select the cell B2 and enter the projected sales for January as 5.

I B «>’ <*’ 8 ; Bookl-Excel

HOME INSERT PAGE LAYOUT FORMULAS DATA REVIEW VIEW DEVELOPER OFFICE TAB
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(b) Similarly, for entering the projected sales for February type the formula = B2* 10 in the cell B3 and press Enter key.

B *>* Si S*’®’ ’ Bookl-Excel

INSERT PAGE LAYOUT FORMULAS DATA REVIEW VIEW DEVELOPER OFFICE TAB

X ✓ fx =62*10 

<| Book3* O' Bookl* x| ]

A B C D . E F G H I J K

1 Month Projected sales
2 January i 5

3 February |=B2*10

4 March
5 April
6 May
7 June
8 July
9 [August
10 i September
11 October
. . . .. . . . . . . . . . . . . . . .
12 jNovember
13 [December

(c) Now, move to the pointer to fill handle, click on it and drag down from cell B3 to cell BI3.

(d) Excel fills the sales data from February to December automatically when you release the mouse button at cell B13.
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3.

(a)

Formatting the Numbers

Select Home tab from the Ribbon. Goto number group and click drop down number format control.
B H *>• <* a

HOME INSERT RASEIAVOUT FORMU1AS DATA RMEW WW DEVELOPER OFFICE TAB

£ &

Sign in

fi ■ =82*10
«*• c. . . . . . . .. . .Book3 

A

Month projected sales 

January 

February 

March 

April 

May 

June 

July 

August 

September 

October 

November 

December

—
FoffnaCtSs

Number s Alignment j Font | B 

i Category, 

j : General 
j i Number 

; Accounting
Date 
lime
Percentage
Fraction
Scientific
Text
Special
Custom

Sample.................

j $50.08

Qeomai places: 2 

Symbol: $

Negatwe numbers:

($1,234.10)

» x
T *

Currency formats are used for general monetary values. Use Accounting formats to align 
decimal point in a column.

AVERAGE, 5H5B5O5S505 COUNT-11 SUM: 5.5S55SE+11

(b) Select currency from the list and select the numbers by clicking on cell B2 and drag down till the cell B13.

8 H W’S ’

HOME INSERT PAGE LAYOUT FORMULAS DATA REVIEW VIEW

Bookl-Excel

DEVELOPER OFFICE TAB

B3 £ =B2*10

I© Book3*~[0'-S«,kx* « ~"S • . '

1

A B C D E F G H 1 J 1

Month Projected sales *

2 January 5
3 February $50 4 . . . . . ... :. . . .
4 March $500

.........

5 April $5,000
-- - - - -

6 May $50,000
7 June $500,000
8 July $5,000,000

9
15

August $50,000,000

September $500,000,000
11
12

October $5,000,000,000

November $50,000,000,000

13 December $500,000,000,000.

14

(c) When the displayed value contains any decimal places, Select Home —> Number Group and click on the decrease 
decimal button twice. Finally, values appear without any decimal places.
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4. Styling

(a) Click on any cell from A1 to B13.

B S *5’ ft e£x’[9’ ; Bookl-Excel

I HOME INSERT PAGE LAYOUT FORMULAS DATA REVIEW VIEW DEVELOPER OFFICE TAB

BI fx Projected sales

Q Book3* Q Bookl* 

A
1

- - - - - - - - - - - - - - - - -
Month Projected sales - ; " “

. . :. . . . ..... . J.... . . . . . . . . .
2 January 5

I

3
4

February $50
March $500

5
6
7

April $5,000
May $50,000
June $500,000

8 July $5,000,000
9 August $50,000,000
10
11

September
October

$500,000,000
$5,000,000,000

12 November $50,000,000,000
13 December $500,000,000,000

(b) Create table by selecting Insert tab -> Table.

®j 0 *>* C*
« er.
si

HOME INSERT PAGE LAYOUT FORMULAS DATA REVIEW VIEW

Bookl - Excel

DEVELOPER OFFICE TAB

(c)

0 B * *store
I?

RecommendedPivotTable Recommended Table Pictures Online

PivotTables Pictures fi-C

Tables Illustrations

MyApps
Charts

fir
Ihti*

Charts

PivotChart Power Li 

View

ii Reports

[Month Project! Table (Ctrl+T)

Create a table to organize and 

analyze related data.

Tables make it easy to sort, filter, 

and format data within a sheet.

. . w •—r”--

January
February
March

-

April
May O Te,iJune

11 £ 811

July $5,000,000
August $50,000,000
September
October

$500,000,000
$5,000,000,000

November $50,000,000,000
December $500,000,000,000 ■ ’ • • '»

“Create Table” dialog tox appears on screen.

Now click OK. As a result, excel applies its default table formatting.
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"•V »
PAGE LAYOUT FORMULAS DATA REVIEW VIEW DEVELOPER OFFICE TAB

1 N

j X
Sign in

May $50,000i

June $500,roo!

July $5,000,000!

August $50,000,000

September $500,000,000

October $5,000,000,000

November $50,000,000,000

December $500,000,000,000
Where is the data for your table?

■ . --
My table has headers

..................1
OK jj Cancel :

9

10 

11 

12

13

14

15

16

17

18 

10

5.

(a)

(b)

(c)

Grouping the Values
Select any cell in the table.

Select Table Tools —> Design -> Table Style Options —> Total Row. This creates a new row below your table. 

Click on cell B14 and select different summary formula from the drop down list.

1.7 CREATING A CHART
Q19. Define charts. Explain different parts of a chart with an example.
Answer :

Charts

A chart (or) graph is an important tool (in MS Excel) that is used to represent data in a graphical manner i.e., by 
using symbols such as bars, lines, dots, pie, etc. The information thus represented can be easily understandable by the user.

Different Parts of a Chart

Consider the following chart.

TextBox
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1. Data Series

Data series are the set of related values which are plotted on the chart. The above chart consists of only a single data 
series i.e., population which consists of 444465, 78900, 665444, 444686 and 788888.

2. Data Markers
Data markers are the representation elements (such as bars, dots, pictures, etc.,) used for representing a particular 

data point (series) within the chart. If a chart consists of more than one series then it is represented using different markers 
or same marker with different color shades.

3. Axes
An axis refers to a reference line used for representing the dimensions of a chart. Suppose, if a chart is created in 

two-dimensions then excel will plot two axes (i.e., X-axis and Y-axis). And, if the chart is created in three-dimensions then 
excel will plot three axes (i.e., X, Y and Z-axis). In the above chart, the data of city field is along X-axis and the data of 
population field is along Y-axis.

4. Category Names

Category names refer to the worksheet labels that are used for the data represented along the X-axis. Bar charts 
represents category names along the Y-axis. When a new chart is created, the category names are identified by the Chart 
Wizard and are included in it.

5. Data Series Names

Data series names refer to those worksheet labels that are used for the data represented along the Y-axis. These names 
are displayed in a box called legend. The names of different data series can be distinguished by using different samples of 
colors, shades or patterns. In the above chart, population refers to the data series name.

6. Tick Marks and Gridlines

Tick marks refer to the short lines that intersect the axes i.e., X-axis and Y-axis of the chart. These marks are used to 
distinguish the different parts of the series scale or category. The guidelines can also be inserted in the chart by choosing 
the selected grid lines option under the format menu.

7. Chart Text

,by
iser.

The text for the charts is included automatically by the chart wizard when a chart is created. However, it is even 
possible for the users to create their own text such as text boxes along with the text notes.

Q20. Discuss the steps involved in creating a new chart.
Answer : Model Paper-I, Q9(a)

1.

The steps involved in creating a new chart are as follows,

The data required to contruct a graph is initially either inserted under the tables or highlighted by clicking or dragging
the mouse across it.

I B b- d 

HOME

» - a
INSERT PAGE LAYOUT FORMULAS

TQ

MYEXCELjdsx - Excel (Product Actuation Failed)

ife Store

DATA REVIEW

I3>
PivotTable Recommended Table Pictures Online ' IflMyApps * Recommended 

PivotTables Pictures v Charts

Tables Illustrations Apps

VIEW DEVELOPER

»il ’ 5” ’ dfaft-ut-to- •«
Pr

e- ti’
Charts

PivotChart Power 

’ View

ft Reports

OFFICE TAB

|aa -jib? 1

Line Column Win/ 

Loss

Sparklines

A1 ” H fx ENAME

Q MY EXCEL.xlsx
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Select Charts option from the Insert Tab this will open a Chart Type dialog box in which vairous types of charts 
such as bar, line, pie etc., are avialable as shown below.

B « *>’ <* ■ ® £3 ,___________________
HOME i INSERT PAGE LAYOUT FORMULAS DATA REVIEW VIEW

...............

MY EXCEL *!« ■ bed (Prcduct Actwatwrt Faiieo}

i.7 s
PivotTable Recommended Table- ; Picture Online

PivotTables 
Tables

Pictures 4 
Illustrations

sf MvexceUxfrx

John SOCC CSE
?9CC £E£

*#W «K» EC?
Bob 5000 IT

DEVELOPER OFFICE TAB

Insert Chet

Recommended Charts ! :Afr Charts

il I I i
- Clustered Bar

Chart Thie

S#S i I ' 1 ••
J

Hint =«W i . i ?

!, r ft SWi- SMC SS«! 4ft» *KP «KS X05 ftSift «X» • |

.......................................................................................................... |
N — II A clustered bar chart is used to compare values across a few categories. Use 

it when the chart shows duration or when the category text is tong.

III 11 1 -
. j j. Cancel .

‘A I 4 - 1c Equation •
, •*», py, Symbol

Ils-..*..
Box & Footer i—J

3.

4.
Select the desired chart type from the “Insert Charts” dialog box and click on OK button.

Finally, the graph along with the data is represented, on the screen. If the user wants to change the title or the text in 
the graph then right click on the text select Edit text, option and type the desired text.

« a •>-<»• a s
HOME INSERT

MY EXCELMss - Excel (Product Artivetidn F«W)

PAGE LAYOUT FORMULAS DEVELOPER OFFICE TAB

CHAKITiSOLS

DESIGN ; FORMAT

& X

1< IW! *#
*** i’B

Add Chart Quick Changes 
Element - Layout- : Colors -

Chart layouts

i Chart i

. ......il
B OS illliftf

; Switch Row/ Select Change i Move 
Column Data Chart Type : Chart

Data Type I Location

»MV
5l.Z.A

Tohn 6000 CSE
Peter 7000 EE=
Alice 6000 ece

boo seco IT 4

O z-
i Style Fiji Outttrte ..

2ele?e

Reset tc Mitch Sty ie 

• O ■■ Edit T»s

: g|| Change Chart Tbps... 

SgleetData...

/t+1"

T

> - ~ ps?rn#t chart Title...

1300 20CO 5KK> «<» KXX5 6003 7000 «035

»£3£?T 8 ESAL

HOME INSERT PAGE LAYOUT FORMULAS DATA REVIEW VIEW DEVELOPER OFFKETAB : DESIGN FORMAT

^"1 ’ L. -

~ r.

& t X 

Sgnin

IL *' !
Add Chart Quick ’ Change 
Element • Layout - I Colors - 

Chart Layouts

lit
Switch Row/ Select : Change : Move 

Column Data Chart Type i Chart
Data ' Type ■■ Location

i Chart i » ; •

1
| >■ V* fx

-John
°eterAiice
Sob

3000 CSE 
7CO3EEE 
5000 ECE 
5COO-IT

Employee Decatis i-H-
vl-
¥;
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1.8 PRINTING YOUR WORKSHEET, SAVING YOUR WORKSHEET

Q21. Write the steps involved in printing a worksheet.
Answer :

The following steps are involved while printing a worksheet,
(i) Initially ensure that the chart to be printed isn’t selected. If a chart is selected already then press ESC or click any 

cell to deselect it.
(ii) Now, click on the page layout button present on the right side of the status bar. As a result, excel provides printing

preview i.e., it displays how the printed worksheet will look like.____________________
j 81 9 • Bookl-Excel MBtETOOlS

HOME INSERT PAGE LAYOUT FORMULAS DATA REVIEW VIEW DEVELOPER OFFICE TAB DESIGN

Model Paper-Ill, Q9(b)(ii)

i w • /«
5 Book3’ 0 ajrtl'

A BCD E F G H

did to add header

ESQ2ETi i UlMmir 0 ■*S ■ Said
2 i January 5

3 j February $50

4 i March $500

5 i April $5,000.

6 i May $50,000

7 i June $500,000

8 i July $5,000,000

9 i August $50,000,000

10: September $500,000,000
ll| October $5,000,000,000

1________ I

12: November $50,000,000,000

13 i December $500,000,000,000 . . 4...

(iii) Then, select File -» Print. This opens print settings dialog box where the user can make the desired changes.
Bookl - Excel

Print

S9
Print

Printer

Copies: il

.y Canon LBP6300 (redirected 1)

^^3 Re arfy: 1 docvmai-t waiting

Settings
Print Active Sheets

Only print the active sheets

Pages:

PnntOne Sided

Only punt on one side of ft..

Col.ated

W 12.3 X2J

1 Portrait Onentabon

!□
i ?r::f j Normal Margins 
±11 Left O.P Rqft: 5.?'

No Scaling

• Li t» Print sheets at ft eir actual size

(iv) Finally, click on the print button present in the upper left side of the worksheet. This prints the selected chart.
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Q22. Write the steps involved in saving a workbook.
Answer :

The following are the steps involved in saving a workbook,
(i) Goto the quick access toolbar and click on the save button present on it. But, since the workbook is still saved with 

its default name excel replies with a backstage screen. This screen prompts the user to select the location for the 
workbook and enables the user to save it on an online location or local system.

©
Info Save As

Book2 - Excel

New

Open

.Save

?□ Computer
: r£3 Computer

Recent Folders

fit Desktop

Save A; fit Yusra

My Documents»Yusra

Pnnt

Share

fir CSE

Desktop. CSE

» Apama

Export Desktop»CSE»Apama 

fir My Documents
Close

Ofhce Tab

1 1 A''" I • •

Browse

Account

Options

(ii) Choose computer and click browse. As a result “Save as” dialog box appears on screen.
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(iii) Type the name of the file to be saved as in file name field and press Enter. Finally, this saves the workbook as file.

iwith 
>r the

1.9 EXPLORING DATA TYPES
Q23. What are the different data types that a cell can hold in Excel?

Answer : Model Paper-ll, Q9(b)(ii)

In excel, a cell can hold one of the following data types,

1. Number data type

2. Text data type

3. Formulas.

1. Number Data Type

This data type is used to insert or store the numbers into the cells of the worksheet. It is usually stored in the form of 8 
bytes irrespective of whether it is large or small. Among these bytes, some of them are used for mantissa and the remaining 
are used for the characteristic. A standard named IEEE-754 standard is used for double-precision (64 bits) which defines 
the way of storing the number by using the 8-bytes. The number data type includes the following.

(i) Number Format

There are several different formats of storing a number like 2.39, 3.05%, 4.05E + 36, dates, fractions etc. These 
formats can be obtained by selecting the format menu followed by the cells option and then selecting the number 
tab. This tab has several formats from which the user can select the desired format. If the number format is to be 
removed from the cell then goto the format menu, choose the cells option, click the number tab and then select the 
general option.

(ii) Value Range

The maximum value range of number data type is >= 1.79768E + 308 and the minimum value range is <= 2.2250E
- 308.

(iii) Precision

The precision limit is the limit in which only 15 decimal or significant digits can be added before or after the number 
irrespective of its length or magnitude. This limit is applicable to only those bits of the byte that stores the mantissa 
part of the number. For instance, 294316339012456 and 0.294316339012456 can be stored in to the cell. But, if 
the numbers 2943163390124567 and 0.2943163390124567 are to be stored then there is a loss of some precision 
because of the 16th significant digit i.e., 7 at the right is neglected and stored in the cell.
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(iv) Dates and Times

The dates and times can be stored in cells by using the number data type. For instance, if 1 is stored in the cell ther. 
that number in the date format can be represented by Jan. 1,1900. This format is obtained by selecting the forma- 
menu, choosing the cells option and then selecting the number tab in which the Date option is available. Among the 
different formats, the user can select the desired format. Similarly, the time option is also available in the Number 
tab from which the user can select the desired format of the time that is to be displayed in the cell.

(v) Formulas

Formulas are evaluated based on the values that are stored in the cells. For instance, if3.486 is stored and is formatted 
upto 2 decimal places then only 3.49 value is displayed in the cell.

2. Text Data Type

This data type is also known as strings in most of the programming languages. It can have the following alphabetic 
characters a-z, A-Z, decimal digits 0-9 and special characters $, A, @, &, etc. When some data is type into the cell and it 
is not recognized by the excel the text data type is used to store such type of data. The text data type format is available in 
the format menu —> Cell option -> Number tab. For instance, a cell can hold 32,768(2A15) characters inspite of the fact 
that only 1024 characters can be displayed in the cell.

3. Formulas

If the numbers placed in the cells are need to be added, multiplied or divided, then formulas must be created. Sometimes, 
the text present in the worksheets can be manipulated using formulas. The formulas are often placed in the cell where the 
results are required to be displayed. They always begin with the equal to sign (=) and are typed in the Formula bar.

For creating formulas, the following steps must be followed,

❖ Activate the cell where the formula need to be placed.

❖ Either type an equal sign or an ampersand so that the Excel is informed about the creation of formula.

The formula can be entered one character at a time or assembled by using mouse and keyboard.

Formulas are evaluated based on the values that are stored in the cells. For instance, if 3.486 is stored and formatted 
upto 2 decimal places then only 3.49 value is displayed in the cell.

1.10 MODIFYING CELL CONTENTS - DELETING, REPLACING, EDITING OF A CELL
Q24. Explain the process of modifying cell contents. 
Answer : Model Paper-Ill, Q9(a)

(i)

(a)

The contents of a cell can be modified in the following manner,
Deleting the Cell Contents
The steps involved in deleting the contents of a cell are as follows, 
Initially, choose the cell which is to be deleted.
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(b) Now, right click on that particular cell and click on delete button.
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(c) Similarly, to delete multiple cells, select all the cells which are to be deleted and click on delete button.
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When only specific attributes of a cell are desired to be deleted then select the Home tab of the ribbon and click on 
the clear tool present in the Editing group. This displays the list of following choices,
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2.

Clear All

It deletes everything related to the cell i.e., cell contents, cell formatting and cell comment (if any).

Clear Formats

It deletes formatting applied to the cell.

A &
I ffe •

11 ’ A A

1 U ’

= $
i fe fe $/'’ * '.tto •7.6Y’A’ ee <-,8 ■»

? m -

3 Z ’ Ay

SIA PUBLISHERS AND DISTRIBUTORS PVT. LTD



32 EXCEL FOUNDATION

(ii)

(a)

Clear Contents

It deletes only information in the cell but not formatting.

Clear Comments

It deletes the comments attached to the cell.

Clear Hyperlinks

It deletes the hyperlinks present in the cell. But, this cell does not function anymore as a clickable hyperlink.

Replacing the Cell Contents

The cell contents can be replaced by the fiSHowing manner,

Click on the cell whose contents are to be replaced.
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(b) Type the desired entry into it and press Enter key. This replaces the earlier content.
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Moreover, the contents of a cell can also be replaced by dragging and dropping the content in the new cell. However, 
in both of these scenarios the formatting of the cell will be replaced by the format of the new data. Inorder to overcome 
this issue, select Home -> Clipboard -> Paste -» Values.

(iii) Editing the Cell Contents

The contents of a cell can be edited directly by typing in the formula bar as follows,
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(a) Select the cell whose contents are to be deleted and double-click on it.

(b) Now press F2 to edit the contents of a cell directly.

(c) Finally choose the cell and click inside the formula bar.

When contents of a cell are being edited excel operates in edit mode. This mode can be enabled or disabled by 
clicking on file option present in the home tab of the Ribbon -> Options -> Advanced. When excel goes in Edit mode the 
formula bar does not restrict two icons i.e., Cancel and Enter. When the user clicks on the cancel icon the editing of the cell 
contents is cancelled. On the other hand, when the user clicks on the enter icon content editing is completed and replaced 
data enters into the selected cell.

1.11 SOME HANDY DATA ENTRY TECHNIQUES
Q25. Discuss about the various data entry techniques used in excel.
Answer : l'

The following are some of the handy data entry techniques in excel,

1. Excel Moves the Cell Pointer Automatically After Entering the Content

When the user clicks on the enter key after typing the data in the cell, the pointer automatically shifts to the next 
cell down. However, this default setting can be modified by performing the following steps,

(a) Goto File tab.

(b) Click on Options.

(c) Click the Advanced tab.

In Excel, the Advanced tab can be used for making several input option settings as shown below,
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2. Navigation Keys Serves as an Enter Key

In excel, user can make use of navigation keys for completing the data entry and entering a new cell. For instance, 
to type the data in a row, click on right arrow key instead of Enter key.

3. Select Group of Cells Before Typing the Data

In excel, when multiple rows are selected then the cell pointer moves down the column and when the pointer reaches 
the end of the selected column then it shifts to the first selected cell in the subsequent column.

4. Data can be Placed in Multiple Cells by using ctrl+Enter

When the user desires to enter similarly data in multiple cells then select the cells where data is to be placed, enter 
the text or formula and press Ctrl + Enter. This inserts similar data into every selected cell.

5. Inserts the Decimal Points by Default

In excel, decimal points can be inserted automatically by performing the following steps,

(a) Click on the File tab present on the ribbon.

(b) Click on Options.

(c) Click the Advanced tab.

(d) Goto the Editing options an enable the checkbox for inserting a decimal point automatically.

(e) Select the desired number of decimal places.

(f) Click OK button to save the settings.

For instance, if the user specifies 3 decimal places then the value 1 2 3 4 5 6 will be modified as 123.456 as depicted
below,
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Use of AutoFill for Entering a List of Values

The autofill feature present in excel enables the user to insert subsequent list of values in the following,

(a) Enter the value in the cell A1.

(b) Enter some other value in cell A2.

(c) Now, select the cells Al and A2 and drag the autofill handle to complete the series of values.
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7. Use of Auto Complete Feature for Automating the Data Entry

In excel, auto complete feature is used to figure out the word intended by the user by just typing a few letters. In 
other words, it displays the words that are already been typed and from this list, the user can select the desired word.

8. Compressing the Text to Appear on New Line within a Cell

When the size of the text is too long then user can display it in more than one line by pressing ALT+Enter.

9. Use of AutoCorrect Feature

In excel, autocorrect feature can be used to automatically correct the mistakes that are made by users. Whenever 
required, it can be turned ON or OFF. The users can also create their own autocorrect entries in Excel Worksheet.

10. Inserting Numbers with Fractions

In excel, fractional numbers can be entered by performing the following steps,

(i) To enter 5y initially type the number 5 leave space and then type 1/2.

(ii) Press enter key.

(iii) Select the cell as a result 5.5 displayed in the formula bar and the cell entry is displayed as fraction.

11. Entering Data using Form

Inorder to use data entry form in excel, it must be initially added to the Quick Assess toolbar or Ribbon by performing 
the following steps,

(a) Right click on the Quick Access Toolbar and select Customize Quick Access Toolbar. Then excel options dialog 
box appears.
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From the choose commands drop down list select commands not on the ribbon, 

c) In the drop down list select Form, then click on Add button.
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(d) Click OK to close the Excel options dialog box.

Using Data Entry Form

(i) Create a table in your worksheet and

(ii) Enter the data for the specified details.

(iii) Click on any cell containing the data

(iv) Now, click on the form option present on the Quick Access Toolbar.

(v) As a result, the content of the selected cell will be displayed in the form as follow,
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12. Time Stamping a Worksheet

Worksheet in excel can be time-stamped by using the following shortcut keys.

(a) ctrl+;

It displays the current date.

(b) ctrl+shift+;

It displays the current time.

1.12 NUMBER FORMATTING
Q26. Explain how numbers can be entered and formatted in spreadsheets. 

Answer :

Entering and Formatting of Numbers

Model Paper-ll, Q9M

In spreadsheets, numbers are referred to as values or constant values. Along with numbers some special symbol 
such as + -(),.$%Ee can also be typed. If a plus sign is included along with numbers then Excel ignores it. If 
minus sign or hyphen is placed before the number or if the number is enclosed in parentheses then it is considered a< 
negative number, commas and dollar signs used along with numbers are treated in a correct way and the numbers typd 
in a scientific notation are also accepted. The format of the number changes when dollar signs, percentages or comma 
are included.
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Number Formats

Suppose if a number 2.2341645 is stored in the 
cell then Excel formats the cell at the maximum possible 
precision. Hence, the number 2.2342 is seen in the cell. 
There are other formats designed by Microsoft with which 
cells can be formatted. If these do not exist then their own 
formats can be created.

If a dollar sign is typed along with a number then 
format of the cell (which is General) is changed to a 
currency format. If a percent sign is typed, the format of the 
number present in the cell (which is General) is changed 
to a percentage format along with two decimal places (for 
Example 23.05%).

Rather than displaying the number, a series of pound 
sign (####) are displayed. This is because of a number 
which is too big that it cannot be displayed inside the cell, 
for example, if a large number is obtained by calculating the 
sum of all numbers then with the use of number formats, 
pennies and decimal points associated with the number are 
ignored even if they are entered.

Entering and Formatting Dates and Times

The dates and times are entered in the following ways,

(i) 29/6/86

(ii) 29-June-86

(iii) June 29, 1986

(iv) 11 : 30 AM

(v) 11 :30:46 AM

(vi) 18 : 12

(vii) 18:12:31

(viii) 29/6/86 18:12.

Users can also create their own date formats as, 

mmmm dd,yyyy

This format will display June 29, 1986. The date 
or time entries stored in the cell are reformatted and they 
are displayed by using one of the above predefined date 
formats.

Q27. Explain in detail about Auto formatting and Manual 
formatting.

Answer : Model Paper-Ill, Q9(b)(i)

Auto Formatting

Auto formatting is a feature of MS-Excel. This 
feature uses “Table Formats” which are generally the 
set of predefined formats. These formats are defined for 
numbers, fonts, patterns, row height, column width. The 
users have the option of either using these formats “as- 
they” are or modifying certain characteristics based on 
the requirements.

Steps for Selecting a Format

The following are the steps considered so as to select 
a format,

(i) Select range of cells that needs to be formatted

(ii) By default “Auto format” option is not available 
in the ribbon. To make it available, go to the 
“customize quick access toolbar” -» Select 
the “Commands not in the ribbon” -> Select 
“Autoformat” option -> click on “Add” button.

(iii) Click tire “Auto Format” option on title bar.

(iv) Go to Format tab and select Auto Format option. 
An Auto Format dialog box appears.

(v) Click on the option » button so as to view the 
extra features of a particular format.

(vi) Scroll down the list under table format option 
so as to find the desired format

(vii) Click on the format name and view the preview 
of the selected format in the sample window

(viii) Select the desired format and then click the OK 
button

(ix) Remove certain features of table format 
(if required) by selecting the “Formats to Apply” 
section of a maximized Autoformat dialog box 
and then clearing the respective check boxes.

(x) Click on the OK button to continue the actual 
formatting.

Manual Formatting

In manual formatting, the users himself performs 
the necessary formatting changes using standard toolbar, 
formatting toolbar or the keyboard. For example, if the 
selected text needs to be underlined, then the user can use 
either of the given options.

(i) Click the underline (U) button, under format toolbar

(ii) Press Ctrl + U keys using the keyboard.

Generally, the first option is preferred by novice users 
and the second option is preferred by the experienced users. 
The selection of cell is necessary prior to changes, because it 
is possible that these changes affect the size of cell content, 
which in turn modifies the column width or row height.

Q28. Explain the concept of styles in MS-Excel.

Answer :

Styles

Styles are the set of formatting decisions, related to 
number format, border specifications, pattern selections, 
alignment instructions. MS Excel offers different predefined 
styles, which the users can use as they are or can modify them 
based on their requirements. It is even possible to create a 
new style and copy a style from one worksheet to another. 
MS-Excel automatically, saves the created styles within the 
respective worksheet.
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Steps for Applying the Styles

The following are the steps considered so as to apply 
the predefined style within a worksheet,

(i) Select the cell(s) that needs to be formatted.

(ii) Select the cell Style option under the Styles tab. A 
Style dialog box appears

(iii) Select the desired style from the drop-down list of 
style name

(iv) Click on the desired style name

(v) The selected style is applied to the selected cell.

Steps for Creating a New Style

The following are the steps for creating a new style 
within a worksheet,

(i) Format the cell as per the requirement

(ii) Select the Cell Style option under Style tab on the 
active cell. A Style dialog box appears. Choose the 
new cell style.

(iii) Enter the name of new style in the style name text box.

(iv) Click on OK button so as to save the created style. 

The created style is added to the drop-down list.

Steps for Modifying the Existing Style

The following are the steps considered so as to modify 
an existing style,

(i) Modify the cell consisting of desired style

(ii) Select the Cell Style option under Style tab.

(iii) Click on the drop-down list under Style Name option.

(iv) Right click on an existing (old) Style Name from the 
list to show the Modify option.

(v) Click on the Modify option. It will show the “Style” 
window. Then redefine it with the required changes.

(vi) Finally click on “OK” button.

Steps for Deleting the Styles

The following are the steps considered so as to delete
a style,

(i) Select the cell styles under styles tab. A style dialog 
box appears.

(ii) Right click on the Style Name that needs to be deleted

(iii) Click on delete button.

The selected Style Name will be deleted from the 
drop-down list.
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Q29. Write short notes on the following,

(a) Formatting numbers using the Ribbon.

(b) Formatting numbers using the shortcut 
keys.

Answer :

(a) Formatting Numbers Using the Ribbon

The number group present in the home tab of the 
ribbon enables the user to format numbers. The iiumlx- 
forlnat drop down list includes 11 general number format 
In addition to this, there also exists accounting number 
format drop-down list, % button, comma(,) style butte:, 
button for increasing the number of decimal values anc 
button for decreasing the number of decimal values. ANT. a 
the user chooses one of the above controls the current ed 
implements the selected number format. Similarly if the use 
selects multiple cells then the number format is appliec a 
all the cells.

(b) Formatting Numbers by using Shortcut Keys

Number formatting can also be done by using 
following shortcut keys,

(i) Ctrl + Shift + ~

This helps in performing general number forma:

(ii) Ctrl + Shift + $

This helps in performing the number forma: 
numbers with two decimal values.

(iii) Ctrl + Shift + %

It performs percentage format on numbers conta^i 
no decimal places.

(iv) Ctrl + Shift + A

It performs scientific notation number forma 
numbers with two decimal places.

(v) Ctrl + Shift + #

It formats date i.e., day, month and year.

(vi) Ctrl + Shift + @

It formats time i.e., hour, minute, AM or PM.

(vii) Ctrl + Shift + !

It applies formatting of numbers with two di 
values, thousands separator and a hyphen.
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INTERNAL ASSESSMENT
1. Multiple Choice Questions

1. feature is located in the HELP menu bar. [ ]

(a) Auto calc

(b) Answer wizard

(c) Number formatting

(d) None of the above

2. is used to share the worksheets that are present over a single network. [ ]

(a) Shared list

V (b) Drop down list

(c) Both (a) & (b) ’

(d) None of the above

3. is used to automatically correct the mistakes that are made by users. [ 1

(a) Auto complete

(b) Auto correct

(c) Auto calc

(d) Answer wizard

4. is used to provide the information about row or column that the user is looking for. [ ]

(a) Cell tips

(b) Auto complete

(c) Scroll tips

(d) None of the above

5. tools are used to move around in worksheets. [ ]

I (a) Formatting tools

(b) Navigational tools

(c) Automation tools

(d) Animation tools

6. is an important tool that is used to represent data in graphical manner. [ ]

(a) Chart

(b) Graph

(c) Both (a) and (b)

(d) Worksheet
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7. data type is used to insert or store the numbers into the cells of worksheet.

(a) Number data type

(b) Text data type

(c) Boolean data type

(d) All of the above

8. data type is known as strings in most of the programming languages.

(a) Boolean

(b) Text

(c) Numeric

(d) Error

9. is used to calculate the sum or average of numbers.

(a) Number formatting

(b) Auto calc

(c) MIN

(d) MAX

10. performs textual processing.

(a) Arithmetic formulas

(b) Comparison formulas

(c) Average formulas

(d) Textual formulas

II. Fill in the Blanks

1. ________ is a spreadsheet application program in which data can be stored, organized analyzed and manipui

2. Each individual spreadsheet file when put together forms a________ .

3. A cell in which some work is done is known as________ .

4. A . consists of toolbars such as scroll bars, menu bar, control boxes etc.

5. ________ are used for creating charts and graphs.

6. ________ is a visual representation of data present on the worksheet.

7. In spreadsheets, numbers are referred to as________ or_________ .

8. ________ feature uses “Table formats”.

9. In________ formatting the users himself performs the necessary formatting changes.

10. ________ refers to a tool which allows the selection of certain range of cells that are of interest.

SIA PUBLISHERS AND DISTRIBUTORS PVT. LTD.



UNIT-1 : Introduction to Excel 43

KEY? ,v\,v ?«.'■» t'lfr

I. Multiple Choice Questions

1. (b) 2. (a) 3. b) 4. (c) 5. (b)

6. (c) 7. (a) 8. (b) 9. (b) 10. (d)

II. Fill in the Blanks

1. Microsoft Excel

2. Workbook

3. Active cell

4. Worksheet

5. Worksheets

6. Chart

7. Values, Constant values

8. Auto formatting

9. Manual

10. Autofill.
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III. Very Short Questions and Answers
Q1. Define cell range.

Answer :

A cell range is selected group or block of cells in a worksheet. Basically, a cell range in excel are those parameters 
which are specified in the functions of the range of the cell A1 :A8 then it implies that, parameters starts from column 
A and rows 1 to 8.

Q2. Define chart.

Answer :

Chart is a visual representation of data present on the worksheet. It displays numeric data in graphical format. It is a picture 
which summarizes numeric data and their interrelationships.

Q3. List out the different data types in Excel.

Answer :

The different data types used in excel are,

(i) Numeric value

(ii) Text

(iii) Formula

Q4. What is the use of formulas in Excel?

Answer :

In excel formulas must be created when the numbers placed in the cells are need to be added, multiplied or divided 
They are evaluated based on the values stored in the cells.

Q5. List out the choices present in the delete command’s drop down list.

Answer :

The following choices are present in the delete command’s drop down list,

(i) Clear All

(ii) Clear formats

(iii) Clear contents

(iv) Clear comments

(v) Clear hyperlinks.
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After studying this unit, a student will have thorough understanding about the following key concepts,

> Moving, resizing and switching among windows

> Activating, adding and deleting a worksheets

> Arranging and protecting worksheets

> Viewing worksheets in different ways

> Various ways of selecting cell ranges

> Copying and moving ranges

> Pasting in special ways

> Adding and formatting comments.

( INTRODUCTION )

Excel-2013 allows both opening of workbooks in a single window and multiple windows. These windows can 

be moved, resized and maximized accordingly in many different ways. Within a single window or workbook, 

many different worksheets can be added. To switch among these worksheets, sheet tabs are used. Using 

these sheet tabs, worksheets can be activated, deleted, rearranged, hide and unhide accordingly. Moreover, 

worksheets can be viewed in different ways by zooming in and out, viewing them in multiple windows and 

comparing them side-by-side. These sheets can be protected from unauthorized editing, deleting and copying 

using protect worksheet option.

Cell range refers to a set of cells that can be selected at a time within a worksheet. Excel-2013 offers selection 

of both contiguous and non-contiguous cells. Contiguous cells refer to the cells that are adjacent to each other 

whereas non-contiguous cells refer to the cells that are not adjacent to each other. Moreover, excel also offers 

selection of cell ranges from multiple sheets at a time.

Excel offers many different options to assist copying and moving of cell ranges. Some of these options are 

drag and drop, shortcut menus, shortcut keys, ribbon commands, office clipboard etc. Using office keyboard, 

the copied data can be pasted in different ways such as transposing rows and columns, skipping blanks, pasting 

only formulas, pasting only values etc.
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PART-A

SHORT QUESTIONS WITH SOLUTIONS

1311

Q1. Write short notes on activating a worksheet.

Answer :

In a workbook, only one sheet can be active at a given time. To switch to another worksheet or to activate a differed 
worksheet, its name (or Sheet tab) can be clicked directly. The names of sheets are displayed at the bottom of the wind : - 
The shortcut keys used for switching among worksheets are Ctrl + Page Up and Ctrl + Page Down for activating previ. _ 
and next sheets respectively.

In case, if the workbook has many worksheets, the names of worksheets can be browsed using tab scrolling conr « 
present on the left side of the sheet tabs.

Q2. List the different ways of closing windows.

Answer : Model Papers CC

Excel 2013 windows can be closed in different ways which are as follows,

❖ The simplest way of closing the window is to click on the close El button present on the top right comer c: re 
window (title bar).

❖ The active window can be closed by pressing Alt + F4 keys on the keyboard.

❖ The active window can also be closed by pressing Ctrl + W keys on the keyboard.

❖ The less preferred way of closing active window is by clicking File menu and selecting close option from the Lx

If the file to be closed is already saved, it is directly closed. Else, a message is displayed providing three o] 
either to save, don't save or cancel the operation. 

Q3. List the different ways of zooming worksheet window.

Answer :

There are different ways of zooming-in and out a worksheet window,

❖ The status bar at the bottom carries a zoom slider using which the active worksheet can be zoom-in and out.

❖ Scrolling the mouse wheel while holding Ctrl button performs zooming of active window.

❖ Select View Menu -> Zoom. It opens a zoom dialog box displaying a set of zooming options.

❖ Excel also supports zooming of specific range of cells. To do so, select the range to be zoomed in and goto V
Menu -> Zoom -> Zoom to selection. This option fits the selected cells to the window.

Q4. How to perform multisheet selection?

Answer : Model Paper-L

Multisheet selection can be performed as follows,

❖ Select the first worksheet by clicking on the sheet tab.

❖ Select any range of cells in the active worksheet.

❖ Click the last worksheet while holding the shift key. Upon doing this, all the worksheets in the workbook are selera

❖ The name of the workbook shows [Group] on the title bar indicating that all the sheets within this workbook : 
group mode.

❖ Apply required formatting on the selected range such as making the text bold or italic, increasing the size c f 
applying background etc.

❖ After performing required formatting operations, click on any of the sheet tab to save changes and exit the g~ 
mode.
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PART-A

SHORT QUESTIONS WITH SOLUTIONS
Q1. Write short notes on activating a worksheet.

Answer :

In a workbook, only one sheet can be active at a given time. To switch to another worksheet or to activate a differed 
worksheet, its name (or Sheet tab) can be clicked directly. The names of sheets are displayed at the bottom of the windc - 
The shortcut keys used for switching among worksheets are Ctrl + Page Up and Ctrl + Page Down for activating previous 
and next sheets respectively.

In case, if the workbook has many worksheets, the names of worksheets can be browsed using tab scrolling contr s 
present on the left side of the sheet tabs. 

Q2. List the different ways of closing windows.

Answer : Model Paper-L oc

Excel 2013 windows can be closed in different ways which are as follows,

❖ The simplest way of closing the window is to click on the close El button present on the top right comer of "c 
window (title bar).

❖ The active window can be closed by pressing Alt + F4 keys on the keyboard.

❖ The active window can also be closed by pressing Ctrl + W keys on the keyboard.

❖ The less preferred way of closing active window is by clicking File menu and selecting close option from the . -

If the file to be closed is already saved, it is directly closed. Else, a message is displayed providing three op: : 
either to save, don't save or cancel the operation. 

Q3. List the different ways of zooming worksheet window.

Answer :

There are different ways of zooming-in and out a worksheet window,

❖ The status bar at the bottom carries a zoom slider using which the active worksheet can be zoom-in and out.

❖ Scrolling the mouse wheel while holding Ctrl button performs zooming of active window.

❖ Select View Menu -> Zoom. It opens a zoom dialog box displaying a set of zooming options.

❖ Excel also supports zooming of specific range of cells. To do so, select the range to be zoomed in and goto Vi
Menu -» Zoom -> Zoom to selection. This option fits the selected cells to the window.

Q4. How to perform multisheet selection?

Answer : Model PapeM

Multisheet selection can be performed as follows,

❖ Select the first worksheet by clicking on the sheet tab.

❖ Select any range of cells in the active worksheet.

❖ Click the last worksheet while holding the shift key. Upon doing this, all the worksheets in the workbook are se

❖ The name of the workbook shows [Group] on the title bar indicating that all the sheets within this workbook ari 
group mode.

❖ Apply required formatting on the selected range such as making the text bold or italic, increasing the size cf ■ 
applying background etc.

❖ After performing required formatting operations, click on any of the sheet tab to save changes and exit the rw 
mode.
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Q5. Explain any four options present in go to special dialog box. ,

Answer : Model Paper-I, Q7

Different options present in the go to special dialog box are described below,

1. Comments

It is used for selecting the cells carrying comments.

2. Constants

It is used for selecting the cells carrying text, numbers etc., but do not carry formulas. Upon selecting this option, 
four check boxes gets activated including numbers, text, logical and errors. The desired once can be selected among 
these four.

3. Formulas

It is used for selecting the cells carrying formulas. It also activates the above four additional options i.e., text, 
numbers, logical and errors.

4. Blanks

It is used for selecting the cells that do not carry any data in it. If range is not specified, it selects all the blank cells 
______that can be displayed on the screen._____________________ ________ __________________________________________

Q6. Write a brief note on copying cell/range using ribbon commands.

Answer :

The data that is copied or cut is maintained in a temporary location called clipboard. This data is replaced with the 
newly copied or cut data. Using ribbon commands, the copy and paste operations can be performed as follows,

❖ To copy a range, select it and go to Home -> Clipboard -» Copy. The selected range will be highlighted and copied 
to the clipboard.

❖ To paste the copied range, select the destination and go to Home -» Clipboard -> Paste. This command can be used 
multiple times.

❖ An alternative to paste using above method is to press Enter key. It directly pastes the copied range and deletes it 
from the clipboard.

When copy operation is performed more than once, excel automatically displays the clipboard.

Q7. Discuss the process of copying and pasting using shortcut menus.

Answer : Model Paper-ll, Q7

Copy-paste operations can be performed using shortcut menus in the following way,

1. Select the cells or range of cells and right-click on it. A shortcut menu appears which displays a list of options. In 
the displayed list, select copy option. Then that selected range of cells with data (or) without data gets copied.

2. To paste the copied data, go to the destination cell and right click on it. In the displayed menu, click on paste option.

3. Instead of using paste option, Enter key can be pressed. It directly pastes the copied range and deletes it from the
______clipboard._____________________________________________________ r ______________________________________

Q8. List some of the important facts regarding office clipboard.

Answer : Model Paper-Ill, Q2

The following are some of the important facts regarding office clipboard.

1. When paste operation is performed using shortcut key (i.e., ctrl+v) or Home -» Clipboard -> Paste, only the most 
recently copied data is pasted.

2. The mostly recently copied data or item is placed in both office clipboard and windows clipboard.

3. When paste option or Paste All option is used from clipboard task pane, all the pasted contents are placed in the 
windows clipboard as a single item.

4. When the items from office clipboard is deleted, it is also deleted from windows clipboard.
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Q9. Discuss the column widths, skip blanks and transpose options of paste-special dialog box.

Answer :
Column Width

This option can be selected to set the destination column width as source.

Skip Blanks

This option can be selected to skip the cells that do not carry any value or contents in it. These cells do not replace 
the destination cells.

Transpose

This option can be selected to paste the copied data in a different orientation. This means that the rows are convert©: 
to columns and the columns are converted to rows.

Q10. What are the steps involved in making the change shape option available?

Answer : Model Paper-Ill, V

To make the change shape option available, the following steps need to be performed.

❖ Firstly, right-click on the empty space of the quick-access tool bar and select "customize Quick Access Tool Bar'

❖ An excel options dialog box appears with "Quick Access Tool Bar" selected by default.

In this dialog box, click on the drop-down arrow which is present below “Choose Commands From”.

❖ In the appeared list, find and select "Drawing Tools Format Tab".

❖ A list of options appears in the left pane. In that list, click on “Change Shape” and click Add button.

❖ Finally, click on the OK button.
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place

PART-B■ ' ■ < - © 7 ' ■ ■ s '■ 7' . ' . 1 . . . i 7 ...... .

ESSAY QUESTIONS WITH SOLUTIONS

2.1 MOVING AND RESIZING WINDOWS, SWITCHING AMONG WINDOWS
Q11. Explain how excel window can be moved and resized. Also explain various ways of switching among 

windows.

'erted

-III, Q7

Bar".

Answer :

Moving and Resizing Windows

Excel 2013 supports opening of multiple workbooks or files in a single excel window. This window can be moved 
and resized accordingly. However, window need not to be in maximized mode in order to be moved or resized.

The simplest way of moving a window is through drag and drop while holding its title bar using mouse. However 
to resize the window, its border can be clicked and dragged accordingly. When the mouse pointer is placed on the border 
of window, it turns into a double arrow (<->) indicating that the window can be resized in that direction. To increase or 
decrease the overall size of the window (i.e., both horizontal and vertical size), it can be done by dragging the window 
from any of its comers.

The opened windows altogether can be resized and arranged in a specific manner using “Arrange A11” option present 
in view -> window menu. Upon activating this option, an “Arrange Window” dialog box appears which offers various 
options for arranging the windows on the screen.

11

to

on

VIEW

S3
OFFICE TAB

Switching among Windows

New Window P"*! Split 

A Arrange All Pj Hide 

EEj Freeze Panes ” ©j Unhide 

Window

angeWin 

Arrange 

SMliled 

© Horizontal 

© Vertical 

© Cascade

[ : Windows of active workbook

OK Cancel

An active window refers to the one, on which user is currently working. There can be only a single active window 
irrespective of number of opened windows. It appears on the top of all the windows. To work on a different worked, it 
must be made active. In other words, users need to switch, to the desired window inorder to make it as active. Switching 
of windows can be done in the following ways,

❖ The simplest way of switching to another window is by clicking the desired window, if it is visible. However, this 
method is not applicable if the window is not visible or the current window is maximized.

❖ The opened windows can be browsed one after the other by pressing Ctrl + F6 continuously until the desired window 
is displayed. The preview of windows can be browsed in opposite direction by pressing Shift + Ctrl + F6.
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50 excel foundation
❖ The desired window can be selected from the list generated on clicking View —» Window -» Switch Window. This 

list displays only nine opened window names. To browse additional names, click on “More Windows” which is 
displayed at the end of the list.

❖ All the opened windows of excel are collectively gathered in the excel icon present on the taskbar. Users can click 
on this icon to display preview of all the opened windows and select the desired one.

2.2 ACTIVATING A WORKSHEET, ADDING, DELETING AWORKSHEET
Q12. Describe the process of adding, deleting and activating a worksheet in a workbook.

Answer : Model Paper-I, Q10(b)(i)

Adding a Worksheet to Workbook

Excel allows multiple worksheets to be placed in a single workbook. For example, employees data can be divided 
based on departments and saved in different worksheets within a single “Employees” workbook.

A new worksheet can be added to an existing workbook in the following ways,

1. A new sheet can be added by simply clicking on the plus(+) present on the right side of last sheet tab. This plm 
button is called as New Sheet Control. Upon clicking this button, a new sheet is directly added in the workboo? 
after the active sheet.

2. It can also be added by pressing Shift + Fl 1 keys on the keyboard. It adds the new sheet before the active sheet.

3. A new sheet can also be added by right clicking on any sheet name(tab) and selecting Insert. In the Insert dialog box 
select General tab and then click on worksheet icon. Finally, click on Ok button to add the new worksheet before 
the active one.

Deleting a Worksheet

Excel allows deletion of unnecessary worksheets from the workbook. These worksheets can be either empty or ft] 

with data. Deletion can be performed in the following ways,

1. A worksheet can be deleted by right-clicking on its name(i.e., Sheet tab) and selecting delete option.

2. Another way of deleting worksheet is to select Home -> Cells —» Delete -> Delete Sheet option.

The worksheet is directly deleted if it doesnot contain any data. Else, the following message box appears. 
r —  ■

Microsoft Excel |w£3w

You can't undo deleting sheets, and you might be removing some data. If you don't need it, click Delete.

Delete j Cancel

Excel-2013 also allows multiple sheets to be deleted simultaneously. To do so, select the sheet to be delete; 
holding Ctrl key and clicking the sheets and then follow any of the above methods.

Activating a Worksheet

In a workbook, only one sheet can be active at a time. To switch to another worksheet or to activate a di: 
worksheet, its name (or Sheet tab) can be clicked directly. The names of sheets are displayed at the bottom of the wi 
The shortcut keys used for switching among worksheets are Ctrl + Page Up and Ctrl + Page Down for activating pr 

and next sheets respectively.
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In case, if the workbook has many worksheets, the names of worksheets can be browsed using tab scrolling controls 
present on the left side of the sheet tabs.

2.3 CHANGING A SHEET TAB COLOR, REARRANGING YOUR WORKSHEETS, HIDING, 
UNHIDING A WORKSHEET

Q13. How to change the colour of a sheet tab? Also discuss the process of hiding and unhiding worksheets. 

Answer :

Changing the Colour of Sheet Tab

Sheet tabs are similar to buttons which activates the sheets upon clicking. They carry names written on them. The 
colour of these tabs can be changed accordingly so that they can be uniquely identified. This can be done by right-clicking 
on the sheet tab and selecting ‘Tab Color’ option from the menu/list of options. Upon clicking ‘Tab Color’, a color selector 
dialog box appears from which, desired colour can be selected. The colour of the names written on sheet tabs is selected 
automatically based on the selected background colour. Excel 2013 allow its users to change the font colour of the sheet 
names.

9 Insert...

Delete

Rename

Move or Copy...

10

11

12

13

14
q] View Code

12 Protect Sheet.,.15

16 Tab Color ►

17 •
Hide

Unhide,.,
18

19

2fL Select All Sheets

< ► ... Sales ] Inv ... (+) ■ • |

1 RE4iDY ffl H E-----

Standard Co Blue, Accent 1, Da

■ ■ «
i No Color

More Colors...

Hiding a Worksheet

Users of Excel-2013 are facilitated with certain privacy based options such as hiding worksheets. A worksheet is 
made to hide if the contents present in it are private. However, all the sheets of a workbook cannot be hidden. Users need 
to keep minimum one sheet visible.

A worksheet can be made hidden from the workbook by right-clicking on its sheet tab and selecting “Hide sheet” 
option from the list of options.

Unhiding a Worksheet

The process of unhiding worksheets is similar to the process of hiding worksheets. To unhide a worksheet, right
click on any of the sheet tab and select “Unhide sheet” option. Upon clicking this, Unhide dialog box appears in which all 
•he hidden worksheet names are displayed. Select the desired worksheet and click on OK button.
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Excel-2013 doesnot allow unhiding multiple sheets at once. Therefore, users need to follow the process multiple 
times to unhide more than one worksheet.

Q14. Explain about rearranging the order of worksheets.

Answer :

Excel-2013 allows its users to arrange the worksheets manually in a specific order. It also allows moving or copying 
of worksheets to a different workbook.

To move or copy a worksheet any of the following methods can be adopted,

❖ A worksheet can be moved or copied by right-clicking on it and selecting Move or Copy option from the appeared 
menu. Upon clicking, a Move or Copy dialog box appears. To move the sheet to a different workbook, select the 
destination in the “To book” drop-down menu and select where to place it among the sheets present within the 
workbook by selecting the sheet before which it needs to be inserted and finally click on OK button. If worksheet? 
needs to be copied instead of moving, create a copy option needs to be checked.

A worksheet can also be moved by clicking and dragging it to the desired location within the workbook. If it neej 
to be moved to a different workbook, open it and restore the window by selecting “Arrange all” option under vied 
menu. Now, click on the sheet that needs to be moved and drag it to the destination workbook. While dragging. 
mouse pointer carries a small file-shaped icon indicating that the sheet is getting moved. Drop the sheet accordir.251 
in the destination workbook.

❖ A worksheet can be copied to a different workbook in a way similar to moving a worksheet. To copy the worksh ee. 
follow the same process while pressing the Ctrl key. Here, the mouse pointer carries a small file-shaped symbol 
a plus sign indicating that the worksheet is getting copied.

In case if the destination workbook already has a sheet with the same name, the newly copied sheet is renama 
automatically to avoid naming conflicts.
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Q15. Discuss the process of protecting workbooks from various operations like inserting, renaming, copying 
or deleting worksheets.

Answer :

Excel-2013 provides an effective way of protecting worksheet from unauthorized inserting, copying or deleting of 
worksheets. To protect the workbook, the following steps need to be followed,

1.

2.

3.

Open the workbook to be protected and click on Review -> Changes -» Protect Workbook.

Upon clicking, a dialog box “Protect Workbook” appears in which structure is checked by-default. 

Specify a password if required or else, directly click on OK button.

Protect Structure and Windows

Protect workbook for 

H Structure 

L,J Windows

Password (optional):

® I~£a-J

OK Cancel

This option disables many operations that can be performed on sheet tabs such as insert, delete, rename, copy, hide 
etc. To verify this, right-click on the sheet tab. It can be seen that all these options are disabled. However, if password is 
not specified, then this protection can be easily disabled.

Another way of protecting worksheets is to use “very hidden” option. With this option, the hidden sheet is not 
displayed even in the unhide worksheet dialog box. To activate this option, follow these steps,

1. Open the worksheet

2. Go to Developer -» Controls -> Properties.

In the properties dialog box, select “2-xlSheetVeryHidden” option in the drop-down menu of visible.

Properties

j Sheet 1 Worksheet 

Alphabetic j Categorized

“21

(Name)

DisplayPageSreaks
DisplayRightToLeft

Sheetl
False
False
False

True

EnableAutoFilter 
EnableCalculation 
EnableFormatConditionsCalculati T rue

EnableOutlining_________ I False
EnablePivotTable False
EnableSelection

Name ____ _
ScrollArea __ _
StandardWidth

0 - xlNoRestrictions 

Accounts___ __  __

8.43
Visible
L

0 - xlSheetHidden 
2 - xlSheetVeryHidden

To unhide the very hidden sheet, press Alt + F11 and select the workbook in which that sheet is present in the Projects 
«.ndow. After this, click on the name of the sheet and press F4. Under properties dialog box, unhide the sheet and open
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2.4 WORKSHEET VIEW, COMPARING SHEETS SIDE-BY-SIDE
Q16. Write short notes on the following,

(i) Zooming worksheets

(ii) Viewing a worksheet in multiple windows

(iii) Comparing sheets side-by-side.

Answer : Model Paper-Ill, Q10(a)

(i) Zooming Windows

The working area of excel can be zoomed within the range from 10% to 400%. This option helps in viewing data 
present in the worksheet differently for different purposes. For example, if the user wants to verify that all the columns of 
a worksheet are properly aligned or not, then small zoom percentage is preferred. Changing the zoom percentage will not 
affect the size and format of the text or contents of the worksheet.

There are different ways of zooming-in and out a worksheet window,

❖ The status bar at the bottom carries a zoom slider using which the active worksheet can be zoom-in and out.

■ . ZZZZZZZZZZZZZZZ13
E -......... I---------+ ioo%

Scrolling the mouse wheel while holding Ctrl button performs zooming of active window.

Select View Menu —» Zoom -> Zoom. It opens a zoom dialog box displaying a set of zooming options.

❖ Excel also supports zooming of specific range of cells. To do so, select the range to be zoomed in and goto View
—» Zoom -» Zoom to selection. This option fits the selected cells to the window.

(ii) Viewing a Worksheet in Multiple Windows

The workbooks in an excel window are displayed in different tabs. However, in some situations, it is preferable 
to display these workbooks or worksheets in different windows to perform comparisons. To assist such operations, excel 
allows the usersto open workbooks or worksheets in different windows. This can be accomplished by clicking View -> 
Window —> New Window. The newly opened window and the old window can be resized according on the screen to perform 
comparisons. To automatically set the windows only the screen click on View -» Windows -> Arrange All and select the 
desired option from the Arrange Windows dialog box.

(iii) Comparing Sheets Side-by-side

Excel-2013 offers a better way for comparing two sheets side-by-side. To do this, open two sheets in two separate 
windows and then click on View -> Window -> View side by side. This option automatically fits two opened window; 
side by side on the screen. In case if there exist more than two opened windows, it displays a dialog box listing the openec 
windows. From this, two windows need to be selected.
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The two opened windows are arranged in such a way that scrolling one window automatically scrolls the other 
one. However, this automatically scrolling can be disabled by clicking on View —> Windows —> Synchronous scrolling. 
The comparisons need to be performed manually because excel does not automatically points out the differences among 
worksheets.

2.5 SELECTING RANGES, COMPLETE ROWS AND COLUMNS, NON-CONTIGUOUS
RANGES, MULTI-SHEET RANGES, SPECIAL TYPES OF CELLS

Q17. List the different ways of selecting range of cells and complete rows and columns.

Answer : Model Paper-I, Q1O(b)(ii)

Selecting Range of Cells

Range refers to a set of cells selected within a worksheet. It is specified by the upperleft cell and the lower right 
cell of the selection separated by a colon(:). For example, the range A2 : C6 refers to the following set of columns in the 
worksheet,

=• Unit-2* IjBb Book4

A B c D E
1 Emp ID Emp Name Emp Address Emp Phn Emp Salary
2 301Shoab Hyderabad 12345 10000
3 302 Shabbir Secunderabad 54321 15000
4 303 Zuberi Mumbai 23456 13000
5 304 Moiz Chennai 65432 25000
6 305 Arbaz Bangalore 98765 20000
7 > ------ ■
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The range of cells is selected to perform specific operations on that cells. For example, to bold the selected cells. 
The different ways of selecting a range are as follows,

❖ Select the starting cell, click and drag the cells till the last cell and release the mouse button. If the destination is 
below the displayed area, keep on dragging till the end and the worksheet will automatically scroll.

❖ Select the starting cell, press and hold shift key and use the arrow keys to select the range.

❖ Select the starting cell and press F8. Now, press the arrow keys to select the range and press F8 again to stop the 
selection.

❖ Range of cells can also be selected by clicking on Home -> Editing -» Find & Select -> GoTo and enter the range 
in the dialog box. Upon clicking Ok, the specified cell range is selected.

Selecting Complete Rows and Columns

In some situations, users need to select the complete row or complete column. For example in employees data sheet, 
a row might carry headings such as EmpID, Emp_Name, Emp_address, Empsalary etc., which need to be bold, then 
users can select entire row and apply Bold font to it.

To select the complete row or column, follow any of the methods below,

❖ A row or column can be selected by clicking on the row number present at the left side and column letter present 
on the top respectively.

❖ Multiple rows and columns that are adjacent to each other can be selected by clicking and dragging the row numbers 
and column letters.

❖ Multiple non-adjacent rows and columns can be selected by holding Ctrl key and clicking the row numbers or column 
letters.

❖ The column in which active cell is present can be selected by pressing Ctrl + Spacebar.

❖ The row in which active cell is present can be selected by pressing Shift + Spacebar.

Q18. How non-contiguous ranges can be selected in excel 2013?

Answer : Model Paper-ll, Q10(bRi)

Non-contiguous ranges refer to multiple ranges that are non-adjacent to each other. Excel-2013 allows its users tc 
work on non-contiguous ranges of cells. Selection of such ranges are also called as multiple selection. Such a selection is 
required in certain situations. For example, if user wants to highlight the employees working in a specific department then 
the user can use this method. When formatting is applied on multiple ranges, it is applied to these ranges only.

Q Unit-2* • gp Book4 I

A B C D E

1 EmpJD Emp_Name Emp_Address Emp_Phn Emp_Salaj"y
2 301 Shoab Hyderabad 12345 10000
3 302 Shabbir Secunderabad 54321 15000;|

4 303 Zuberi Mumbai 23456 13000
5 304 Moiz Chennai 65432 25000
6 305 Arbaz Bangalore 98765 20000
7
o
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Non-contiguous ranges can be selected in the following ways,

❖ Firstly select the initial range and hold the control while selecting the next range with mouse dragging.

❖ If the selection is to be performed in keyboard, press F8, select the first range and press again. Now, press Shift +
F8 to select the next range. When the selection is completed, press F8 again.

❖ It can be selected by entering multiple ranges separated by commas in the name box. For example, A1 :C4, A7:C12,
A16:C19.

❖ Select Home -> Editing -» Find & Select —» Goto.

In the displayed dialog box, enter the ranges separated by comma and click on OK button.

Q19. Write short notes on selecting muitisheet ranges.

Answer :

Excel-2013 allows selection of ranges over multiple sheets thereby extending two-dimensional selection to three 
dimensional. Such selection is usually required when multiple sheets carry identical data. For example, in an employees 
workbook, salaries, expenses and some other data related to employees is divided based on departments into different 
sheets. The layout, fields and format of the sheets are identical but the figures might differ. In such case, the identical fields/ 
columns can be formatted using multisheet range option provided by excel.

e- Unit 2 {Group}* Q

a iT

Book4 F

C D E

i EmpJD Emp Name Em p Ad dress Emp Phn EmpJSalaryi

2 301 Shoab Hyderabad 12345 10000

3 302 Shabbir Secunderabad 54321 15000

4 303 Zuberi Mumbai 23456 13000

5 304 Moiz Chennai 65432 25000

6 305 Arbaz Bangalore 98765 20000

To use multisheet selection, follow these steps,

*X* Select the first worksheet by clicking on the sheet tab.

❖ Select any range of cells in the active worksheet.

❖ Click the last worksheet while holding the shift key. Upon doing this, all the worksheets in the w’orkbook are selected.

❖ The name of the workbook shows [Group] on the title bar indicating that all the sheets within this workbook are in 
group mode.

❖ Apply required formatting on the selected range such as making the text bold or italic, increasing the size of text, 
applying background etc.

❖ After performing required formatting operations, click on any of the sheet tab to save changes and exit the group 
mode.

The major advantage of group mode is that the modifications done in one sheet will be reflected on all the other 
sheets. In case if the group mode needs to be activated with a non-contiguous range of sheets, press and hold Ctrl key 
instead of shift key and click on the desired sheet tabs. The selected sheet tabs become bold indicating that they are in 
group mode.
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Q20. Discuss about selecting special types of cells.

Answer :

In excel, different cells carry different types of data. Some might contain formula while some contain comments and 
so on. Excel 2013 allows selection of specific'type of cells present in the worksheet. To do this, select the range and go to 
Home —> Editing —» Find & Select —» Go to special option. It opens a "Go to special dialog box" which displays various 
options such as comments, constants, formulas and many more. Select the desired option and click on OK button. If the 
range doesnot carry any matching cell, it returns “No cells were found” message.

Different options present in the go to special dialog box are described below,

1. Comments

It is used for selecting the cells carrying comments.

2. Constants

It is used for selecting the cells carrying text, numbers etc., but do not carry formulas. Upon selecting this option, 
four check boxes gets activated including numbers, text, logical and errors. The desired once can be selected among 
these four.

3. Formulas

It is used for selecting the cells carrying formulas. It also activates the above four additional options i.e., text, 
numbers, logical and errors.

4. Blanks

It is used for selecting the cells that do not carry any data in it. If range is not specified, it selects all the blank cells 
that can be displayed on the screen.

5. Current Region

It is used for selecting rectangular range around the active cell. The shortcut used for activating this option is Ctrl 
+ Shift + *.
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6. Current Array

It is used for selecting the array.

7. Objects

It is used for selecting the objects such as graphs, charts etc., present in the worksheet.

8. Row Differences

It is used for selecting the cells which are different from others with in a row.

9. Column Differences

It is used for selecting the cells which are different from others with in a column.

10. Precedents

It is used for selecting the cells which are used in the formulas of other cells.

11. Dependents

It is used for selecting the cells carrying formulas referring to other cells.

12. Last Cell

It is used for selecting the bottom right cell carrying data of the active worksheet.

13. Visible Cells Only

It is used for selecting all the cells which are visible within the selection.

14. Conditional Format

It is used for selecting the cells which are formatted using conditional format option.

15. Data validation

It is used for selecting the cells which are set up using data entry validation option.

2.6 COPYING OR MOVING RANGES
Q21. Discuss in brief about copying and moving cells/range in Excel 2013. Also discuss the way of copying 

cells or range using ribbon commands.

Answer :

Copying and Moving Cells/Range in Excel 2013

Copying cells/range refers to making a copy of selected cells and moving it to the destination while keeping the 
data at the source. However, moving cells/range does the same but removes the data from the source. Excel-2013 provides 
simple ways of copying/moving the data from one place to another. With this, a single cell can be copied on a range of cells, 
range of cells can be copied to a range of cells in different location or a range of cells can be moved to another location.

In general, copying or moving is a two step process.

1. In the first step, the range to be copied is selected and copied. If move operation is to be performed, then cut option 
is selected instead of copy.

2. In the second step, the cell or range is selected where the copied data is to be moved and paste operation is performed.

These options are frequently used and it can be performed in different ways.

Copying Cell/Range using Ribbon Commands

The data, that is copied or cut is maintained in a temporary location called clipboard. This data is replaced with the 
newly copied or cut data. Using ribbon commands, the .copy and paste operations can be performed as follows,

❖ To copy a range, select it and go to Home -» Clipboard -> Copy. The selected range will be highlighted and copied 
to the clipboard.

❖ To paste the copied range, select the destination and go to Home -» Clipboard -» Paste. This command can be used 
multiple times.

An alternative to paste using above method is to press Enter key. It directly pastes the copied range and deletes it 
from the clipboard.

When copy operation is performed more than once, excel automatically displays the clipboard.

----- ---------------- ■ ■■ SIA PUBLISHERS AND DISTRIBUTORS PVT. LTD.



60 _ ___ ____________ _____ __ EXCEL FOUNDATION

Q22. Explain the process of copying and pasting using shortcut menus and shortcut keys.

Answer :

Copying and Pasting using Shortcut Menus

Copy-paste operations can be performed using shortcut menus in the following way,

1. Select the cells or range of cells and right-click on it. A shortcut menu appears which displays a list of options. In 
the displayed list, select copy option.

2. To paste the copied data, go to the destination cell and right click on it. In the displayed menu, click on paste option.

3. Instead of using paste option, Enter key can be pressed. It directly pastes the copied range and deletes it from the 
clipboard.

Copying and Pasting using Shortcut Keys
* * -

The copy-paste operations can also be performed using keyboard shortcuts as follows,

1. Select the range of cells to be copied and press Ctrl+c. The selected range will be copied to the clipboard.

2. Select the range of cells to be cut and press Ctrl+x. The selected range will be removed from the source and copied 
to clipboard.

3. Select the destination cell and press Ctrl+v to paste the contents of clipboard.

Q23. Discuss about the following,

(i) Drag and drop method of copying or moving

(ii) Copying to adjacent cells

(iii) Copying a range to other sheets.

Answer : Model Paper-ll, Q10(b)(ii)

(i) Drag and Drop Method of Copying or Moving

Drag and drop method of copying or moving doesnot involves the usage of clipboard. The copy and move operations 
are performed in the following ways,

1. Select the range to be copied to the new location. Press and hold Ctrl key and drag the selected range to new location
(destination). After dropping, release the Ctrl key. The selected range will be copied to the new location.

2. Inorder to move a range, follow the above process without holding Ctrl key.

(ii) Copying to Adjacent Cells

Excel-2013 allows copying of contents/formulas from one cell/range of cells to the cells adjacent to it. Such copying 
is usually required when similar operation needs to be performed on adjacent cells. Therefore, when formulas can be copied 
to adjacent cells, it avoids re-entering of formulas and saves time.

A simple way of copying the formula to adjacent cells is to use the fill handle. This handle refers to the small square 
present on the bottom right comer of selected cell. When it is dragged to adjacent cells, same formula is copied into those 
cells. From menus, this option can be performed as follows,

1. Click on Home —> Editing —> Fill —> Down to copy the contents or formula of the cell present below the active cell.

2. Click on Home -> Editing —> Fill —» Up to copy the contents or formula of the cell present above the active cell.

3. Click on Home ->■ Editing -> Fill -> Right to copy the contents or formula of the cell present on the right side of
the active cell.

4. Click on Home —> Editing —> Fill -> Left to copy the contents or formula of the cell present on the left side of the 
active cell.
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(iii) Copying a Range to Other Sheets

The methods used to copy the contents within the worksheet can also be used to copy the content over different 
worksheets and workbooks. However the most preferred way of doing this is as follows,'

1. Firstly, specify the cell or range of cells to be copied.

2. Hold Ctrl key and open the destination worksheet. The mode will be changed to group.

3. Select Home -» Editing -» Fill -> Across worksheets option. It displays a dialog box containing certain options 
such as All, Contents, Formats.

4. Select the desired option and click on OK button.

Q24. Describe the process of pasting using office clipboard.

Answer : Model Paper-Ill, Q10(b)(i)

Clipboard refers to a memory which stores the copied data temporarily. It usually replaces the copied data with the 
newly copied one. However, it also allows the users to keep copies of different data so that it can be pasted individually 
or as a group.

Clipboard can be accessed by clicking on the dialog launcher present on the bottom right comer of clipboard category 
under Home. It is displayed as a task pane on either right or left side of the work area. To insert data into the clipboard, 
select the cells and copy them using any of the methods. The preview of copied text is displayed in the clipboard. When 
the clipboard is opened, multiple range can be copied and maintained in it.
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To paste the data present in the clipboard, select the destination cell and click on the copied data to be pasted from 
the clipboard. If the user wants to paste all the data present in clipboard, “Paste All” option can be used which is present at 
the top of task pane. Using this option, data can be collected from various sources and pasted on a single place. The “Clear 
All” button present beside Paste All button clears or deletes the contents present in the clipboard.

The following are some of the important facts regarding office clipboard.

1. When paste operation is performed using shortcut key (i.e., ctrl+v) or Home -> Clipboard -> Paste, only the most 
recently copied data is pasted.

2. The mostly recently copied data or item is placed in both office clipboard and windows clipboard.

3. When paste option or Paste All option is used from clipboard task pane, all the pasted contents are placed in the 
windows clipboard as a single item.

4. When the items from office clipboard is deleted, it is also deleted from windows clipboard.

Q25. Discuss various paste options offered by excel 2013 for pasting in special ways.

Answer : Model Paper-I, Q10(a)

Excel-2013 offers several ways of pasting the copied contents. Such pasting is required in many situations such as 
pasting the results of formulas instead of pasting formulas. To paste the contents in special ways. Select Home -> Clipboard 
-» Drop-down arrow below paste. Upon clicking this, many different paste options are displayed and when mouse pointer 
is moved over it, preview is displayed on the active worksheet.

Different paste options provided under this menu are as follows,

HOME

Paste
A A A A
"0

1*4*n

¥

Paste Values

Ll23
A

123 *123

Other Paste Options

A ('“‘j A pi5" I® B dS

Paste Special.,,

1. Paste(P)

This option is used for simply pasting the copied contents with the source formatting.

2. Formulas(F)

This option is used for pasting only the formulas without formatting.

3. Formulas and Number Formatting(O)

This option is used for pasting formulas while keeping the number formatting.

SIA PUBLISHERS AND DISTRIBUTORS PVT. LTD. -------------------------- -- - --



UNIT-2 : Worksheet Operations 63
4. Keep Source Formatting(K)

This option is used for pasting the formulas with source formatting.

5. No Borders(B)

This option is used for pasting the contents without border formatting.

6. Keep Source Column Width(W)

This option is used for pasting the columns and modifying the column width of destination to match the source 
width.

7. Transpose(T)

This option is used for pasting by interchanging rows and columns of the source. If formulas are present in the copied 
range, they are modified automatically to generate appropriate results.

8. Merge Condition Formatting(G)

This option is used for pasting the contents by merging the conditional formatting of source and destination. It is 
shown in the paste menu only when the copied range contains conditional formatting.

9. Values(V)

This option is used for pasting the values generated from the formulas in the copied range while excluding the 
formulas.

10. Values and Number Formatting(A)

This option is used for pasting the values generated from formulas with number formatting of source.

11. Values and Source Formatting(E)

This option is used for pasting the values generated from formulas with all the source formatting.

12. Formatting(R)

This option is used for pasting only the formatting.

13. Paste Link(N)

This option is used for pasting the formulas while keeping the same references of the formulas.

14. Picture(U)

This option is used for pasting the copied data in the form of picture.

15. Linked Picture(l)

This option is used for pasting the copied data as picture which is updated automatically when the data in the source 
is modified. *

16. Paste Special

For answer refer Unit-II, Page No. 63, Q.No. 26.

2.7 PASTE SPECIAL DIALOG BOX
Q26. Explain in detail about paste special dialog box.

Answer :

Paste special option offers several pasting methods of copied data. The dialog box for paste special can be accessed 
by selecting Home -» Clipboard —> Paste —> Paste special. The shortcut method of opening this dialog box is by right
clicking on the destination cell and selecting paste-special option.
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The paste-special dialog box offers the following options,

1. All

This option can be selected to paste the contents with all formatting, formulas and data validation.

2. Formulas

This option can be selected to paste the formulas with values but without formatting.

3. Values

This option can be selected to paste only the values(results) of the formulas.

4. Formats

This option can be selected to paste the source formatting.

5. Comments

This option can be selected to paste the comments included in the copied range.

6. Validation

This option can be selected to apply the data validation criteria of source range on destination.

7. All using Source Theme

This option can be selected to paste the contents along with the document theme of one workbook to another.

8. All Except Borders

This option can be selected to paste all the contents of source without borders (if any).

9. Column Width

This option can be selected to set the destination column width as source.

10. Formulas and Number Formats

This option can be selected to paste formulas, their values(results) and number formatting while excluding other 
formatting of source.
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Values and Number Formats

This option can be selected to paste values generated from formulas with number formatting while excluding the 
formulas.

2 All Merging Conditional Formats

This option can be selected to merge the conditional formatting of source with the destination.

Mathematical Operations in Paste Special Dialog Box

Paste special dialog box offers certain mathematical operations that can be performed among source and destination 
ranges. These operations are included under operation category. This category offers four mathematical operations 
i.e., Add, Subtract, Multiply and Divide. With these operations, the source values are added, subtracted, multiplied 
or divided with destination values and stored in the destination cell range.

4 Skip Blanks

This option can be selected to skip the cells that do not carry any value or contents in it. These cells do not replace 
the destination cells.

; Transpose

This option can be selected to paste the copied data in a different orientation. This means that the rows are converted 
to columns and the columns are converted to rows.

1.3 ADDING COMMENTS TO CELLS
22' Write short notes on adding and formatting comments.

<aswer : Model Paper-Ill, Q10(bXii)

Comments are used to desirable a particular cell within a worksheet. This description can be explanation about 
rrula, name or anything else.

Mding Comments

Comments can be added in any of the following ways,

Select a cell and go to Review -> Comments -> New Comment.

Select the cell and right click on it. In the displayed menu, select “Insert Comment” option. 

Select the cell and use the shortcut key “Shift + F2”.

D E F G
- a.......... ...□..... . □

12345
- " Local Phone number
10000 cjof Employee 

15000

13000 

25000 

20000

□
54321

23456

65432

98765

TT □

All the above options displays a yellow box with a cursor blinking in it. Enter the desired comment and click any 
*-?re in the worksheet to add it. By default, the name of user who added the comment is displayed in the comment box 
which can be removed from Excel options. The cell on which comment is added includes a small red coloured rectangle 
r :op-right of the cell. The comment is displayed when mouse pointer is placed on it otherwise it is hidden. To make it
sidle all the time, right click on the cell and select show/hide comments.

An added comment can be edited by right-clicking on the cell and selecting “Edit Comment” option.
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Formatting Comments

Excel-2013 allows its users to format the comment accordingly. To do this, right-click on the cell and click “Edi: 
Comment”. Excel allows to edit the text present in the comment box. Select the text and format it accordingly by changing 
font size, font color, alignment etc. Some additional options are included in the format comment dialog box which car 
be accessed by right-clicking on the comment and selecting format comment. With this dialog box, borders, margins and 
many other aspects of the comment box can be modified.

Image comment can also be added to a cell in Excel-2013. To do this, open the format comment dialog box, click on 
colors and lines tab and select fill effects under color drop-down list. A fill effects dialog box appears in which select picture 
tab. Click on select picture button and select the picture. Finally click on OK button to add the picture in the comment box.

65432 25000 □ □ □

98765 20000

Q28. Discuss the following operations on comments,
(i) Changing shape
(ii) Reading
(iii) Printing
(iv) Hiding and unhiding
(v) Selecting
(vi) Editing
(vii) Deleting.
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Model Paper-ll, Q10(a)

Changing Shape

The default shape of a comment is rectangular which can be modified.

To make the change shape option available, the following steps need to be performed.

Firstly, right-click on the empty space of the quick-access tool bar and select customize Quick Access Tool Bar. 

An excel options dialog box appears with quick access tool bar selected by default.

In this dialog box, click on the drop-down arrow which is present below “choose commands form”.

In the appeared list, find and select Drawing Tools Format tab.

A list of options appears in the left pane. In that list, click on “Change Shape” and click Add button.

Finally, click on the OK button.

FILE K OME INSERT P
Change Shape

Paste

Tahoma ’ 9
Change the shape of the drawing, b
preserving all the formatting.

d r ii _ .
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It can be noticed that change shape icon is added on top of the window. Now, to change the comment shape, click 
on the comment box and click change shape icon. A list of shapes appears from which the desired one can be selected.

D E F G

□ X D
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65432 25000 ..□..... ........ run................Ln.
98765 20000

(ii) Reading

All the comments present in a workbook can be browsed by clicking Review -> Comments -> Next. To see the 
next set of comments, keep on clicking next button. To see the comments in reverse order, click Review —» Comments -> 
Previous.

(iii) Printing

The comments are hidden objects and hence they are not printed. If they need to be included in the print, the following 
process need to be followed,

❖ Firstly, open the page setup dialog box by clicking on the dialog box launcher icon present on the bottom right comer 
of page setup group under page layout.

❖ Click on sheet tab.

❖ Click on the drop-down list of comments.

❖ Two options are displayed i.e., At End of sheet and As Displayed on Sheet.

❖ Select the desired option and click OK button.

(iv) Hiding and Unhiding

If users need to display the comments all the time, then go to Review -» Comments -> Show All Comments. The 
same option can be selected to unhide the comments. To hide/unhide comments of individual cells select the cell and go 
to Review -» Comments -> Show/Hide Comment.

(v) Selecting

If users want to select all the cells carrying comments within a worksheet, click on Home -» Editing -> Find and 
Select -» Go to Special. Under Go to Special dialog box, select comments and click on OK button.

(vi) Editing

If a comment needs to be edited or modified, right click on the cell and click on "Edit Comment" in the displayed 
list. It can also be edited using Shift + F2 shortcut key.

(vii) Deleting

If a comment needs to be deleted, select the cell and go to Review -> Comments -> Delete. Another way of deleting 
comment is by right - clicking on the cell and selecting Delete Comment.
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INTERNAL ASSESSMENT
I. Multiple Choice Questions

1. A window can be in________ state.

(a) Maximized

(b) Minimized

(c) Restored

(d) All of the above
t

2. The shortcut key to cycle through all the windows that are open is________ .

(a) Ctrl + F5

(b) Ctrl + F6

(c) Ctrl + F7

(d) Ctrl + F8

3. The shortcut for directly closing an opened window is________ .

(a) Alt + F4

(b) Ctrl + W

(c) Both (a) and (b)

(d) None of the above

4. The special character that can be used in sheet name is________ .

(a) $

(b) :

(c) ?

(d) *

5. The sheet names displayed on the screen are called as________ .

(a) Sheet names

(b) Sheet tabs

(c) Sheet array

(d) None of the above

6. To select multiple sheets randomly, the following key needs to be pressed and hold.

[ ]

[ ]

[ ]

[ ]

(a) Ctrl

(b) Shift

(c) Alt

(d) Windows
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7. The zoom range allowed in Excel - 2013 is________ .

(a) 100% to 500%

(b) 50% to 500%

(c) 10% to 400%

(d) 50% to 400%

8. Which among the following is a valid range? [

(a) A1-D5

(b) A1+D5

(c) A1 % D5

(d) A1:D5

9. The shortcut key for selecting a row is________ . [

(a) Ctrl + Space bar

(b) Shift + Space bar

(c) Alt + Space bar

(d) None of the above

10. The data present in cells can be copied using_______ [

(a) Ctrl + C

(b) Ctrl + V

(c) Ctrl + P

(d) Ctrl + S

II. Fill in the Blanks

1. “Arrange All” option for arranging windows is present in_________ menus.

2. Ctrl + PageUp is used to activate  _______ .

3. To select continuous series of worksheets, activate the first worksheet, press________ button and click the 1
worksheet.

4. ' refers to a set of rows and columns that can be selected at once.

5. To select all the cells within a worksheet, press________ .

6. ________ option is not present in Go to special dialog box.

7. All the copied data in excel is stored in________ .

8. The shortcut key to cut the data in a cell is________ .

9. ______ option in paste drop down is used to paste formulas without formatting.

10. ________ option in paste drop-down is used for pasting the data as picture which is updated automatically wh
source is modified.

SIA PUBLISHERS AND DISTRIBUTORS PVT. LTD.



71
1

J NIT-2 : Worksheet Operations

■ Ofe

Multiple Choice Questions

1- (d)

2. (b)

3- (c)

4. (a)

5- (b)

6. (a)

7. (c)

8- (d)

9. (b)

10. (a)

Fill in the Blanks

1. View

2. Previous worksheet

3. Shift

4. Range

5. Ctrl + A

6. Symbol

7. Clipboard

8. Ctrl + X

9. Formula (F)

10. Linked Picture (I)

KEY
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III. Very Short Questions and Answers

Q1. What is the simplest way of moving and resizing window?

Answer :

. The simplest way of moving a window is through drag and drop while holding its title bar using mouse. However 
to resize the window, its border can be clicked and dragged accordingly.

Q2. Define active window.

Answer :

An active window refers to the window on which, the user is currently working.

Q3. List the different ways of deleting a worksheet.

Answer :

Deletion can be performed in the following ways,

❖ A worksheet can be deleted by right-clicking on its name(i.e., Sheet tab) and selecting delete option.

❖ Another way of deleting worksheet is to select Home -» Cells -> Delete —» Delete Sheet option.

Q4. Define cell range.

Answer: /■

Cell range or simply range refers to a group of cells that can be selected together within a worksheet.

Q5. What is meant by copying and moving cells/ranges?

Answer :

Copying cells/range refers to making a copy of selected cells and moving it to the destination while keeping the datz 
at the source. However, moving cells/range does the same but removes the data from the source.
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z-----I LEARNING OBJECTIVES J

After studying this unit, a student will have thorough understanding about the following'key concepts.

> Creation of a table.

> Changing the look of a table.

> Adding and deleting new rows or columns.

> Removing duplicate rows from a table.

> Sorting and filtering a table.

> Working with the formatting tools on the home tab.

> Application of naming styles.

( INTRODUCTION )

In excel, table is referred to group of rows and columns in a worksheet that contain related data. Tables enable 

a user to manage and analyze group of related data easily and quickly. Moreover, by formatting data as a table 

user can perform various tasks such as,

❖ Sorting data.

❖ Filtering data.

❖ Adding rows and columns.

❖ Deleting rows and columns.

❖ Changing the naming styles and so on.
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................. 1111 ---------------------------------
PART-A

*
SHORT QUESTIONS WITH SOLUTIONS

Q1. Write the steps for table creation in an empty range.

Answer : Model Paper-I, Q8

The steps involved in creation of a table for an empty range are given as,

1. Select any cell within the range.

2. Goto insert tab and select table from the tables group.

3. As a result, excel displays create table dialog box. Enable "My table has headers" check box and click OK button.

4. Finally excel creates a table by adding generic column headers.

Q2. Write a short note on navigation in exc*el.

Answer : Model Paper-Ill, Q8

In Excel, navigating in a table is similar to navigating through a worksheet except the fact that when the user uses 
tab key excel will activate the cell which is at the right of the current selected cell. Additionally, when the user reaches last 
column of the table the cell in the first column of the next subsequent row will be activated unlike in a worksheet.

Q3. Write the steps for removing a filter.

Answer : Model Paper-ll, Q8

Filter can be removed from a table in either of the following ways,

(i) To remove filter from a single column click on the drop down arrow in the row header and choose clear filter.

(ii) To remove a filter from multiple columns select home tab -> click on sort and filter option present in the editing 
group -> select clear.

Q4. What are the steps involved in inserting siicers?

Answer : Model Paper-Ill, Q3

The following steps are involved in inserting a sheer,

(i) Click on any cell within the table.

(ii) Goto the "Table tools group" present in the design tab.

(iii) In the "Table tools group" click on the "Insert Sheer" command. As a result, insert siicers dialog box appears.

(iv) Select the desired field and then click OK.

(v) Now, excel displays the sheer next to the user table. In this sheer every selected item will be highlighted in blue, j

(vi) On selecting or deselecting items from the sheer, the changes will be reflected in the pivot table

Q5. Write the steps for converting table back to range.

Answer : Model Paper-1, 02 j

After creating an excel table, sometimes the user may require only table style but not table functionality. In such s 
case user can convert a table back to its normal range by performing the following steps,

1. Click on any cell within the table.

2. Now, select table tools group present in the design tab of the ribbon.

3. Click on "Convert to Range" option present in the tools group.

As a result, the table features are no longer available.
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Q6. Write the use of mini toolbar.

Answer :

A mini toolbar facilitates the user by displaying the options for cutting, copying, pasting, inserting, deleting, sorting, 
" Itering, formatting the content and so on. This toolbar appears on screen whenever a user right clicks on a cell and it 
-emains visible until the user selects some option for cell formatting. A mini toolbar can be made hidden by clicking any 
cell or pressing the ESC button on keyboard.

Q7. What are the different ways for performing sorting in excel?

Answer : Model Paper-ll, Q3

In excel, sorting can be performed in either of the following ways,

i) To sort a table by a specific column, click on the filter button present in the column header and select one of the 
sorted commands.

ii) To sort a table depending on the text color or background color of a cell select sort by color.

iii) To sort a table by number of columns, perform sorting on the less frequently used column first and continue till you 
reach the most significant column. *

38. Write the steps involved in changing a line color or line style of a cell.

Answer s

Similarly, to change the line color (or) line style of a cell.

a) Click on the Home tab present on the ribbon.

b) Click on arrow next to the Borders icon present in the Font group.

c) Select line style/line color option from the displayed drop-down menu.

: i Select the desired Line color/Line style.
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PART-B

ESSAY QUESTIONS WITH SOLUTIONS

3.1 CREATING A TABLE, CHANGING THE LOOK OF A TABLE
Q9. Define a table and write the steps involved in creation of a table in excel.

Answer: Model Paper-I, Q11(a)

Table

Arrangement of data in the form of rows and columns is referred to as "table". Each row and column in a table 
contains different type of information. For instance, when a row contains information about a student then columns contain 
student related attributes like student name, roll no, branch, marks and so on. In excel, table can be created in either of the 
following ways.

(i) Creation of a table for the existing range of data.

(ii) Creation of a table for an empty range.

(i) Steps Involved in Table Creation for the Existing Range of Data

1. Select the cell in which you want to type your first field name.

Book2

i FILE B HOME INSERT PAGE LAYOUT

Calibri ’[ll -] A A

Paste B I U ’ S3 ’ ’ A. ’

Clipboard n Font □

A1 ’ i M X jx

FORMULAS DATA REVIEW VIEW

= s Wrap Text icem

= = ■*= H|j Merge & Center - $ '

Alignment . o I

A B C D E F G H

1 I

2

3

4

2. Enter the field name and move the cell pointer to the next corresponding cell BI.

B H Book

FILE HOME INSERT PAGE LAYOUT FORMULAS DATA REVIEW VIEW

><3^; i [Calibri * 11 ’i A a’ =■ = s ~ Wrap Text Ger

Paste B I U ’ r 4 - ’ a • = = = S ■Sh § Merge & Center * $

Clipboard Font . Alignment n; ■

5 Bl •v } X */ fi

A B C D E F G H

1 SNAME

2 •

3

4

3. Type the second filed name in the cell B1.
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Similarly, enter all the header filed names in cells Cl, DI, El and so on.

I H *>’<*' 5 Boole

HOME INSERT PAGE LAYOUT FORMULAS DATA REVIEW VIEW

ICalibri.

Paste

11 ’ A A Wrap Text I G et

B I U ’ Li;
Clipboard i» Font

<> A, ’ =; = i *E i g Merge & Center ’•

n Alignment a

Cl X <✓ fx \ SMARKS’

A B c D E F G H
1 [sNAME SNO SMARKS
2 i

3 :
4 1

Now, enter the data corresponding to the field names in cell A2, B2, C2 and so on.

® H *5’ C»; ’ aft

HOME INSERT PAGE LAYOUT FORMULAS DATA REVIEW VIEW

Caiibri 11 A A •’Wrap Text

Paste g j y - i Lfi ’ Jj’A’ g Merge & Center ~ 5

Font Alignment

A6
<1 rl3

s A S
J?. •

A C D E F G H

1 [SNAME SNO SMARKS

2 John 101 60
3 1 Peter 102 70

4 [Alice 103 55

5 Bob 104 90

6

Select the header row and drag over the cells that contain data related to the header fields.

B H ♦>’ C*’ • affu-

I HOME INSERT PAGE LAYOUT FORMULAS DATA REVIEW VIEW

Caiibri 11 A A’ = g* Wrap Text Gen,

Paste g j u - HJ - <^> • A, - = = g Merge & Center - $

Font Alignment

I X «✓ fi \\ SNAME

A B c D E F G H

1 SNAME SNO SMARKS

2 John 101 60

3 Peter 102 70 '» 1

4 Alice 103 55

5 Bob 104 90
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Choose insert tab present on the ribbon and select table from the tables group.

H ’ rt ’ = afft

HOME INSERT PAGE LAYOUT FORMULAS DATA REVIEW VIEW

S”
Store III

PivotTables 
Tables

I
PivotTable Recommended Table Illustrations ^^y^pps - Recommended .

PivotTables * Charts ** l—
Apps Charts

At

B

Table (Ctrl+T)

Create a table to organize and 
analyze related data.

Tables make it easy to sort, filter, 
and format data within a sheet.

A F G H
1 SNAME SNO
2 John 10
3 Peter 10
4 Alice 10 © Tell me more
5 Bob 10<i.............. 90:.........................................
6

As a result excel displays "Create Table" dialog box as shown below,

QS H ♦> c* *

HOME INSERT PAGE LAYOUT FORMULAS DATA

|O| S f 'j LZJ • Store 

PivotTable Recommended Table Illustrations
PivotTables
Tables Apps

If
tmmei
Charts

REVIEW
I-, »

afft

VIEW
’ S’

Recommended , F

.Charts

At X V

1 A B C
1 {SNAME SNO SMARKS
2 {John 101 60
3 JPeter 102 70
4 Alice 103 55,
5......
6

Bob 104 90

7 -T

8
9

inhere is the data for your table?

fx SNAME

B My table has headers

OK Cancel

Enable "My table has headers" check box and click on OK button.

H *7- <♦’ »
I HOME INSERT PAGE LAYOUT FORMULAS DATA REVIEW

affu -

VIEW

Table Name I O Summarize with PivotTable 

jTabiel j li Remove Duplicates

Resize Table §3 Convert to Range 

Properties Tools

I fs| Properties 
: At
'.. *■' !r i^Open in Browser

Insert Export Refresh 
Sheer ’ - . Unlink

External Table Data

A1 ’ 1 ’ ) X . JS? 1 SNAME

B C | D E F G H
1 iEJSSI ’ SOi
2
3 Peter 102 70
4
5 Bob 104 90j
6 .................>.................i..................
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Steps Involved in Creation of a Table for an Empty Range

Select any cell within the range.

B H » Bool

HOME INSERT PAGE LAYOUT FORMULAS DATA REVIEW VIEW

ICalibri ’ 11 ’• A A §^Wrap Text

B I U ’ : ES ’ ’ A ’
* Font Q

e e : S £ ' § Merge & Center - : $ 

Alignment is

• A1 ...’J ’ ? fx

A B C D E F G H
1
2
3
/1

Goto insert tab and select table from the tables group.

Boc

HOME INSERT

PivotTable

PAGE LAYOUT
5 : :........•........ .

, R>’ Store

FORMULAS DATA REVIEW VIEW

iir

Recommended Table Illustrations M Apps . Recommended “ J , , 
PivotTables ’ * Charts ci’

Apps

E? Jigs,

PivotTables
Tables Charts

A1

A B I

1 3

2
3
4
5

Table (Ctrl+T)

Create a table to organize and 
analyze related data.

Tables make it easy to sort, filter, 
and format data within a sheet.

© Tell me more
1------- -------------------

As a result, excel displays create table dialog box. Enable "My table has headers" check box and click OK button.

H *>’ C*” ’ Book

HOME INSERT PAGE LAYOUT FORMULAS DATA REVIEW VIEW

ii X 'H Store
i . " ’ M ’ III"

PivotTable Recommended Table Illustrations My Apps „ Recommended P
PivotTables * Charts W k-tZPivotTables
Tables Apps Charts
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4. Finally excel creates a table by adding generic column headers.

®! a ♦3 • s? - • Boc

ULL HOME INSERT PAGE LAYOUT FORMULAS DATA REVIEW . VIEW

*
i Caiibri ............’|U.......71 ** * ~ 3?” |g Wrap Text iG

%
Paste

v B I y •' ffl • =; =: = tg S i § Merge & Center - ; J

Clipboard Font fi Alignment

Q10. Explain the process of changing the style of a table.

Answer :
When the user creates a table excel applies table style by default. But, if the user intends to apply different style the: 

it can be modified by performing the following steps,

(i) Click on any cell present in the table.

31 H *3~ <♦’ ’ aft'
HOME INSERT PAGE LAYOUT FORMULAS DATA REVIEW VIEW

•Caiibri 11 -i A A' gg Wrap Text Gt

Paste fe . gt) Merge & Center • $

Alignment n

A BCD E F G H

1 snameQ SNO 0
2 John I 101 60

3 Peter 102 70
4 Alice 103 55
5
6

Bob 104 ... . 90„

7

(ii) Select table styles from the design tab present on the ribbon. As a result, excel expands table styles group as show 
below,
• H <*’ ‘ affu-Exce! ? m - S X

' U HOME INSERT PAGE LAYOUT FORMULAS DATA REVIEW VIEW ADD-INS ANALYTIC SOLVER DATA MINING SOLVER HOME TEAM ) DESIGN Si

Table Name: [$i Summarize with PivotTable

; B'O Remove Duplicates 

'Er Resize Table Convert to Range
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;Tab?e 1 » Si'LSSopv
Insert Export Refresh ."
Sheer ’ ’ 0M****

External Table Data

Header: 

(..j Total RC
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Light

X ,fx \ John
A 5 C D E F G H I
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John
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Alice 103: 55
Bob 105 VO,

-

US’

S’

1 whhmi 1

in &R
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(iii) When the user moves mouse pointer among the styles, excel automatically highlights the selected range in the table. 

Now, click on the desired style to make it permanent.
H *> • <* ’ affu - Excel

HOME INSERT PAGE LAYOUT FORMULAS DATA REVIEW VIEW ADD-INS ANALYTIC SOLVER

Table Name: 3 Summarize with PivotTable 

1 Remove Duplicates[Tablel

•fp Resize Table Convert to Range

Properties Tools

M Header Row □ First Column 

LJ Total Row [ J Last Column".....  , si &Ojser, sn Browser
Insert Export Refresh 
Slicer - - $? Unlink iVi Banded Rows LJ Banded Columr

External Table data Table Style Options

A2 I X ■- fi John

A B C 0 E F G H I J K
1 SNAMEB^NO BsmarksH ................... !..............

2
3

John | 101 60

Peter 102 70
4

5
Alice 103 55
Bob 104 90,

6
7

8

yle then
Moreover, user can also modify some elements of the style by using the following checkbox controls.

1. Header Row

The display of the header row is toggled by using this control.

2. Total Row

The display of the total row is toggled by using this control.
3. First Column

Based on the style added to the table, this command may not apply any effect. By using this control, formatting for 
the first column is toggled.

Last Column

Based on the table style, this command may not produce any effect. This control toggles special formatting for the 
last column.

5. Banded Rows

The display of the banded rows is toggled using this command.

6. Banded Columns

The display of the banded columns is toggled using this command.

Filter Button

The display of the drop-down button present in the header row of the table is toggled using this command. 

Therefore, to apply the above controls.

(a) Goto the "Table Style Options" present in the design tab.
bj Select the desired checkbox control from the table style options group.
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Steps for Creating Custom Table Style

(i) Click on any cell present within a table.
tgi S * affu - Excel ? ™ f?

HOME INSERT PAGE LAYOUT FORMULAS DATA REVIEW VIEW ADD-INS ANALYTIC SOLVER DATA MINING SOLVER HOME TEAM DESIGN
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(ii)

(iii)

(iv)

Goto the design tab present on the ribbon.

Select table styles group and click on the new table style option.

As a result, excel display new table style dialog box as shown below,

HOME 3NSERT PAGE LAYOUT FORMULAS DATA REVIEW VIEW ADD-INS
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(v) Choose any table element present in the list.

(vi) Click on format button and specify the formatting for selected element.

Table Name:
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2 John
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5 Bob
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Element Formatting:
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Format
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• ii) Click on OK button and give name for the Table style.

ii) Click on OK. Finally, your custom table style will be displayed in the custom category of table styles gallery.
C* • • affu- Excel ’ IS - a
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3.2 NAVIGATING IN A TABLE, SELECTING PARTS OF A TABLE
Q11. How can a user select various parts of a table?
Answer : Model Paper-I, QH(b)(i)

In Excel, navigating in a table is similar to navigating through a worksheet except the fact that when the user uses 
tab key excel will activate the cell which is at the right of the current selected cell. Additionally, when the user reaches last 
column of the table the cell in the first column of the next subsequent row will be activated unlike in a worksheet.

Selecting Parts of a Table
When the user scrolls mouse over a table in excel, the cursor changes into various shapes which help the user in 

selecting different parts of a table as follows,
Selecting an Entire Column
(a) Keep the cursor of the mouse over the top of the cell within the first row of a table.
(b) Now, either click on the cell twice or press Ctrl + Spacebar on keyboard. This selects the entire column within the 

cell.

FILE

Paste

QS H *5* <*' ’ affi
HOME ! INSERT PAGE LAYOUT FORMULAS DATA REVIEW VIEW

iCaiibri ’Jll ”j A A “ 2^ Wrap Text Ge
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7
8
9

Alice 103 55
Bob 104 90

- 1

10 _ •

Selecting an Entire Row

(a) Keep the cursor of a mouse at the left grid line of a cell within in the first column of a table.

(b) Now either click on the cell twice or press 'Shift + Spacebar'. This selects all the cells with that row.

1 H ♦>’ .<*

HOME

sCaiibri
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INSERT PAGE LAYOUT FORMULAS DATA REVIEW VIEW
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Selecting an Entire Table
< a) Keep the cursor of your mouse over the top left comer of your table.

ih) Now either click on the mouse button twice or press 'Ctrl + A'. As a result, the entire table gets selected as follows,
0s H ' C*- - affu

| FILE | HOME INSERT PAGE LAYOUT FORMULAS DATA REVIEW VIEW

Paste

Caiibri ............d11 ’i A A “ BP Wrap Text JGen
% -

u - a- ft* A- s ' jg :t g Merge &. Center * $

Clipboard r» Font f'i ' Alignment *»

D7 - I X > ft

3.3 ADDING, DELETING NEW ROWS OR COLUMNS
□12. Write the steps involved in adding and deleting rows and columns in a table. 
Answer :
Steps for Adding Rows and Columns within a Table

Initially select any cell within a table and right click on it.

2 Excel displays a shortcut menu as shown below,

03 H ’ C* ’ 5 affu
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3. Select insert from the shortcut menu. As a result the insert command displays the following menu items,

(a) Table columns to the left

(b) Table columns to the right

(c) Table rows above

(d) Table rows below.

® B *5 ~ C* ' ' affu-Excel
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9

4. Now, place the pointer of a mouse at the bottom right cell of a table. Then, click on the mouse button and drag < 
for adding more rows to the table.
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5. Similarly, you can also add more columns by pressing the mouse button and dragging it to the right side of a table.

8S U affu-Excel
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Clipboard
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Font

DATA REVIEW VIEW ADD-If

& Wrap Text 
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$ ’ % »
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Steps for Deleting Rows and Columns from a Table

1. Choose any cell that is to be deleted from either a row or a column.

2. Then, right click on the cell. The following shortcut menu appears on screen.

Properties
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3. Select delete -> table rows. As a result rows get deleted from the table.

® H ♦> ’ f* • = af

H39I HOME insert page layout formulas data REVIEW VIEW
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Paste ■
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Clipboard Font

• 5 f X ✓ fi If

>* gp Wrap Text

E § Merge & Center

Alignment

C5

1
2

A ' B C D E F G H
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6

A A

4.

5.

Similarly to delete multiple columns, select any cell within a table and right click on it. 

Now, choose delete from the table columns.
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3.4 MOVING A TABLE, WORKING WITH THE TOTAL ROW
Q13. Describe the method for moving a table to new location.

Answer ; Model Paper-Ill, Q11(bXi)

The steps involved in moving a table to a new location within a similar worksheet are as follows,

(i) Initially, move the mouse pointer to one of the table borders.

0 H ’
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PivotTable Recommended Table
PivotTables
Tables

Boo

PAGE LAYOUT FORMULAS DATA REVIEW VIEW

Store
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5
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(ii) When the pointer of the mouse turns into a cross containing four arrows click on it and drag the table to the desired
location.

®i H <*. - *
HOME INSERT PAGE LAYOUT

V. * 
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Paste

jCalibri -]ll -j A A*
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Clipboard Font ri
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16 PETER 13 300
17
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(0

The steps involved in moving a table to different location are as follows,

Select any cell within a table and press Ctrl + A twice. As a result, the entire table gets selected.

Book? - Excel

FILE HOME INSERT PAGE LAYOUT FORMULAS DATA REVIEW VIEW ADD-INS

jCah'bri ’jll ’ A A - gp Wrap Text [General

B I J ’ .... - ’ A ’ ==P i £e== Cgcr ggsj Merge & Center - $ ’ % » ’

Font ft NumberClipboard r* Alignment

• ii) Now cut the selected cells by pressing Ctrl + X.

f iii) Activate the destination worksheet and click on the position where you want to place the table. 

I iv) Finally, paste the table by pressing Ctrl + V.
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w a *->
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Q14. Write short notes on working with the total row in excel. 

Answer : Model Paper-I, Q11(b)(ii)

In an excel table, user can total the data quickly by displaying total rows at the end of the table and also by using 
the functions that appear in the drop down lists. The following steps are involved for displaying total rows in excel,

1. Click on any cell which is present within the column whose values are to be added.

2. Select "table style options" group present in the design tab of the ribbon.
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Table Name: p| Summarize with PivotTable

•Table2 | i |'| Remove Duplicates

0 Resize Table ; ^Convert to Range 

Properties Tools

.f

SJ Bi
Insert Export Refresh

. 8ook2 - Excel

DATA REVIEW VIEW ADD-INS

~ropert.;ei ** Headet Row

7. Open in Browser Total Row

» Uniinlc Banded Rows

External Table Data

ANALYTIC SOLVER

First Column 

Last Column 

Banded Columns

DATA MINING 

✓I Filter Button

SOLVER HOME

Sj - £
DESIGN ■

Table Style Options

Total Row (Ctrl+Shift t-T)

SB

ssBsa *
R- 7 ;

Table Styles

1
A S C D E r G

Turn on or off the total row of the
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3. Check mark the total row checkbox present in table style options.
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In excel, sum of the values are displayed in column containing numbers by default. But, sometimes user may wish 

to have different formula for adding the values. In such cases, select a cell in the total row and when the drop down arrow 
appears in the cell click on it. As a result, excel displays a drop down menu containing various summary formulas as shown 
below,

(i) None

This field does not contain any formula.

(ii) Average

This field is used for calculating the average of the numbers in the column.

(iii) Count

This field is used for displaying the number of values in a column.

(iv) Count Numbers

This field is used for displaying the number of numeric values present in a column.

(v) Max

This field is used for displaying maximum value present in the column.

(vi) Min

This field is used for displaying minimum value present in the column.

(vii) Sum

It calculates sum of the values in a column.

(viii) StdDev

This field is used for calculating standard deviation of the values in a column.

(ix) Var

This field is used for calculating the variance of the value in a column.

(x) More Functions

This field is used for displaying insert function dialog box so as to select a function which is not available in the list.

3.5 REMOVING DUPLICATE ROWS FROM A TABLE
Q15. Discuss the method for removing duplicate rows from a table. 

Answer : Model Paper-Ill, Q11(b)(ii)

In excel, data duplication generally occurs on compiling data from multiple sources. When duplicate values are 
removed from a table then only the selected range of cells are affected. Moreover, deleting duplicate values from a table 
is an easy task. The following steps are involved in removing duplicate rows from a table,

(i) Select any cell or range of cells within a table.

(ii) On the design tab, in the table tools group, click on Remove Duplicates.
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(iii) As a result, excel displays Remove duplicates dialog box. Then, Do one or more of the following,

❖ Under the list of columns, place a tick mark next to the column that is to be included in duplicate search.

❖ Click on select All button to quickly select all columns.

❖ Click on unselect All button to quickly clear all columns.

Click OK. Then, excel displays a message notifying how many duplicate values were removed, how many unique 
values remain or no duplicate values found.
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3.6 SORTING AND FILTERING A TABLE, CONVERTING TABLE INTO RANGE
Q16. Explain in detail about sorting a table.

Answer :

On sorting a table, data in rows gets organized based on the contents of a particular column. After sorting, data is 
displayed in alphabetical order. In excel, sorting can be performed in either of the following ways,

(i) To sort a table by a specific column, click on the filter button present in the column header and select one of the 
sorted commands.

(ii) To sort a table depending on the text color or background color of a cell select sort by color.

(iii) To sort a table by number of columns, perform sorting on the less frequently used column first and continue till you 
reach the most significant column.

In addition to this, sorting can also be performed using the sort dialog box in the following manner,

1. Select home tab present on the ribbon.

2. Click on the sort and filter option present in the editing group.
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Select custom sort.
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As a result excel displays sort dialog box as shown below,
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5. Now, specify the sort settings by using the drop down lists.

6. Finally click on OK button to apply the above settings.
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7. When custom sorting is applied on the specified field as a result an arrow T appears beside this field. When the user 
clicks on the arrows, excel displays drop down menu for performing different types of sorting.
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Q17. Explain in detail about filtering a table.

Answer :

Filtering a table refers to the process of displaying only those records that satisfy specific criteria. 

The following steps are involved in filtering a table,

(i) Click on any cell within a table.

(ii) Select the data tab and click on "Filter" option present in the sort and filter group.
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© Tell me more.

Filter (Ctrl* Shift* I)

Turn on filtering for the selected 
cells.

Then, click the arrow in the column 
header to narrow down the data.

(iii) As a result, arrows appear in the column header. Then, click on the arrow next to the desired filed in your table. I 
displays drop down menu.

(iv) Click on Select All to clear all the checkboxes and check mark the checkbox next to the desired attribute.
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(v) Click OK. As a result, excel displays the data corresponding to the selected field.
® B t> ’ ’ SSi ” Book2 - Excel ? GB

L _ I HOME INSERT PAGE LAYOUT FORMULAS DATA REVIEW VIEW DEVELOPER OFFICE TAB DESIGN

iai :

Get External 
Data ’

ih,

Refresh
All”

© Connections

Properties

Q Edit Links

si {TiT{ 
*♦ IaIxi

H s°rt

T
c Fitter

jT Clear

I Reapply

:■ X' Advanced

piSt, Flash Fill
bjO --

Remove Duplicates
Textto

: Columns §9 Data Validation *

l*a Consolidate 

l§y What-If Analysis ’

•^ Relationship;

® Group v i Data Analysis

® Ungroup ’ “di i

88 Subtotal

B2

Q Book4 Q NEWSCREEN
~~~ ... A _ B

1 /" 
zi Sort A to Z 

I | Sort Z to A 

Sort by Color

X &** Filt*r F«jm "COUNTRY “ 

Fijt-?! by Color

Text Filters

{Search

CT Book2

C

Pi

■ (Select All) 
!-O AUSTRALIA 

i-Q INDIA

re

• i) Similarly your can filter multiple values in a column by placing multiple check marks. For instance, if the user
desires to see USA listings in which the type is single family. Click the arrow next to family.

• ii) Click on Select All to clear all the checkboxes and click on the checkbox next to single family.

• iii) Click OK. As a result, excel displays the population in USA in single family.
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Removing a Filter

Filter can be removed from a table in either of the following ways,

(i) To remove filter from a single column click on the drop down arrow in the row header and choose clear filter.
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(ii) To remove a filter from multiple columns select home tab 
group -> select clear.

click on sort and filter option present in the editing

Q18. Write about the following,

(a) Filtering a table with slicers

(b) Converting a table into range.

Answer :

(a) Filtering a Table with Slicers

Slicers are generally like filters but they are more easier and faster to use. Slicers provide buttons which help the 
users in filtering the table data and knowing the current filtering state. The following steps are involved in inserting a slicer

(i) Click on any cell within the table.

OS - H *> - c* * -
FILE <|>ME INSERT PAGE LAYOUT FORMULAS DATA REVIEW VIEW

Table Name. : Q Summarize with PivotTable 

jlablel Remove Duplicates

Resize Table ; Convert to Range

Properties Tools

Insert Export Refresh 
Slicer

PI Properties

in Browse? 

Unlink.

affu - Excel

ADD-INS ANALYTIC SOLVER DATA MINING 

: Pi Header Row L.j First Column R.i Filter Sutton 

i L..I Total Row [J Last Column

i Pi Banded Rows i... i Banded Columns

Table StylesExternal Table Data Table Style Options

(ii) Goto the "Table tools group" present in the design tab.
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mg

$7
(iii) In the "Table tools group" click on the "Insert Slicer" command. As a result, insert slicers dialog box appears.

as a ♦>- <»•» -
lNSERT PAGEiAYOUT FORMULAS DATA REVIEW VIEW ADD-1

TabteName: ; [^Summarizewith PivotTable ;?HK§ • ^Properties; V; Header Row First Column

iTablel i : Remove Duplicates ’•........ ' :;^.c.(panin&t<w.-ar Total Row ?J last Column
■ .... Insert i Export Refresh „

> Resize Table Convert to Range Siicer , <^ Uniifst • 'A Banded Rows Banded Columns

Taijte Style Options

ANALYTIC SOLVER DATA MINING SOLVER HOME TEAM i DESIGN i Sk 

v Fitter Button

? r.............. ............................ -....
i RENAME 
i Qsno 

^SMARKS
John 20l|

Peter 202:

Alice 103

Bob • 204

-

Sheetl J(?)

(iv) Select the desired field and then click OK.

i’L

» a <>• <♦- •.
' OME INSERT PAGE LAYOUT FORMULAS DATA REVIEW VIEW ADD-INS ANALYTIC SOLVER DATA MINiNG SOLVER HOME TEAM

Table Name: O Summarize with PivotTable J

iTablel i Remove Duplicates

size Table ^2 Convert to Range

i JHH i '? Properties 
: <~x

Export...........

; ;yli Header Row f.J First Column 

Total Row Last Column

,< Banded Rows Banded Columns

the
cer,

(v) Now, excel displays the slicer next to the user table. In this slicer every selected item will be highlighted in blue.
»«•>-<» » aim-Ki . '? ?!- - 5

HOME INSERT PAGE LAYOUT . FORMULAS DATA REVIEW VIEW ADD-INS ANALYTIC SOLVER DATA MINING SOLVER HOME TEAM OPTIONS : 1

Sheer Caption: 

iSNO

5 :
6 '
7 :

8 

9
20 i 

22 1 
12 ; 

13 i
24 j

25
26 i

v,...../*.

C
[sWAMFBbNO B SMARK$BM|-. 1??'' " ; ‘ :

John 101 60
Peter 102 i 70

Alice 103 80

Bob 204 . .. 50.

Firing FiXiSSiKl ' 

Ss-ixt Satfcwsrcs •
EX Selection Pane 

Arrange

: ■£5- Columns: 2 

1 11 Height 026'

3 Width: 1.82"

IB Height b.7"iwr

1113 i<
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(vi) On selecting or deselecting items from the slicer, the changes will be reflected in the pivot table as follows,

01 S3 ♦>•_«*
HOME

Sheer Caption: 

SNO
W3 
Report

@ Slicer Settings , , )lOns

Sheer

SNO

FORMULAS DATA

------- -•--------

Sheer Styles

affu - Excel 

VIEW ADD-INS ANALYTIC SOLVER DATA MINING SOLVER HOME 

. Bring forward v * '““Columns: 1 

"J. Send Backward
Bu Selection Pane

Arrange

IB Height:026" 
£3 Width: 1.81" 

Buttons

? GB - © 

TEAM OPTIONS

? D Height 2.7’

Swidtfc r J

Size >»

SNAME S3 SNO £3 SMARKS g3

SNO

(lot “--------------s

102

103

104

(b) Converting a Table Back to a Range

After creating an excel table, sometimes the user may require only table style but not table functionality. In such a 
case user can convert a table back to its normal range by performing the following steps,

1. Click on any cell within the table.
H *>• «*- .

SB HOME INSERT

affu-Excel ? ® - g X

PAGE LAYOUT FORMULAS DATA REVIEW VIEW ADD-INS ANALYTIC SOLVER DATA MINING SOLVER HOME TEAM DESIGN Sr.

> Resize Table 

Properties

; |§Zg Summarize with PivotTable 

Remove Duplicates

: Convert to Range

Tools

Property Header Row
i /N

.  1 s-' r7:Opetun Total Row
Insert Export Refresh 
Slicer - •

External Table Data

I First Column 

j Last Column

P: Sanded Rows \ ’”] Banded Columns

Table Style Options

i>; Filter Sutton

Table Styles

1
A B C D E F G H I ) K L M N 0 P

SSS ”1

2 John 101 6o|

3

4

Peter 102

Alice 103
70

30
5

6
7

Bob 104 .................5ft.........................................

2. Now, select table tools group present in the design tab of the ribbon.

8 *> {♦ =.
SB HOME INSERT

affu - Excel ?

PAGE LAYOUT FORMULAS DATA REVIEW VIEW ADD-INS ANALYTIC SOLVER DATA MINING SOLVER HOME TEAM

aa - 5 

DESIGN

Table Name: ; [Tj Summarize with PivotTable ss i Properties iyj Header Row L First Column [V; Filter Sutton

^Tablel , |’| Remove Duplicates 1SJ
" ...w I Jr Open in Brower

Fvnnrt RpfrAsh
Lj Total Row f” Last Column

'£1* Resize Table Convert to Range Slicer . V » Unlink : V: Sanded Rows I Banded Columns
- ---------- 1-------------- ---- -1

External Table Data Table Style Options Table StylesProperties Tools

2 v Convert to Range

........4 Convert this table Into a normal
snge of cells.

2 {John All of the data is preserved.

3 Peter 102 70
4 Alice 103 80
5 Sob 104 50,

3. Click on "Convert to Range" option present in the tools group. 

As a result, the table features are no longer available.
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3.7 FORMATTING TOOLS ON THE HOME TAB, MINI TOOLBAR
Q19. Where are the cell formatting tools available in Excel?
Answer : Model Paper-ll, Q11(b)(ii)

In excel, cell formatting tools are available in the following locations,
❖ On the home tab of the ribbon.
❖ On the mini toolbar which is displayed when the user right clicks on a cell.

❖ On the format cells dialog box.
(i) Using the Formatting Tools on the Home Tab

Formatting tools present on the home tab of the ribbon helps the user in changing fonts alignments and other 
appearance of the table or worksheet. These formatting tools can be used by clicking the small arrow (X on the button and 
the button displays list of choices in the form of a drop-down list,
(ii) Using the Mini Toolbar

A mini toolbar facilitates the user by displaying the options for cutting, copying, pasting, inserting, deleting, sorting, 
filtering, formatting the content and so on. This toolbar appears on screen whenever a user right clicks on a cell and it 
remains visible until the user selects some option for cell formatting. A mini toolbar can be made hidden by clicking any 
cell or pressing the ESC button on keyboard.
(iii) Using the Format Cells Dialog Box

Format cells dialog box is generally used for applying any kind of stylistic formatting and number formatting. This 
type of tabbed dialog boxes include six tabs namely number, alignment, font, border, fill and protection.

3.8 FONTS, TEXT ALIGNMENT, WRAPPING TEXT TO FIT A CELL
Q20. How do you format a worksheet by using different fonts?
Answer :

Fonts can be generally defined by their typeface and size. As the height of a row in excel is 15pt and since excel uses 
1 lpt Calibri font by default there exists small amount of blank space between the characters in adjacent rows. The different 
fonts and font size tools present on the home tab of the ribbon can be used for changing the size of cells on a worksheet. 
Moreover, to use additional fonts that does not appear anywhere, user can select them from the font tab in the format cells 
dialog box. Its not only provides access to fonts, font sizes, font color but also includes settings for subscript superscript, 
and various types for underlining.

The following steps are involved in changing the font style of a cell,

1. Select home tab present on the ribbon and goto the font group.

2. Select a cell or range of cells that you want to format.

3. Click on the drop-down arrow [X which is next to the font style. As a result, format cells dialog box appears.
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4. Then click on the font button in the dialog box and choose the desired font style or font size from the displayec 
preview.

EP H *>• C*'

HOME

Clipboard c

a; S -

INSERT PAGE LAYOUT

116 •j.A A 

> ’ A ’

FORMULAS DATA

- ==. W Qeneral

.00 ~,o Ip Cd| style

NEW SCREEN - Excel

REVIEW VIEW DEVELOPER OFFICE TAB 

® Conditional Formatting' 

E? Format as Table *

Alignment Styles

M ■' fx JOHN V

Q21. List out the most commonly used alignment commands in the excel 2013. 

Answer :

In excel, the cell contents can be aligned horizontally and vertically. This alignments can be done by using d t 
alignment commands present in the alignment group of the home tab.

Selecting Horizontal Alignment Options

Horizontal alignment options are used for distributing the contents of a cell horizontally. The various horizona 
alignment options present in the format cells dialog box are as follows,

(i) General

It is a default alignment option which aligns numbers to the right, text to the left and centers the logical and era 
values.

(ii) Left

It aligns contents of the cell at the left side. But when the size of the text is large then the text may enter into tfe| 
right side of the cell due to which it may become unclear to the user.

(iii) Center

It aligns the cell contents in the center of the cell. But, if the entered text is too large then it may also appear on eith 
sides of a cell. Due to this, the text becomes unclear and also appears on the ribbon.

(iv) Right

It aligns the contents of the cell to the right side. But, if the size of the text is large then it may spill over the left > 
and become unclear.

(v) Fill

It places text into the cell until the width of the cell is filed completely.

(vi) Justify

It justifies the cell contents to the left side and right side of a cell. This option can be applied only when the cel 
formatted as wrapped text.

(vii) Center Across Selection

It aligns the text at the center of the selected columns. It is mainly useful for displaying a center heading over mule? 
columns.

(viii) Distributed

It distributes the text uniformly across the selected columns.
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Selecting Vertical Alignment Options

Vertical alignment options are useful only when the height of the row is adjusted. The following are the various 
vertical alignment options present in format cells dialog box,

(i) Top
This option is used to align the cell contents to the top of the cell. It also appears on the ribbon of a worksheet.

(ii) Center

This option centers the contents of a cell vertically. It also appears on the ribbon of a worksheet.

(iii) Bottom

This option aligns the contents of a cell to the bottom of the cell. It also appears on the ribbon of a worksheet.

(iv) Justify

This option justifies the text vertically in the cell. It is used for increasing the line spacing.

(v) Distributed

This option distributes the text uniformly in a vertical fashion.

Q22. What is the use of wrap text option present on the ribbon? 

Answer :

In excel, when the size of a text is too long user can use wrap text option or shrink to fit option. These two options 
enables the user to enlarge the cell enough to fit the text. On enabling shrink to fit option the font size of the text will be 
reduced automatically so that the text fits without wrapping. On the other hand, wrap text option does not shrink the size 
of the text but fits lengthy headings on multiple lines in a cell.

The following steps are involved in wrapping or shrinking text to fit the cell,

(i) Select a cell containing text which is too long to fit in the cell.

(ii) Right click on the cell and select "Format cells" option from the menu list.

(iii) As a result, excel displays format cells dialog box.

0 *>- c* »
HOME INSERT

-U Calibri

PAGE LAYOUT FORMULAS DATA

Alignment

8c oO
REVIEW VIEW DEVELOPER OFFICE TAB

gg Conditional Formatting" Insert ’ 52

........ ............... Format as Table ’ ^Delete ’

% ’ 'm -o Cell Styles - ©Format- <

Number f» Styles Cells

? X

Sign i

Sort& Find St 
Filter’ Select’ 
Editing

A’ A

X X Jx N Balaguruswamy

Book4 8 NEW SCREEN * qh Book2* q' Boota’
A B C D E F G H

; ENAME ENO ESALARY

rmatCefls ; v tod

£ Font • Border I.....Fill....J Protection

Category:

Number
Current
Accounting
Date
Time
Percentage
Fraction
Scientific
Text
Special
Custom

Sample

: Balaguruswamy

General format cells have no specific number format

OK • Cancel ;Xez.z..-...... C............. ... a...* 1

SIA PUBLISHERS AND DISTRIBUTORS PVT. LTD.



102 EXCEL FOUNDATION
(iv) In the format cells dialog box, goto the alignment tab and select wrap text checkbox.

B BI *>• f* W S -■
HOME INSERT PAGE LAYOUT FORMULAS DATA REVIEW VIEW DEVELOPER OFFICE TAB 

*' Cal.br, Jll -A' A* 22 - _ » 6,n,ra. - Ig, Condfconal Forming

Paste

Clipboard

B 1 U
• A* A “S w ■ i; ?' General

Alignment fi Number

££? Format as Table ’ 

cell Styles’

fi Styles

’ H" Insert *

^ Delete ’ -

HI Format’ -

Cells

zT ft
Sort fit Find & 
Filter’ Select’

fx Balaguruswamy

Book3- Excel 

REVIEW VIEW

General

$

$ X 
Sign in

(v) Click OK.

B B I* - Sj a 5
HOMS INSERT PASE LAYOUT FORMULAS DATA 

, * Calibn -11 • A' A ss — Pf

y b i m • £ . . a « « « « « B •

>erd n Font ii Alignment

* fx Balaguruswamy

% » *<>s <•%
Number r>

DEVELOPER OFFICE TAB 

i S§! Conditional Formatting • 

Format as Table ’ 
tpCell Styles’

Styles

S" Insert - Z ' 

1* Delete • ’

B Format’ ; •

Cells

zT ft
Sort fit Find fit 
Filter • Select * ;
Editing

A 8 C 0 E F G H I J K
ENAME ENO ESALARY
Balaguru

swamy
ischand

101 70000
102 70000

3.9 COLORS AND SHADING, BORDERS AND LINES
Q23. Write the steps involved in changing the color of a text and background. 

Answer : Model Paper-ll, Q11(b)(1)

In excel, user can change the text color or can add colors to the background of the worksheet by performing the 
following steps,

(i) Select a cell that you want to highlight.
EP B *>- <*- «
—i HOME INSERT PAGE LAYOUT

iCaii&h <2 1 A A
t:Q5)

Paste B / SI ’ i E -

Clipboard fi Font

C3 : X fx 70

A B C D
i

2 iJohn 101 60
3 | Peter .........................lO^E. 70j

4 Alice 103 80
5 ;Bob 104 ...... 5°a

gi? Wrap Text

•§=? Merge &Center 

Alignment

I L /
, os Conditional Format as Cell
’ os ~=.s

Formatting ’

6
? f

zT AJ* Delete - Si’- ""
Sort& Find& 
Filter * Select *

Editing

“ Insert

Table- Styles- S Format- <-

Styles
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Click on home tab present on the ribbon.

In the font group click on arrow next to the fill color.

|j - ■

Paste

CVvphoard

Calibri

* aftu-fcx&e* r T — (5

INSERT PAGE LAYOUT FORMULAS DATA REVIEW VIEW ADO-INS ANALYTIC SOLVER DATA MINING SOLVER HOME TEAM DESIGN S

z§T Insert

CEL

’ll • A A “sfe g>WnpT«» «nw „
u». -» J'Oeiew - fg

L> « a B« @MeR|e&Ca4e> $-% ’ *J Coonittona! Formal« Cell »
Fomatting- Table- Styles- ®jfornia’ Filter - Select

crlt IHMeaCsAoM ybgwnwfc nV Muntow n statesS M«B«W l..V._.......... ................... ............ .........................................

Z

Sort& Find &

tdfeg

(iv)

t SOFT*

2 John
3 | Peter

4 Alice
5 iBob

101
102f

103
104)

. Standard Colors ?

.■■■siBBMaaai
**>«.......................... .[■■

More Colors...

Select the desired color from the displayed theme colors or standard colors. As a result, excel fills the selected cell 
with the selected color.

? 03 - i3

DATA MINING SOLVER HOME TEAM DESIGN 

“Insert ’ Z ’ A-» JkA,

» affu • Excel

INSERT PAGE LAYOUT FORMULAS DATA REVIEW VIEW ADO-INS ANALYTIC SOLVER

’jU U* Wrap Text General .... »! V 43* ^Delete
E-

- ««t!@'MK9aifc enter - $-%’ » 4 Conditional Format as Cel! B _ Son & Find &
Formatting ’ Table * Styles ’ *»a - Filter ’ Select -

Clipboard i» font o Alignment r- Number a Styles Cells Editing

C3 »j / JS 1 70

A 6 C DEFGH1 JKL M N O P

2 John 101

3 |9eter 1O21HHP
4 Alice 103 80
S Bob 104 50,
6 i
7 i

« 5> h It
I u

A A

Q24. Write about adding borders and lines in Excel.
Answer : Model Paper-ll, 011(a)

In excel, borders and lines are generally used to combine group of similar cells. Excel provides 13 preset styles of 
borders. Borders and lines can be added to a worksheet in distinct ways.
Adding Borders by Selecting Different Line Styles and Colors
1.

2.

3.

Select any cell or range of cells.
8s H ♦>-<*• . • • ' affu-Excei ■ » B - -9 X

8BS|| HOME INSERT PAGE LAYOUT FORMULAS DATA REVIEW VIEW ADD-INS ANALYTIC SOLVER DATA MINING SOLVER HOME TEAM DESIGN Si

A1 ’ fx SNAME v

ABC D E F G H i J K L M N 0 p

1
2 Wm ioi so
3
4
5

Peter 102 70
Alice 103 80
Bob 104' 50.

6
7
ft

Click on the home tab present on the ribbon.

Click on the arrow next to the borders icon present in the font group.
® B affu - Excel ? ts

HOME INSERT PAGE LAYOUT FORMULAS OATA REVIEW VIEW ADD-INS ANALYTIC SOLVER DATA MINING SOLVER HOME TEAM DESIGN Si)

,x Cahbn

8 I U

• A A

’ A -

Wrap Text fW EBB 53 - 2 - a&De,ete. z

2 John 101.
3 Peter 302

Bottom Border

4
5

Aik e
Bob

.• 103
104

App7 borders to the current 7 
se eded ceils.

fe fe • SStj Merge 8t Center - $

Alignment ■» i

t it
Sort & Find &- % * eo « Conditional Format as Cell ~

Formatting’ Table’ Styles’ ormat <.. Fjfter’ Select
Number n styles Cells Editing
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4™ As a result, excel displays a dropdown menu. Select the desired border option from the menu list.

J H *5 • <* ? - S>

iCa;ibri (IF Wrap Text

' -i?'- < / Mergeer Center

inert

affu-Excel

Clipboard
2 .IsWl 101
3 Peter 102
4 Alice 103
5 Bob

Toe Border 
I! Left Border

r M - :7 • Jfc-A-
, Borders

! If Si •
y ^ee Conditional Format as Cell 

\ Formatting ’ Table - Styles '•

1-Insert ’ x Z ’

$*0 Format 

Cells

Filter ’ Selectv 
Editing

6.

(a)

(b)

(c)

10 i

11 ' 

12 '

13 '

14 '
15 ’

16 

1? 

18

• IS
20 
21 ’ 

.2.2.....

ill Eight Border 

&© Sotcei

ffl Ail Borders 

j EH Outside Borders

□ Thick Sox Border

Bottom Double Border 

' bd Thick Bottom Border 

Top ansi Bottom Border

■__ Top and Thick Bottom Border

Qj Top and Double Bottom Border 

i Draw Sorters

HE Dra& Border 

i i [X Draws Border grid - •

•i •$. £rase Border 

|:i2.,...i.-d.e„Co-or,...................... .........
..... ,,,| N, j, „  .......

Excel applies the selected border around the selected range of cells.
® H *3- <♦ • affu Excel ? ® _ 9

Uohrt 101 60
; Peter 102 70
• Alice 103 80
;8ob 104 50.

Similarly, to chanj 

Click on the Horm 

Click on arrow ne 

Select line style/li:
® H *>- t+ =

HOMF INSERT

<S.

Paste

i Calibri

B / U -

Clipboard •« H
2 John 101
3 Peter 102
4 Aike
5 Sob 104

Tea Border 

Left Border
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(d) Select the desired Line color/Line style.
a c* • »•

HOME INSERT

> *

PAGE LAYOUT DATA REVIEW

affu - Excel 

VIEW ADD-INS ANALYTIC SOLVER

I L'

DATA MINING

Conditionai Format as Ceil 
Formattingv Table ~ Styles -

Styles

SOLVER HOME 

fh insert ’ Z ’ 

& Delete ' £j -

Format • g_ -

Cells

TEAM DESIGN

m
Sort & Find &
Fitter - Select ~ 

Editing

9 \ 
10 | 

11 ;
12 r

13 |

14 i

FH ad Sorbet 

[~j Dutj-oe SorJets 

i Q Prick Box Border 

ii Sottom Do!jb* Border 

_ TQsc* Bottom Border 

^2 Top eng Bottom Border

too and Thfix Bottom Border
15 2 Top and Dcgbie Bottom Borde
16

17 Draw Borders

18 Ti Dra& Borde

19

20

21

E'ift Dtaw Border £po 

£ra?e 3o<de^

; Line Color >

i Sheetl i une 5W * «r

I SLAP* 1. ............. ...T................................ 1 AWRACL-W.n COUNT. IS SUM'WO 4 !«

(e) As a result, excel applies the line settings when you click on any cell within the table.
S ’ affu-Excel ? SB - S’

11111(1 HOME INSERT PAGE LAYOUT FORMULAS DATA REVIEW VIEW ADD-INS ANALYTIC SOLVER DATA MINING SOLVER HOME TEAM DESIGN

j A1 ’ fx SNAME

A B C D E F 6 ' H. 1 i < L M O P

John 101 60;

; Peter 102 70 i

1 Alice 103 80

;Bob 104 50,

a

Adding Borders by Using Border Tab of the Format Cells Dialog Box

1. Right click on any cell within the table.

2. Select Format cells option in the menu list.
gi fcl *>- W O *

HOME INSERT PAGE LAYOUT FORMULAS DATA

Table Name: Summarize with PivotTable 

Remove Duplicates ~;Table2

Resize Table §3 Convert to Range

Properties Tools

Insert
Slicer
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; External Table Data

Book2 - Excel

REVIEW VIEW DEVELOPER 
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A2 fi
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3. Excel displays Format cells dialog box. Then Click on Border button present in the dialog box.

88 a *3 ’ <» - Si §* • £§ ■■ S ;
|K55S| " HOME insert page layout

Table Name: ^Summarize with PivotTable f3

Remove Duplicates|T»ble2 | |

Resize Table §1? Convert to Range

Properties Tools

■ Bookx • •

FORMULAS DATA REVIEW VIEW DEVELOPER OFFICE TAB

I Header Row O First Column Ed Filter Button
! : ...... . ...

L.J Total Row LJ Last Column
Insert i Export Refresh _
Sheer • » i Ld Banded Rows LJ Banded Columns

• External Table Data Table Style Options

A2 ’■ V /l

A'; Book4 I?'; NEW SCREEN* 0 >5oOk2 
A B ‘ C

i 3BBCfflSEEEDE»y
" 3' Book3’

"d............ e....

None • — .

Color:

1 1 i 
s? I i*

£3

None Outline Inside

Border

H 3 L

Text

H *3 r
B B H

The selected border style can be applied by clicking the presets, preview diagram or the buttons 
above.

EC jiwU

4. Then, select the Line style, Line color and Border style.

FORMULA

I Si

a§ a *>- <*' ® m * 
H0ME WSERT PAGE LAY0UT

Table Name: f§J Summarize with PivotTable !

|*| Remove Duplicates;Table2

Resize Table Convert to Range

Book2 • txa-J

FORMULAS DATA REVIEW VIEW DEVELOPER 

h ED Header Row LJ First Column
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Insert Export Refresh
Slicer ‘ «• bd Banded Rows LJ Banded*Columns

i External Table Data ; Table Style Options

OFFICE TAB 

3 Filter Button

TABLE TOOLS

DESIGN

Quick 
Styles v
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5. Click OK.

ffl H *b- «» a: S »
| HOME INSERT PAGE LAYOUT 
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Book2 - Excel 
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5

3.10 NAMING STYLES
025. Write the steps involved in,

(a) Applying styles to a cell

(b) Modifying an existing style

(c) Creating new styles

(d) Merging styles from other workbooks

(e) Controlling styles with templates.
Answer :
(a) Applying Styles to a Cell

Select the cells or range of cells within a table where you want to apply the style.

Model Paper-Ill, Q11(a)
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Now, click on the home tab present on the ribbon.

Then, goto the styles group and click on the More drop down arrow next to the cell styles.
a *>- <* =
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4.

(b)

As a result excel displays a set of styles. Now, select the cell style that your intended to apply.
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INSERT PAGE LAYOUT
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Modifying an Existing Style

1. Click on the more dropdown arrow present in the style gallery of the styles group.

2. Select the cell whose existing style is to be modified and right click on it.

3. Select modify from the shortcut menu. As a result, style dialog box appears on screen as shown below,
B faj *9 ' * Sook2-Exce! ? 3B _ S>

HOME INSERT PAGE LAYOUT FORMULAS DATA REVIEW VIEW ADO-INS ANALYTIC SOLVER DATA MINING SOLVER HOME TEAM DESIGN

g'Wraeta, Ce,™ - f. y |

” ........ ........ •----------------------------------- OBI-
«g*K

i iGenerai

$ ’%
r

: *s » Conditional Forma! as Ceil Sort& Find& ;
| Format- < - Filter’Select’

CSpbssrd <» fori •» : Alignment ; Good, &sd and Neutral

C2 • i ■ X V /» loo Norm.1 M , Good Neutral

A B C D E Data and Made!

...A.. Calculation Exp/cmittory F... Linked Ce« Note
. 2 ALICE ifjiWtWS | Output | War ning Text

3 808 12; 200
4 PETER 13 300, ; Trtfas and Headings

5 Heading 1 Heading 2 Heading 3 Heading 4 Title Total
6
7 ’

; Themed Cel! Styles

20% -Accent? 20% - Accent4 20% - Accents8 ; 20% - Accentl 20% - Accent2 20% - Accents

9 40%-Accentl 40% - Accent! 40% - Accent! 40% - Accent* 4S%-Accents 40% - Accents
10
11
12
13
14

15
16 ; 
17 i 

..18.1.

• 8SBB3C’-’;

L Number Format
J Comma Comm, • Percent

IHiH hjew Ceii Style 

i^l Mercs Styles...

A^siy

Modify.

Supikate..;

Delete

Add Sailer? to Quick Access Toolbar

h ft
B I U

©

4. Click on the format button. Then, excel displays format cells dialog box as shown below,
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5. Select the desired formatting and click OK.

gS H »
HOME insert
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6.

(c)

1.

3.

4.

Click OK again to close the style dialog box.

Creating New Styles

Select a cell where you want to create a new style.

Right click on the cell and choose modify. As a result, excel displays format cells dialog box.

Now, make the desired formatting in the format cells dialog box.

Then, select home tab -» styles -> cells styles and choose new cell style. This displays style dialog box as shown 
below,

H *>- c*
HOME INSERT PAGE LAYOUT FORMULAS DATA REVIEW

Calibri Light -jll ’i A A "*»{T A A

b / u A-
HE Wrap Text

Font

Style name:

Bbok2 - Excel

VIEW ADD-INS

General

ANALYTI

] Merge & Center

" ms
» i .00 C< 
* i .CO

Number

Fo

X ✓
Format...

1
ALICE llfl

2
3 BOB 12
4 PETER 13
5
6
7
8
9

10
11
12
13
14
15

18.1 Number General

181 Alignment General Bottom Aligned

gj Font Calibri Light (Headings) 11. Background 1

181 Border No Borders

181 HU Shaded

pi Protection Locked

Cancel

SIA PUBLISHERS AND DISTRIBUTORS PVT. LTD.



110 EXCEL FOUNDATION

Type your desired style name in the style name field of the style dialog box.

® H «>’<♦’ » Book2 -Excel
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Paste
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6.

(d)

1.

2.

Click OK button to create the style.

Merging Styles from Other Workbooks

Open two workbooks wherein the first workbook includes some cell styles and the second workbook is where you 
wish to apply some style.

Activate the second workbook and click on the "Cell style" button present on the ribbon.
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3. As a result, drop down menu appears on screen.

4. Click on the "Merge styles" button in the drop down menu.
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5. Select first workbook in the merge styles window.

in a *> * - -
HOME INSERT PAGE LAYOUT FORMULAS

ICalibri

Conditional Format as 

Formatting * Table - SI

’ 11 A A

Book? ■■ Excel
DATA REVIEW VIEW ADD-INS , ANALYTIC SOLVER DATA MI 

: §> Wrap Text [General

3? i Eg Merge & Center - $ ’ % ’

Alignment . i Number r»

>u

b i u -

Clipboard & Font

’ ❖’A

6. Click on the OK button. As a result the cell styles in first workbook can also be used in second workbook.

(e) Controlling Styles with Templates

1. Create a workbook.

2. Apply any desired style to your workbook.

3. Save the workbook as template and apply the desired styles from styles gallery present in the home tab on the ribbon.
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INTERNAL ASSESSMENT
I. Multiple Choice Questions

1. ________ control toggles the display of the drop down buttons in the tables header row. [ ]

(a) Header row

(b) Banded rows

(c) Filter button

(d) Banded columns

2. To select an entire column move the mouse to the________ of a cell. [ ]

(a) Top

(b) Left

(c) Right

(d) None of the above

3. To add a new column to the end of a table, select a cell in the column to the________ of a table. [ ]

(a) Left

(b) Right

(c) Top

(d) Bottom

4. Press________ on a keyboard to select the entire table. [ ]

(a) Ctrl + V

(b) Ctrl + A

(c) Ctrl + X

(d) Ctrl + S

5. ________ displays the number of entries in the column. [ ]

(a) Sum

(b) More

(c) Var

(d) Count
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6. Every item in the header row of a table contains a drop-down arrow known as________ . [ ]

(a) Format button

(b) Filter button

(c) Autofilter button

(d) Sort button

7. ________ are less flexible. [ ]

(a) Filters

(b) Tables

(c) Sheers

(d) None of the above

8. When the user creates a chart using the data in a table, the chart will be________ automatically. [ ]

(a) Shrinked

(b) Minimized

(c) Extended

(d) Both (b) and (c)

9- _____ function displays the Insert function dialog box for selecting a function that isn't in the list. [ ]

(a) None

(b) Max

(c) Min

(d) More

________ tab of the ribbon provides quick access to the most commonly used formatting options. [ ]

(a) Home

(b) Insert

(c) Page Layout

(d) Data
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II. Fill in the Blanks

1. A_________ is a rectangular range of structured data.

2. Activating any cell in the table gives you access to the________ contextual tab on the ribbon.

3. The users custom table style will appear in the . gallery.

4. ________ doesn't override normal formatting.

5. If you want to make changes to an existing table style, locate it in the________ and_______

6. Selecting cells in a table works just like selecting cells in a________ .

7. ________ option displays the number of numeric values in the column.

8. When a table is sorted the rows are rearranged based on the,________ of a particular column.

9. ________ refers to displaying only those rows that meet certain criteria.

10. Slicers occupy more
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I. Multiple Choice Questions

1- (c)

2. (a)

3- (b)

4. (b)

5- (d)

6- (b)

7. (c)

8- (c)

9. (d)

10. (a)

II. Fill in the Blanks

1. Table

2. Table tools

3. Table Styles

4. Table formatting

5. Ribbon and Right click

6. Normal range

7. Count numbers

8. Contents

9. Filtering

10. Space
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III. Very Short Questions and Answers

Q1. Define a table.

Answer :

Arrangement of data in the form of rows and columns is referred to as "table". Each row and column in a table 

contains different type of information. For instance, when a row contains information about a student then columns contain 

student related attributes like student name, roll no, branch, marks and so on.

Q2. What is the function of center across selection option in excel?

Answer :

Center across selection option aligns the text at the center of the selected columns. It is mainly useful for displaying 

a center heading over multiple columns.

Q3. What is filtering?

Answer :

Filtering a table refers to the process of displaying only those records that satisfy specific criteria.

Q4. What is the use of StdDev function?

Answer :

StdDev function is used for calculating standard deviation of the values in a column.

Q5. What is the use of MAX function?

Answer :

Max function field is used for displaying maximum value present in the column.
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4
c LEARNING OBJECTIVES J

After studying this unit, one would have thorough understanding about the following key concepts,

❖ Creating a new excel file/workbook.

❖ Saving workbooks.

❖ Protecting and recovering workbooks.

❖ Checking compatibility.

❖ Creating, modifying, editing and resetting excel templates.

❖ Creating and saving custom templates.

cz INTRODUCTION ZZZ
Excel files are also called as workbooks which can be created opened, closed and saved in many ways. The 

file saving process of excel is very quick and therefore it should be performed frequently in order to avoid 

damage, corruption or loss of unsaved data due to power failures or system crashes. To avoid loss of data, 

Excel-2013 offers auto recover feature to recover lost, unsaved or replaced data. To offer this feature, excel 

saves the active file periodically. It also offers various file protecting options.

Excel-2013 also offers the usage of templates which are used are prototype to support other workbooks. It 

contains predefined formatting styles and standardized text. Excel-2013 offers many default templates and 

also allows users to create their own templates manually.
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Q1. List the different ways of opening a saved workbook.

Answer :

Excel offers several ways to open a saved workbook. Some of these ways are as follows,

1. If the file/workbook is used recently, it can be opened from the list of recently used workbooks. To do this, go to 
File —» Open -» Recent Workbooks. Under the Recent Workbooks list, click the desired file. This can carry at most 
50 files.

2. If the desired workbook is not present in the recently used list, it can be opened by clicking F ile —> Open —> Computer. 
The displayed screen lists some folders and Browse button at the end of the list. If the folder in which the work-book 
is stored is displayed in the list, select that folder, else, click on the Browse button. This displays an “Open” dialog 
box. Locate the workbook and click on open button.

3. Open the workbook directly by double clicking on it from Window Explorer. This option opens the workbook even 
if excel application is not running.

4. If the workbook to be opened is stored on some internet location such as SkyDrive, SharePoint etc., it can be opened 
by selecting File -> Open and other online locations list.

Q2. Discuss any five options of opening a file from open dialog box.

Answer : Model Paper-ll, Q4

In the open dialog box, there exist drop-down list present beside the open button which offers the following options.

1. Open ‘

This option directly opens the file.

2. Open Read-Only

This option opens the file but doesnot allow the users to edit or modify it. Users can only read the opened file.

3. Open as Copy

This option creates a copy of the file and opens it for the user. The changes in this file will not be reflected to the 
original file.

4. Open in Browser

This option opens the selected workbook in a web browser instead of excel.

5. Open in Protected View

This option opens the selected file and hides most of the ribbon commands so that the users cannot edit it.

Q3. What are the different ways of saving a workbook?

Answer :

The different ways in which a workbook can be saved are as follows,

1. Click on File -> Save.

2. Click on the floppy icon present on the quick access toolbar.

3. Use the shortcut key Ctrl + S.

4. Use the shortcut key Shift + F12.
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Q4. Write short notes on recovering versions of workbook.

Answer :

Excel-2013 keeps multiple versions of a saved file. These files can be viewed or accessed any time from File —> Info. 
Under versions section, a list of older versions of the file that are autosaved are displayed. This list may contain multiple 
versions of the some file and not even a single version for some other file. These files can be opened simply by clicking 
its name. Opening these versions doesnot replace the saved copy, however, it can be saved if required.

Excel also allows some data to be copied from the autosaved version instead of saving the entire file.' When the 
autosaved versions are opened and closed, they are deleted automatically. Sometimes, they are also deleted on closing the 
saved file.

Q5. Discuss the process of password-protecting a workbook.

Answer :

The process of protecting a workbook by setting a password is as follows,

1. Go to File -> Info -» Protect workbook button. It displays a list options.

2. In the list of options, select Encrypt with password option which shows Encrypt Document dialog box.

3. In the displayed dialog box, type the password and confirm it.

4. Finally, click on OK button and save the document.

Q6. How to modify a template?

Answer : Model Paper-1, Q4

The process of modifying a template is as follows,

❖ Go to File —> Open to open the template file.

❖ Browse through the computer to find and select the original template file.

❖ Click on open button and modify the template file.

❖ Save and replace the original file or give a different name to it.

Note that template files are stored in xltx, xltm or xlt formats. The location of downloaded templates can be determined 
by selecting File -> Options. In the Excel options dialog box, select trust center and click on trust center settings button. Then 
in the Trust Center Dialog Box, select Trusted Locations. The templates are stored in the location ending with Application 
templates. 

Q7. What is the process of locating XLStart folder?

Answer :

The location of XLStart folder can be determined as follows,

❖ Select File —> Options.

❖ Click Trust Center in the Excel options dialog box.

❖ Click Trust Center Settings.

❖ Click Trusted Locations in the Trust Center dialog box.

❖ In the list of locations, find User Startup. Click on it to display its location.

Q8. Write short notes on custom templates.

Answer : Model Paper-Ill, Q4

Custom templates refer to the templates which are created by users to make their work easier. These custom templates 
are fairly different from default template of excel. Use of these templates reduces the amount of rework. For example, if 
a company generates its monthly expenses report for every month, then it can create a report template with empty fields 
and insert the values whenever report needs to be generated. In this template, users can include default header and footer, 
apply styles to various cells and sheets, insert some data into cells that appears every time when a workbook is created 
-sing the template.
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4.1 EXCEL FILES

4.1.1 Creating a New Workbook, Filtering Filenames 

Q9. Explain how workbooks are created and opened in Excel-2013. Also discuss about filtering filenames.

Answer : Model Paper-I, Q12(a)

Creating a New Workbook

Excel-2013 opens with a start-up screen displaying various options to create or open a workbook. It offers a set of 
templates using which new workbooks can be created with different predefined styles. To open a blank workbook that does 
not contain anything, select “Blank Workbook”. This option can be set as default whenever excel is opened while skipping 
the start-up screen. To do this, select File —> Options. It displays an “Excel Options” dialog box with various tabs. Among 
these tabs, click on General and uncheck the “Show the Start Screen When this Application Starts” option and click on 
OK button.

Now, whenever excel is started, automatically new workbook is created. The newly created workbook is named as 
Bookl by-default and it is stored temporarily in the memory. It carries a single worksheet by-default.

The different ways of creating a workbook in Excel-2013 are as follows,

1. Select File —» New. A screen is displayed that provides different options of creating a workbook. Users can choose 
either a blank workbook or a required template to start working on the new workbook.

Open

Save

- Ca ve As

Pfint

Chate

Export

Close

Office Tab

Account

Option;

New

—:------1-------------- ■---------

• Expense Report

Expense Report

Bookl - Excel

a i : 3
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J
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s
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7

Billing Statement

A 8 C 5

2 Blood Presaire Tracker i
j

♦
Sytt-fx: j

Tyj« ievstW

C <«■* t*VS*»r.

Blood Pressure Tracker

2. The shortcut key Ctrl + N can be used in the opened window of excel to quickly create a blank workbook. This 
option does not allow the selection of templates.
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Opening an Existing Workbook

Excel offers several ways to open a saved workbook. Some of these ways are as follows,

If the file/workbook is used recently, it can be opened from the list of recently used workbooks. To do this, go to 
File -> Open —> Recent Workbooks. Under the Recent Workbooks list, click the desired file. This can carry at most 
50 files.

2 If the desired workbook is not present in the recently used list, it can be opened by clicking File -> Open -> Computer.
The displayed screen lists some folders and Browse button at the end of the list. If the folder in which the work book 
is stored is displayed in the list, select that folder, else, click on the Browse button. This displays an “Open” dialog 
box. Locate the workbook and click on open button.

Open the workbook directly by double clicking on it from Window Explorer. This option opens the workbook even 
if excel application is not running.

If the workbook to be opened is stored on some internet location such as SkyDrive, SharePoint etc., it can be opened 
by selecting File —> Open and other online locations list.

If users want to display certain files always in the recent workbooks list, click on the pushpin icon present on the
-ght side of workbook name. The pinned workbooks are always displayed on top of the list.

In the open dialog box, there exist drop-down list present beside the open button which offers the following options.

I2| Open ■

(► Libraries > Documents > ▼ | II 1I i Search Documents P 1

Organize T New folder - 3 ©

' Document

T Music
Documents library

Arrange by; FolderT
Includes: 2 locations

Pictures ...................
1 Videos Name Date modified Type

i Fax 07/03/2017 11:15 File fo!

A Computer t fahmina 11/15/2017 18:05 File fol

Local Disk (C:) 1 dra2_files 11/29/2017 12:00 File fol.l_

■ New Volume (D:) I dral.files 11/29/2017 11:58 File folk

L D and C Act
^Ss Network * Custom Office Templates

Open

Onen Read-Onlv
A 69-PC 0' time Open as Copy
A ABC-PC Hl Open in Browser

Filename: time ▼ Open in Protected View

Open and Repair...
Tools ▼ Show previous versions
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1. Open

This option directly opens the file.

2. Open Read-Only

This option opens the file but doesnot allow the users to edit or modify it. Users can only read the opened file.

3. Open as Copy

This option creates a copy of the file and opens it for the user. The changes in this file will not be reflected to the 
original file.

4. Open in Browser

This option opens the selected workbook in a web browser instead of excel.

5. Open in Protected View

This option opens the selected file and hides most of the ribbon commands so that the users cannot edit it.

6. Open and Repair

This option is used to open and recover the data contained in a damaged or corrupted file.

7. Show Previous Versions

This option displays the previous versions of the workbook.

Filtering Filenames

When a file is opened using open dialog box, it might be difficult for the users to find the desired file if there exist 
different workbooks with different file types. Excel offers filtering of workbooks while using open dialog box. To do this, 
click on the drop-down list present beside file name drop down list and select the desired file types. The default-option 
selected in this drop-down is “All Excel Files”.

■
01 Open

w

Organize •

► Libraries ► Documents ►

New folder

{Jll Microsoft Excel

Favorites 

■ Desktop 

il Downloads

Revent Places

' Documents

Libraries 

d, Documents 

j Music

Documents library
Includes: 2 locations

Name

, Yusra

Visual Studio 2013

Visual Studio 2010 

ji Visual Studio 2003 

jfc SQL Server Management Studio

Scanned Documents 

1 R

Dicti it

File name:

-All Files

Excel Files
All Web Pages 
XML Files 
Text Files 
All Data Sources 
Access Databases 
Query Files 
dBase Files
Microsoft Excel 4,0 Macros 
'Microsoft Excel 4,0 Workbooks; 
Worksheets
iWorkspaces
Templates
Add-Ins
Toolbars
SYLK Files
Data Interchange Format 
Backup Files
OpenDocument Spreadsheet

All Excel Fries

a

< : i

Tools Open Cancel
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4.1.2 Saving and Auto Recovery

Q10. Discuss various ways of saving workbook.

Answer : Model Paper-Ill, Q12(b)
»

The file saving process of Excel is very quick and therefore, it should be performed frequently to avoid damage, 
corruption or loss of files due to power failures or system crashes. The different ways in which a workbook can be saved 
are as follows,

1. Click on File —» Save.

2. Click on the floppy icon present on the quick access toolbar.

3. Use the shortcut key Ctrl + S.

4. Use the shortcut key Shift + F12.

If the file on which the user is working is saved, it is replaced with the same name and stored on the same location. 
If an already saved workbook is opened, worked on it for hours and closed without saving, then the changes done to the 
file are lost. If the users want to save the file on a different location or with a different name, Save As option is used. To 
use option, go to File —> Save As or press F12.

If the opened workbook is never been saved, saving the file will open save as dialog box. Specify the name and 
location of the file and click on save button. The default names given to workbooks if users do not specify the names 
are Bookl, Book2,.... The default file format selected for saving the files is .xlsx. However, if the file contains VBA 
macros, it needs to be saved with .xlsm format so that macros can be included in it. Otherwise, the macros will be deleted 
automatically.
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Excel displays a message asking the user whether to replace the file or not if the file name is same as already existing 
file having the same name. If the file is replaced, it cannot be recovered.

Q11. Write short notes on AutoRecover feature of Excel-2013.

Answer: Model Paper-ll, Q12(b.

A file or data present in a file can be lost or damaged for several reasons. These reasons can include power failure, 
accidently closed the file without saving, system failure and several other reasons. To recover from such losses, Excel-2013 
offers various options under its AutoRecover feature. With this feature, Excel saves the active work time to time so that 
it can be recovered in case of unusual activities. This process is completely hidden from the user however, the autosaved 
copies can be accessed and retrieved any time from the excel application. The autosaving option works irrespective of 
whether the user saved the file or not.

The two major options available in AutoRecover feature are as follows,

1. Recovering Versions of Workbook

Excel-2013 keeps multiple versions of a saved file. These files can be viewed or accessed any time from File —> Info. 
Under versions section, a list of older versions of the file that are autosaved are displayed. This list may contain multiple 
versions of the some file and not even a single version for some other file. These files can be opened simply by clicking it? 
name. Opening these versions doesnot replace the saved copy, however, it can be saved if required.

Manage
Versions”

Versions
|| 05/26/2018 16:29 (autosave)

© 05/26/2018 16:16 (autosave)

© 05/26/2018 14:59 (autosave)

|| 05/26/2018 12:54 (autosave)

© 05/26/2018 12:43 (autosave)

Excel also allows some data to be copied from the autosaved version instead of saving the entire file. When the 
autosaved versions are opened and closed, they are deleted automatically. Sometimes, they are also deleted on closing the 
saved file.

2. Recovering Unsaved Work

When users try to close a workbook without saving it, Excel displays a message informing that there is some unsave: 
data present in the file. If the autosaved version of the file is available and it is closed without saving, it can be recovered 
from File -> Info -» Manage Versions -> Recover unsaved workbooks. Upon click this, excel displays a list of autosave: 
versions of workbooks that can be opened, checked and saved accordingly. These unsaved workbooks are automatical! • 
stored in XLSB format which means that they are read only and hence, they are not editable. In order to make them editable 
they needs to be saved into a different location with a different name. Typically, these versions are removed when they are 
saved or after four days.
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4.1.3 Password-Protecting a Workbook, Recovering Unsaved Work, Protect Workbook Options
Q12. Discuss various options available in protect workbook drop-down list. Describe the process of password 

protecting a workbook.

Answer :
Options in Protect Workbook

Protect workbook drop-down list present in File -» Info carries different options which are as follows,
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Book4 - Excel

Info

Protect Workbook 
Control what types of changes peof 

this workbook.

.1 Let readers know the workbook is final

and make it read-only.

Encrypt with Password
Require a password to open this 

workbook.

pffl Protect Current Sheet
Control what types of changes people can

make to the current sheet

F~7: Protect Workbook Structure

.. Drai/ant i imtrsntoH I’hannat tvs 1"S Prevent unwanted changes to the structure 

of Vie workbook such as adding sheets.

Restrict Access
-© Grant people access while removing their ► 

ability to edit copy, or print.

A Add a Digital Signature

-8 Ensure the integrity of Vie workbook by 

adding an invisible digital signature.

1. Mark as Final

This option is used to indicate other users that the file is complete. It is saved in a read-only format to avoid unnecessary 
modifications.

2. Encrypt with Password

This option is used to prevent the workbook from unauthorized access. Using this option, a password is set to the 
workbook which is required every time when it is opened.

3. Protect Current Sheet

This option is used protect the worksheet from editing. It also enables users to set password to protect the worksheet.

4. Protect Workbook Structure

This option is used to protect the workbook structure such as addition and deletion of sheets. This option does not 
restrict the users from editing the cells.

5. Restrict Access

This option is used to allow access to the workbook to specific persons. However this service is not available free- 
of-cost and hence requires registration.

6. Add a Digital Signature

This option is used to digitally sign the workbook or file.

Process of Password-protecting a Workbook

The process of protecting a workbook by setting a password is as follows,

1. Go to File -» Info -» Protect workbook button. It displays a list options.

2. In the list of options, select Encrypt with Password option which shows Encrypt Document dialog box.

3. In the displayed dialog box, type the password and confirm it.

4. Finally, click on OK button and save the document.
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After setting the password, whenever the file is opened, excels asks the user to enter the password.

Q13. Write a short note on recovering unsaved work.

Answer :

For answer refer Unit-IV, Page No. 124, Q.No. 11, Topic: Recovering Unsaved Work.

4.1.4 Checking Compatibility

Q14. Write about checking compatibility of excel files workbooks.

Answer : Model Paper-1, Q12(b)

Different versions of excel have different limitations. Even if the files get opened in different versions, it is not 
guaranteed that everything is according to the original document. Therefore, it is necessary to check the compatibility of 
workbooks.

Excel-2013 application comes up with a compatibility checker which is automatically executed when workbook 
is saved to a format older than Excel-2007. It is responsible for identifying the functionalities that get disabled when the 
active workbook is saved to earlier versions. To identify the functionalities that get lost in various versions, firstly, open the 
compatibility checker from File —> Info —> Check for Issues —> Check Compatibility. This opens a compatibility checker 
dialog box which automatically displays features which are not supported by earlier versions of excel. Users can specify 
a specific version in the select version to show drop-down.

Microsoft Excel - Compatibility Checker j f

The following features in this workbook are not supported by earlier versions of 

Excel. These features may be lost or degraded when opening this workbook in an 

earlier version of Excel or if you save this workbook in an earlier file format 

i Select versions to show T |

Summaiy Occurrences

A PivotTable style Is applied to a PivotTable in this workbook. 

PivotTable style formatting cannot be displayed in earlier 

versions of Excel.

Location: 'Sheets, PivotTable

1

Find Help

Excel >7 ?QH3

A

A PivotTable in this workbook will not work in versions prior 

to Excel 2007. Only PivotTables that are created in

Compatibility Mode will work in earlier versions of Excel.

1

Find Help

Location: 'Sheets, PivotTable Excel 97-2003

Some cells or styles in this workbook contain formatting that 

is not supported by the selected file format. These formats 

will be converted to the closest format available.

8

Help

Excel 97-2003

A PivotTable in this workbook contains settings which do not 1
exist in earlier versions of Excel. Some PivotTable settings will 

not be saved.
Find Help

Location: 'Sheets, PivotTable •Excel 97-2003

Excel 2007

Check compatibility when saving this workbook.

Copy to New Sheet i J

The above dialog box displays all the functionalities that will get lost in the previous versions. These results can 
be displayed in a more appropriate form by using copy to new sheet option. These problems can not only reside in older 
versions, but also in 2007 and 2010 versions irrespective of the fact that they use the same file format.
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4.2 TEMPLATES

4.2.1 Creating a Excel Templates, Modifying a Template

Q15, Define a template. Discuss how a workbook can be created from a template. Also discuss the process 
of modifying a template.

Answer : Model Paper-ll, Q12(a)

Template

A template is a workbook model which is used as a prototype to support other workbooks. It contains predefined 
formatting, styles and standardized text like headers, row and column labels, formulas, macros etc. Excel-2013 offers many 
default templates and also allows users to create their own templates manually.

Creating Workbooks from a Template

A workbook can be created using the templates offered by Excel-2013. To select a template, go to File -> New, 
browse through the available template thumbnails and click on the required one. Users can also search for the templates 
online using the search box present on the top of the screen. The online templates are downloaded in to the computer and 
thumbnails of downloaded templates are added in the new workbook screen.

Open

Save

New

Bookl - Excel

Save A;

Pfint

Share

Export

Close

Office Tab

Account

Option;

i » 4

: • Expense Report

Expense Report

..... .%..... i.. ........c.. ....... $ .
Your Company NameSc-mAac-M.JUM.2

4
* S&sfwerfi

Billing Statement

a; a i c j b

2 Stood Pressure Tracker
J..?..
| 4
i

....«•...... I
I Sywte

Blood Pressure Tracker

p

When a template is selected or opened, a new workbook is created which is based on the selected template. Customize 
the template as desired and replace in values. Once the modifications are done, the users can save the workbook with 
desired name. Saving this file will not replace the original template file. Using such an approach for creating workbooks 
saves much of the time and efforts of the users.
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Cash Advances
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Expense Report

Modifying a Template

A downloaded or default template of excel can be modified accordingly so that it can be opened as per the user 
requirements. For example, if the user wants to add a logo to the template and add some additional fields in the template 
so that it can appear in the workbook every time when the template is opened, then modify template feature can be used.

The process of modifying a template is as follows,

<• Go to File -> Open to open the template file.

•> Browse through the computer to find and select the original template file.

❖ Click on open button and modify the template file.

<• Save and replace the original file or give a different name to it.

Note that template files are stored in xltx, xltm or xlt formats. The location of downloaded templates can be determined 
-y selecting File -> Options. In the Excel options dialog box, select trust center and click on trust center settings button. Then 
e the Trust Center dialog box, select Trusted Locations. The templates are stored in the location ending with Application 
emplates.
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a company generates its monthly expenses report for every month, then it can create a report template with empty fields 
and insert the values whenever report needs to be generated. In this template, users can include default header and footer, 
apply styles to various cells and sheets, insert some data into cells that appears every time when a workbook is created 
using the template. By default, excel assigns the name of template followed by a number to the created workbook. When 
the workbook is saved for the first time, Save As dialog box appears.

A custom template can be created in the way similar to creating a normal workbook. This means that go to File —» 
New -> Blank Document. Add necessary formulas, styles, header and footer, charts, macros and as other options that need 
to be displayed every time when a new workbook is created using that template.

Saving Custom Templates

Custom templates are saved in a way similar to saving a normal file i.e., File -> Save if it is getting saved for, 
first time or File -> Save As if it is already saved. The difference in saving a normal workbook and a template file is 1 
selection of template(*.xltx) option from the Save As Type drop down list before saving the template. In case if the tempb 
carries VBA macros, then Excel Macro-Enabled Template (*.xltm) needs to selected. After selecting the desired optic 
click on Save button. The template is saved in the default templates folder.
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XML Spreadsheet 2003 
Microsoft Excel 5.0/95 Workbook 
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Organize 

Desktop

Text (Macintosh)
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Jsing Custom Templates

A new workbook can be created using custom templates in the way similar to creating workbooks using other 
■Emplates.

For remaining answer refer Unit-IV, Page No. 128, Q.No. 15, Topic: Creating Workbooks from a Template.

2'9. List some of the settings that can be adjusted and used in custom templates.

knswer :

The following are some of the settings that can be adjusted to assist users while using custom templates.

• Row Height and Column Width

Users can set the row height and column width of various cells according to the data to be inserted into the template.

2 Header and Footer

Default header and footer can be specified so that it will inserted automatically whenever the template is used. It 
can be added by selecting page layout from View -> Workbook views.

saved for 
ate file is 
the temp
sired opti Users can apply different styles to different cells using cell styles option present in Home -> Styles. Styles can 

include font, font size, alignment of font, background color, font color etc.
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4. Print Settings

Users can specify print settings for the template. These settings include margins, paper size, orientation and other 
options.

5. Custom Number Formats

Users can specify special number formats within the template.

6. Multiple Formatted Sheets

Users can apply different styles to different sheets within a single template. For example, sheetl can print data ir 
portrait mode whereas, sheet2 print data in landscape mode.

7. Sheet Settings

Users can specify other sheet options from View -> Show group.

SIA PUBLISHERS AND DISTRIBUTORS PVT. LTD.



-MT-4 : Excel Files and Templates 135

INTERNAL ASSESSMENT
:............ • -

Multiple Choice Questions

1. Excel options dialog box can be accessed from which tab? [ ]

(a) File f

(b) Home

(c) Review

(d) View

2. When Excel-2013 is opened, the_____ screen is displayed by default. [ ]

(a) New template

(b) New worksheet

(c) New workbook

(d) None of the above

3. The shortcut key for opening an existing workbook is_____ . [ ]

(a) Ctrl + N

(b) Ctrl + O

(c) Ctrl + E

(d) Ctrl + S

4. Which of the following options is not available in drop-down list of open dialog box?

(a) Open as read-only

(b) Open as copy

(c) Open in browser

(d) Open in explorer

5. Excel-2013 saves its workbooks in_____ format.

(a) xls

(b) xltx

(c) xlsx

(d) xlmx

6. The unsaved workbooks are automatically saved by excel in_____ format.

(a) xltx

(b) xlsb

(c) xlsx

(d) None of the above

[ ]
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’ 7. The older versions of excel workbook can be viewed from_____ .

(a) File —»Info

(b) Home —> Info

(c) View -> Info

(d) Data -» Info

8. Thumbnails of template are displayed in_____ .

(a) File -> New

(b) File -> Share

(c) File -> Info

(d) None of the above

9. The location of downloaded templates can be determined from_____ .

(a) File explorer

(b) Info

(c) About

(d) Trusted locations

10. Which among the following is a type of template supported by Excel-2013?

(a) Default workbook template

(b) Default worksheet template

(c) Custom workbook template

(d) All the above

II. Fill in the Blanks

1. To open multiple workbooks at once from open dialog press and hold_____

2. Excel 97-2003 supports________ file format.

3. Every file is autosaved after________ minutes by-default.

4. ________ option is used to indicate that the file is completed.

5. Check compatibility option is available in________ tab.

6. The extension of a backup file is;________ .

7. The search templates online search box is present in________ .

8. The extension of default template is________ .

9. A macro-enabled template is saved in ______ format.

10. When the workbook is closed, the autosaved versions are________ .
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I. Multiple Choice Questions

1. (a)

2. (c)

3. (b)

4. (d)

5. (c)

6. (b)

7. (a)

8- (c)

9. (d)

10. (d)

II. Fill in the Blanks

1. Ctrl

2. xls

3. 10

4. Mark as final

5. File

6. .xlsk

7. File —>New

8. .xltx

9. xltm

10. Deleted
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III. Very Short Questions and Answers

Q1. What is the shortcut key of creating blank workbook?

Answer :

The shortcut key Ctrl + N can be used in the opened window to quickly create a blank workbook.

Q2. What is the task of compatibility checker?

Answer ;

Compatibility checker is responsible for identifying the functionalities that get disabled when the active worksheet 
is saved to earlier versions.'•

Q3. Define template.

Answer :

A template is a workbook model which is used as a prototype to support other workbooks. It contains predefined 
formatting, styles and standardized text like headers, row and column labels, formulas, macros etc.

Q4. When to use worksheet template?

Answer :

Worksheet templates are used when a new worksheet is to be inserted with user defined styles and settings.

Q5. How to edit the default template?

Answer :

The default template defined by user can be edited any time. To do this, simply locate the template file, open it, maut 

necessary changes and save it at the same location.

SIA PUBLISHERS AND DISTRIBUTORS PVT. LTD.



MION

UNIT

5 PRINTING YOUR WORK

V________________ /
SIA GROUP

isheet

c LEARNING OBJECTIVES —

;fined

make

After studying this unit, a student will have thorough understanding about the following key concepts.

❖ Different views of worksheet.

❖ The process of changing page orientation.

❖ Different ways of adjusting page margins.

❖ The process of inserting and removing page breaks.

❖ The process of adding Header and Footer.

❖ The process of creating custom views and PDF files.

Microsoft excel allows user to print reports in a more attractive and formatted manner with less effort. It 

offers different page setting features like setting margins, selecting the print area, changing the orientation, 

printing guidelines, printing row and column headings, scaling to fit page and printing titles. Excel also 

offers three worksheet views namely Normal, page layout and page break preview. It prevents certain cells 

of worksheet from being printed by using techniques such as hiding rows and columns, hiding cells and 

masking an area. The custom views feature enables user to create different view settings for workbook.

Excel can add Header and Footer to a printed page for displaying information like titles, chaptername, 

page number, dates etc. It also allows user to create PDF files for excel worksheet.
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PART-A
SHORT QUESTIONS WITH SOLUTIONS

Q1. What are the different views of excel worksheet?

Answer : Model Paper-ll, OS

The different views of excel worksheet includes the following,

1. Normal View

2. Page Layout View

3. Page Break Preview.

The three view options provided by excel allow users to view the worksheet in different ways. Users can choose th e 
most suitable view by clicking on one of the view icons appearing at the right side of the status bar. Another way of choosin; 
the view is to click on the view tab on the ribbon and then selecting the required view from workbook views group.

Q2. What are the default print settings of excel?

Answer :

The list of default print settings of excel includes the following,

1. Excel prints the entire active area of worksheet along with embedded charts (if any) and graphic objects like smar 
arts or shapes.

2. It prints single copy of worksheet.

3. It prints in portrait mode rather than landscape mode.

4. It considers letter (8.5" x 11") as default paper size with left and light margins of 0.7 inches and top and bottom 
margins of 0.75 inches.

5. It prints without headers and footers.

6. It prints without cell guidelines and cell comments.

Q3. What are the steps followed for adjusting the printer settings?

Answer :

The steps followed for adjusting the printer settings are given below,

1. Click on File tab.

2. Click on ‘print’ option in drop down menu. A ‘print’ dialog box gets displayed on screen.

3. Click ‘printer properties’. A properties dialog box related to current active printer appears on screen.

4. In the properties dialog box, adjust the settings of printer like page setup, Finishing, paper quality and paper so_-3i

Q4. How to determine the active area of worksheet?

Answer :

In Microsoft Excel, the area from cell A1 to the last active cell is referred to as active area of worksheet. The c a 
mand ‘Ctrl + End’ determines the active area of worksheet by taking the cursor to the last active cell. The use of ‘Ce 

End’ command is not always accurate. For instance, if user deleted certain rows from the middle of the workshee: as 
pressing ‘Ctrl + End’ moves cell pointer to the cells where user deleted the rows rather than the last active cell. The acn 
area is reset once the page is sent for printing.
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35. Explain how to add an image on Background in excel.

Answer :

The steps followed to add an image as background in excel are given below,

Click on page layout tab appearing on ribbon.

2 Choose ‘Background’ from page setup group. A window appears on screen.

Click on ‘From a file’ button and choose an image from computer and then click on ‘insert’ button.

4 The selected image is placed on worksheet as background.

Background images only appear in excel worksheet. They donot appear in printed output.

36. Discuss briefly about page breaks in excel.

Answer :

In MS-excel, page breaks are adjusted automatically when user performs operations like adding or deleting rows/ 
amns, switching from one orientation to another orientation and so on. However, page breaks can be adjusted manually 

• ised on user requirements. Basically, page breaks are two types, namely Horizontal page breaks and Vertical page 

: reaks. Horizontal page breaks are responsible for dividing rows while vertical page breaks are responsible for dividing
. :.umns.

37. Discuss the steps involved in printing row and column headers in excel.

Answer : Model Paper-I, Q5

Excel does not print the row and column headers by default. However, users can print row and column headers by 
xtlowing these steps,

Click on page layout tab on the ribbon.

Click on dialogbox launcher appearing at bottom-right comer of sheet options group. A page setup dialog box ap
pears on screen.

Goto print section and check the check box that appears before headings option.

Click on ‘Ok’ button to close the page setup dialog box. Now, row and column headers appear on the printed page.

38. Explain how to print cell gridlines in excel.

Answer :

Excel does not print cell gridlines by default. However, users can print cell gridlines by following the steps given
■jelow,

Click on page layout tab on the ribbon.

Click on dialog box launcher appearing at bottom-right comer of ‘sheet options’ group. A page setup dialog box 
appears on screen in that, select the sheet tab.

Goto ‘print’ section of page setup dialog box and check the checkbox that appears before ‘gridlines’ option.

Click “Ok” button to close the page setup dialog box. Now, cell guidelines are displayed on printed page.
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Q9. How to scale the printed output?

Answer : Model Paper-Ill, Q5

The steps involved in scaling the printed output are given below,

1. Click the ‘Page Layout’ tab.

2. Click on the width box from ‘scale to fit’ group for scaling the width of the output such that printout fits in specific 
number of pages. Specify the number of pages from width drop down list to fit the output.

3. Click on the ‘height’ box from ‘Scale to Fit’ group for scaling the height of the output such that printout fits in 
specific number of pages. Specify the number of pages from height drop down list to fit the output.

4. Choose ‘Scale’ option from ‘scale to fit’ group for scaling the output from minimum of 10 percent to a maximum 
of 400 percent. User can enter directly or set the scaling percentage using scale spinner arrows.

Q10. Explain the steps followed for hiding rows or columns.

Answer : "

The steps for hiding rows or columns are given below,

1. Select the rows or columns that users want to hide and then click on ‘Home’ tab.

2. Click ‘Format’ command from cells group. A drop down list is displayed.

3. Under Hide & Unhide Option, Choose “Hide Rows” for hiding rows and “Hide Columns” for hiding columns.

4. The selected rows or columns gets hidden to the user.
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5,1 NORMAL, PAGE LAYOUT, PAGE BREAK VIEW
□11. Explain in detail the normal view of excel worksheet. 

Vnswer :

Normal view is considered as the default view of worksheet in excel. It is the preferred choice of most of the users 
it offers simplicity in performing operations like editing, formatting and typing.

The following figure shows normal view of a worksheet.
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The normal view can be activated by clicking ‘view’ table and selecting the normal icon appearing in “workbook 

rews group”.

IB B h’ d - ; Normal View Q1 - Excel
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Another way of activating normal ‘VIEW’ is by clicking the “normal view” icon appearing at the bottom right of 
'.e screen on status bar beside zoom slider.

Normal view

In normal view, the horizontal and vertical dashed lines represent page breaks. These page breaks indicates splitting 
r work sheet into individual pages, which helps in identifying how much data is getting printed on a single page. Based 
n these lines users can adjust row height and column width inorder to print the required area of output on single page.

Page breaks are not displayed by default on worksheets. Users need to switch from one of three views to display the 
' rmal view. However, to hide the displayed page breaks temporarily by simply opening.and closing the excel file. Inorder 

? hide the page breaks permanently for the active sheet, user needs the following procedure needs to be followed.
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1. Click on the file tab present on the upper left comer of screen. A drop down menu gets displayed on screen.

2. Click on the option “options” in drop down list. An ‘excel options’ dialog box appears on screen.

3. Click on the advanced tab and scroll down to the “Display options for this worksheet” section.

4. To hide page breaks for the current worksheet uncheck the checkmark that appears before “show page breaks”.
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Q12. Discuss briefly the page layout view of excel worksheet.

Answer : Model Paper-I, Q13(b)(i)

Page layout view displays the worksheet in a page-wise format. This view is similar to print layout view of Ms-word 
which provides complete view of the page allowing users to include headers and footers directly.

The following figure shows the page layout view of worksheet.
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The Page Layout view can be activated by clicking on the view tab and then selecting the ‘Page Layout’ view from 
workbook views group.
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Another way of choosing page layout view is to click on the page layout view icon appearing at the bottom right of 
the screen beside zoom slider on status bar.

Page Layout view icon

The features that enable users to prefer page layout view over normal view are as follows,

(i) User can see how the pages are laid out.

(ii) User can see and add headers and footers directly.

(iii) User can see the ruler and margins.

(iv) User can see the position of pages in the status bar at the bottom of each page.

In this view, all commands of excel can be accessed without restriction, which are disabled when preview in back- 
stage view is used.

The page layout view provides exact preview of the printed output as it displays the repeated rows and columns as 
well as page headers and footers. User also has an option of hiding the white space that appears at the margins. This can 
be done by moving the mouse to the end of the page and clicking on the border (page break). The process of hiding the 
unused margins allows user to view the maximum amount of information on a single screen.
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Q13. Explain briefly the page break preview of excel worksheet.

Answer :
The page break preview of excel worksheet display only the working (active) area of the worksheet where page 

breaks are represented using blue colored dashed lines. The inactive area of the worksheet is displayed in gray colour. The 
following figure shows the page break preview of worksheet.
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Page break preview can be accessed by clicking on view tab and then selecting page break preview from workbook 
views group.

Page Break Preview-Excel

BIBB HOME INSERT PAGE LAYOUT FORMULAS DATA REVIEW VIEW OFFICE TAB

iO
Rutar iyj Formula Bar
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Another way of accessing page break preview is to click on page break preview icon appearing at the bottom right 
of the screen beside zoom slider on status bar.

Page break preview

The features that enable users to prefer page break preview over page layout view and normal view are as follows,

(i) All page breaks appearing on worksheet are represented using solid blue lines and dashed blue lines that can be 
dragged accordingly. The solid blue lines represent manual page breaks and dashed blue lines represent automatic 
page breaks.

(ii) All pages of worksheet are overlaid with page numbers.

(iii) The zoom factor can be adjusted accordingly. By this, user can view the maximum amount of information on work
sheet.

(iv) the printable area is displayed in white background and non printable area is displayed in gray background.

In page break preview, when user drags page breaks then scaling percentage in page setup is adjusted automatically 
inorder to fit information.

Like page layout view, all commands of excel can be accessed completely without restriction in page break preview
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5.2 CHOOSING YOUR PRINTER, SPECIFYING 
WHAT YOU WANT TO PRINT

Q14. Explain the steps followed in choosing the 
printer. Also explain the steps for specifying 
what to print.

Answer :
Steps for Choosing the Printer

The steps followed to choose a printer or output device 
are given below,

1. Click on the file tap and from the drop-down menu, 
click on the print option.

Print
Copies: 1

Printer
n Canon LBP6300

H Ready

Printer Properties

Settings
Print Active Sheets

Only print the active sheets

A A
V to V

Office Tab

Account

Options

E

Pages;

1 Print on Both Sides

Flip pages on long edge
▼

a Collated

1,2.3 1,23 1,2.3
▼

1
Portrait Orientation ▼

□ A4

877”xll£9”
▼

bzh

Normal Margins

Left 0.7" Right 07’ .
▼

jQ No Scaling 

J ho Print sheets at their actuals

Page Setup

Goto “Printer” section and select the required printer 
from installed printers by clicking on the drop down 
menu.

Steps for Specifying the Required Area to Print

Users need to specify the area to be to be printed under 
the following circumstances.

(i) Printing the selected pages instead of entire work
sheet.

(ii) Printing the selected area instead of entire page.
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The steps to be followed for specifying what to print are as follows,
1. Click on file tab and select print option from the drop down list that appears on screen.
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The options available for printing ranges are as follows,

(a) Print Active Sheets

This option can be used to print current active sheet or required number of sheets. To print more than one sheet. _ ;
can hold the Ctrl key and click on the tabs of multiple worksheets. By this, each worksheet is individual?- —- ec 
on different page rather than on same page.

(b) Print Entire Workbook

This option can be used to print the complete workbook containing chart sheets (if any).

(c) Print Selection

This option cab be used to print the selected area of worksheet.

(d) Print Selected Chart

This option can be used to print the selected chart. This option is activated in the settings section only after selection of chart.

(e) Print Selected Table

This option can be used to print the selected table. It is activated in settings section only if cell pointer exists in the table.

In ‘pages’ option of settings section, user can specify the first and last number of page to print range of pages or 
multiple pages.

5.3 CHANGING PAGE ORIENTATION, SPECIFYING PAPER SIZE
Q15. Describe the process of changing page orientation.

Answer : Model Paper-Ill, Q13(b)(i)

Page orientation deals with the positioning of data for displaying or printing. Excel supports two types of page 
orientations namely portrait and landscape portrait is the default page orientation. Which is preferred when data range 
to be printed is taller (vertical). Landscape orientation is preferred when data range to be printed is wide (horizontal). The 
choice of portrait or landscape is decided based on the number of rows or columns in the worksheet. If worksheet contains 
more rows then portrait is preferred whereas, if worksheet contains more columns, then landscape is preferred.

The following figure illustrates portrait and landscape orientation.
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Figure: Portrait Orientation
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Figure: Landscape Orientation

The steps followed for changing the page orientation are given below,

Choose the page layout tab.

Click on orientation dropdown appearing in page setup group. A drop down menu gets displayed.
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Choose portrait or landscape from the drop down list.

The orientation is changed to the selected page orientation
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User can also change the page orientation by choosing print option from File menu.
V

When user switches from one orientation to another orientation, page breaks are adjusted automatically.
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Q16i What are the steps followed for specifying

paper size and printing multiple copies of a 
report?

Answer :

Specifying Paper Size

The steps followed for specifying paper size are given
below,

1. Click the ‘Page Layout’ tab.

2. Click on ‘Size’ from page setup group. A drop down 
list appears on screen.

3. Choose the required paper size option from drop down
list.

Another way of setting paper size is through print 
dialog box. To do so, select ‘print’ option from File 
menu. A preview window in Backstage view ap
pears on screen. Goto “settings” section and select 
the required paper size option.

PAGE LAYOUT FORMULAS DATA REW

Size Print Breaks Background 
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I n ^5
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B5
7.17" x 10,12”

A4
8.27" x 11.69”

B4
10.12” x 14,33"

A3
11.69" x 16.54” Printing Multiple Copies of a Report

Envelope Monarch
3.87" x 7.5"

Mere Paper Sizes.,,

The steps to print multiple copies of a report are given
below,

1. Click ‘File’ tab and choose ‘print’ option from file 
menu. A preview window in Backstage view appears 
on screen.
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In preview window, go to ‘copies’ section appearing at the top of print tab and set or enter the number of copies 
directly.
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3. Click on ‘Print’ button. Excel prints the specified number of copies of the report.

574 ADJUSTING PAGE MARGINS

!J Ltf U3

Q17. Explain in detail the process of adjusting page margins.

Answer : Model Paper-I, Q13(a)

The blank spaces or area which is left empty at four sides (top, bottom, left and right) of a printed page are referred 
to as Margins. Excel offers default margin settings of 0.7 inch for left and right margins and 0.75 inch for top and bottom 
margins.

Top Margin

Figure: Printed Page
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Users can adjust the size of margins using four “quick margin” settings where the size of margins is same for all 
printed pages of worksheet. The margin size and the area available for printing the output are inversely proportional to 
each other. That is, If margin size is increased, then the size of printed area gets decreased.

User can adjust the page margins using any of the following three techniques.

(i) Adjusting Page Margins Using Margins Commands

The steps followed to adjust page margins using ‘Margins’ command are given below,

1. Click on the page Layout tab.

2. Choose “Margins” Command from page setup group. A drop-down menu gets displayed.

3. Choose one of the predefined margin settings (Normal, Wide or Narrow).

4. Click on ‘Custom Margins’ to set user defined margins.

5. A page setup dialog box appears on screen.

Q13(a)

"erred
attorn
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Under ‘Margins’ tab of page setup dialog box, set the margins as desired either by entering the new values directly 
in the four boxes or by clicking on the appropriate spinner (arrow buttons).

Click “OK” button to close the page setup dialog box.

The updated margins in page setup dialog box gets displayed in Last custom setting under Margins tab.
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(ii) Adjusting Page Margins Using Rulers

User can also adjust page margins using rulers in page Layout view. Ruler appearing at the top of column header is 
referred to as Horizontal Ruler, which can be used for adjusting left and right margins and the ruler appearing at left of 
row header is referred to as vertical rulers, which can be used for adjusting top and bottom margins.

» —r ;r " *............. j... _

A .....8. . . . .. . . . c. . . . . . . . . D. . . . . . . . . E. . . . . . . . . . F. . . . S............. H . 1

Click to add header

12

13

M

15

To adjust the margins using ruler, point to the line on the ruler near the borders of page until the pointer turns to a 
double sided arrow. Now, click and drag accordingly to adjust the margins. The changes will be reflected instantly on the 
worksheet without delay.
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(iii)

1.

2.

Adjusting Page Margins Using Backstage View
Users can also adjust page margins using preview window in backstage view by following the steps given below, 

Choose “Print” option from File menu. A preview window in Backstage view is displayed on the screen.

Click on ‘Show Margins’ button appearing at bottom-right color of the preview window.

3. A preview window along with margins is displayed. User’s can drag the margin indicators accordingly to adjust the 
page margins.

types of sparkline new - Excel ? - » X 

Sign in

Print

Printer
Canon LBP6300 (redirected 1) •
neaay: j oocumenti

printer Properties

Settings
P Print Actrve Sheets

Only pintthe acfcve sheets -

Pages: C to C
Pnnt One Sided
Only pent on one side of th...

t!R Collated
U,3 1.2,3 1.2.3

I
Portrait Onentabon -

A4
i U 8.?rxlLM'

0 Normal Margins
left 0.7* Right- 0 ?' -

No Scaling
Pnnt sheets at then actual see

Apart from page margins, users can also adjust Header or Footer margins by following the steps given below,

Click on Header section in page setup dialog box and enter new margin size in the edit box. Header margin refers to 
distance from top edge of the paper to the header. Similarly, click on Footer section and enter new margin size in the edit 
box. Footer margin refers to the distance from bottom edge of the paper to Footer. The size of margins entered in Header 
or Footer must be smaller than size of page margins to avoid the overlapping of header or Footer with printed output area.

In “center on page” section of margins tab in page setup dialog box, checkmark the check boxes that appear before 
‘Horizontally’ or ‘vertically’ inorder to display the printed output at center of the page.

SIA PUBLISHERS AND DISTRIBUTORS PVT. LTD.



156 EXCEL FOUNDATION

5.5 INSERTING A PAGE BREAK, REMOVING MANUAL PAGE BREAKS 
Q18. Explain the process of inserting a page break.

Answer: Model Paper-ll, Q13(b)(i)

In MS-excel, page breaks are adjusted automatically when user performs operations like adding or deleting rows/ col
umns, switching from one orientation to another orientation and so on. However, page breaks can be adjusted manually based 
on user requirements. Basically, page breaks are of two types, namely Horizontal page breaks and Vertical page breaks. 
Horizontal page breaks are responsible for dividing rows while vertical page breaks are responsible for dividing columns.

The steps followed for inserting horizontal page breaks are given below,

1. Click on ‘Page Break Preview’ icon appearing at the right side of status bar.
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2.

3.

Move the cell pointer to the row where the page break needs to be inserted. For instance, page breaks in the middle 
of rows 35 and 36 can be inserted by placing the cell pointer in row 36.

Choose ‘Page Layout’ tab and select “Breaks” command from page setup group. A drop down menu gets displayed.
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4. Click on “Insert page break” Option.

5. The page break is inserted above the selected cell which is indicated using solid blue line.
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Dwaraka ECE BTECH - i F 1 Musheerabad 9.365E.09

Diuya ECE BTECH C J 26" F “ Abids 6.94E.09
Srauanthi CSE DIPLOMA 24 F Secunderabad 9.479E.09

* •-, .XX-X ?
, ■ :: X ■' X ? ' • ■ .. ■ .. • ■ ■

■ . .-s™..*.. V
•

' xxSxx

Mariya IT BTECH 28 F Hyderabad 9.543E.09
Pallaui EEE BTECH 32 F kauadi Guda 9.633E.09

-lima Bindt CSE MCA 27 F Meerpet 9.546E+09
Preethi IT MCA 26 F Mettuguda 9.584E+09
Lauanya CSE BCA 28 F Uppal 9.785E.09
Dwaraka ECE BTECH 26 F Musheerabad 9.365E.09

Diuya ECE BTECH 25 F Abids 6.94E.09
Srauanthi CSE DIPLOMA 24 F Secunderabad 9.479E*09
Mariya IT BTECH 28 F Hyderabad 9543E.09
Pallaui EEE BTECH 32 F kauadi Guda 9.633E.09

-lima Bindt CSE MCA 27 F Meerpet 9546E.09 ;<x fe
Preethi IT MCA 26 F Mettuguda 9.584E.09
Lauanya CSE BCA 29 F Uppal 9.785E.09
Dwaraka ECE BTECH 26 F Musheerabad 9.365E.09

Divya ECE BTECH . .25 F Abids 6.94E.09
Srauanthi CSE DIPLOMA 24 F Secunderabad 9.479E.09

.x-'-'x-xxxf

- : X X XX

Mariya IT BTECH 28 F Hyderabad 9.543E.09
Pallaui EEE BTECH 32 F kauadi Guda 9.633E.09

-lima Bindt CSE MCA 27 F Meerpet 3.546E.09
Preethi IT MCA 26 F Mettuguda 9.584E-09
Lauanya CSE BCA 29 F Uppal 9.785E-09
Dwaraka ECE BTECH 26 F Musheerabad 9.365E-09

Diuya ECE BTECH 25 F Abids 6.94E-09
Srauanthi CSE DIPLOMA 24 F Secunderabad 9.479E.09

The representation of manual and automatic page breaks in normal view is different from page break preview. In 
rormer case, solid gray lines and dashed gray lines are used for representing manual and automatic page breaks, respec
tively. Whereas in latter case, solid blue lines and dashed blue lines are used for representing manual and automatic page 
breaks respectively.

The process of inserting vertical page breaks is same as the process followed for inserting horizontal page breaks.

The only difference is that select the column instead of rows.
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Q19. Explain the process of removing manual page breaks.

Answer :
The steps followed for removing the manual page breaks are given below,

Move the cell pointer to the row that is immediately below the page break inserted by the user.
. - - ® B ♦>’ <*> » • BocK-6®

1.

HOME INSERT i PAST LAi CUT FORMULAS DATA REVIEW OFFICE TAB

[3 ii Colon- Si HE Width: Automatic ’ •

[S] Fonts’ i feii 4....i Li ii® I I i® i-W | 0 Height; Automatic ’
Theme _ Margins Orientation Size Print Breaks Background Print

£ Scale: 1100% .*. g Effects- Area’ V Titles
Page Setup 

fx Preethi

j Print L

ft. Sheet Optic

SEARCH’
,......,, _

S Book2 S' 

8

Book; Q 5cok4
C

Name Department Qualification Age Gendei Address Phone No
Divya ECE BTECH 25 F Abies 6939812257

Sravanthi CSE DIPLOMA 24 F Secunderabad 9478925832

Mariya rr BTECH 28 F Hyderabad : 9542587536-

PaOavi EEE BTECH 32 F kavaci Gaeai 9632587412
bima Binds CSE MCA 27 F Meerpet . 9546324517

Preethi IT MCA 26 F Me&igoda ’ 9584256456

Lavarsya CSE BCA 29 F Uppal : 9784587623

Dwaraka ECE BTECH 26 F Musheerabad: 9365281475

Dsyya ECE BTECH 25 F Abids 6339812257

iSravanthi CSE DIPLOMA 24 ' F Secunderabad 9478925832

Mariya rr BTECH 28 F Hyderabad : 9542587536

i Pailavi EEE BTECH' 32 p ksvadi Guda • 9632587412
hima Bind . CSE MCA 27 F Meerpe; 9546324517
[ Preethi ' IT MCA 26 F Mettuguda 1 9584256456

= Lavanya CSE BCA 29 F Uppal 9784587623
i Dwaraka ECE BTECH 26 F Musheerabsd- 9365281475

2. Click on ‘Page Layout’ tab.

3. Choose “Breaks” command from page setup group to display a drop down list.

INSERT i RAGE LAYOUT
1.........F

t....3

Margins Orientation

ID B
Size Print ( 

» Area’
Page Setup;

Preethi

pn fcj Width: Automatic ’ i

Print

Titles

tO Height Automatic ’i

1 Scale |ioo% ; |

Insert Page Break 

Remove Page Break 

Reset Ail Rase Breaks

n

4. Select “Remove page Break” option from drop-down list. The manual page break is removed or deleted from the 
worksheet.

In a worksheet, page breaks inserted by user can be removed or deleted at once by selecting “Reset Page Break” 
option in step 4 rather than ‘Remove Page Break’ option.

5.6 PRINTING ROW AND COLUMN TITLES

Q20. Explain how to specify the row and column titles on printed page in excel.

Answer?:

Row and column titles are also referred to as print titles. The job of these titles on printed page is similar to the job 
of frozen panes in a worksheet. But, frozen panes are independent of displaying row and column titles on printed page. 
They simply display the titles while navigating in a worksheet.

Row and column titles are used for displaying specific rows and columns at top and left sides, respectively on each 
and every printed page.
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The steps followed for printing row and column titles are given below,
1. Select the worksheet on which row and column titles are to be added.
2. Click ‘Page Layout’ tab.

3. Click ‘Print’ titles button from page setup group.
# B *»• !»B n°ME
ii/ij £?Colors- 

EOfcnts*
Themes

. gj Effects’ 

theme;

BMS£?T Page LAYOUT FORMULAS DATA REVIEW VIEW

Normal Vie# Q1 - Excel 

DEVELOPER . OFFICE TAB

3 X 

Sign in

F-S «i'<'ZKlth- ; Automatic* Gridlines Headings
. , „ ' ™ xjj Height iutcmatx • y View < View

Maigms vnertahon Sue Pnnt B*ah Background Pnnt Bong Send Selection Align
• ta- • fit. SI** W» '■ K* P""t Fowd-lKtad- Pane -

fSCC '.«='p-
•' .it

Name Department Qualification Age
W

--------- No

Divya ECE BTECH 25 F ; Abids 6939812257
i Sravanthi CSE DIPLOMA 24 F Secunderabad 9478925S32
j Mariya IT BTECH 28 F Hyderabad 9542587536
j Paiiavi EEE BTECH 32' F kavadi Guda 9632587422
(Hirna Binds CSE MCA 27 F Meeraet 9546324527
; Preethi iT MCA 26 F Mettuguda 9584256456
i Lavanya CSE BCA 29 F Uooai 9784587623

Dwarao. ECE BTECH 26 F Mushserabad 9365281475

«;anse

..............

i Pttet Titles

I Chocs? raws and cslumisjycu’d |" 
ii (to repeat ga each printed page 
such «those cHth Ufcfl} c< *«sen. ..

E Hl’ 1 < L M hi 0 1’ 3

c w , vi

D i t M!i&0A

aiar
LJ

t. A page setup dialog box appears on screen. By default, the sheet tab is selected in the dialog box.

5 Goto ‘Print’ section and click on either ‘rows to repeat at top’ box or ‘columns to repeat at left’ box. Enter the refer
ence of rows or columns manually. Excel automatically selects the corresponding row or columns specified in the 
worksheet.
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5.7 SCALING PRINTED OUTPUT
Q21. List the steps involved in scaling the printed output in excel.

Answer : Model Paper-I, Q13(b)(ii)

In MS-excel, users can set the data to be printed in a specific number of pages either by increasing or decreasing 
the size of data.

The steps involved in scaling the printed output are given below,

Click the ‘Page Layout’ tab.

Click on the width box from ‘scale to fit’ group for scaling the width of the output such that printout fits in specific 
number of pages specify the number of pages from width drop down list to fit the output.

Normal View Ql-Excel 

REVIEW VIEW DEVELOPER OFFICE TAB 

Width: AatwHcX Gridlines Headings

View

Ute Skate

1.

2.

• B ' ad91 HOME INSERT

O 5Colors’-
£a===® (aJ Fonts* 

Themes __
, # Effects*

PAGE LAYOUT

in Ga A-
_J IU Mfr Pi 3® tig Ijjn^

Margins Orientation Size Print Breaks Background Print

Scale
3 pages 

: 4 pages

i 6 pages

FORMULAS DATA

w
Area’

Page Setup Options

A IT

A B C D E F

i Name Department Qualification Age Gender Address
2 i Divya ECE BTECH 25 F Abids

13 pages

More Pages...

Click on the height box from ‘Scale to Fit’ group for scaling the height of the output such that printout fits in specific 
number of pages: Specify the number of pages from height drop down list to fit the output.

W 8 " Sh 01 ’ Normal View Ql - Excel

HOME INSERT PAGE LAYOUT FORMULAS DATA REVIEW VIEW DEVELOPER OFFICE TAB

ir%iirts
Themes

Colors ’ 
0 Fonts’ 

__ Effects’

Themes

8 ID 6
Margins Orientation Size Print Ereaks Background Print : n

* Area- „ BJ Scale: Automatic

Width: ^Automatic*; Gridlines Headings 

10 Height '/ View < View

J Print

Pag? Setup

X V i
0 Normal View Ql

8
Name Department Qualification Age Gender Address.

Divya ECE BTECH 25 F Abids ig
Sravanthi CSE DIPLOMA 24 F ' Secunderab □

aTeru 78 r UvrlarahaX....

Ipage
2 pages

3 pages
4 pages
5 pages
6 pages 

pages

pptions ■ j;

Choose ‘Scale’ option from ‘scale to fit’ group for scaling the output from minimum of 10 percent to a maximum 
of 400 percent. User can enter directly or set the scaling percentage using scale spinner arrows.

® a ^5” SSI S » Normal View Ql - Excel

W HOME INSERT PAGE LAYOUT FORMULAS DATA REVIEW VIEW DEVELOPER OFFICE T.AB

B O'
Themes

SJ Colors’ 

0 Fonts’ 

M Effects’

n w
Margins Orientation Size Print Breaks Background Print

v Area’ ’ Titles SScak

Page Setup

Width; Automatic’ Gndlines Headings 

** View View-

Print Print

Scale to Fit Z Sheet Options 15

1(j Height Automatic ’

5.8 HEADER OR FOOTER OPTIONS
Q22. How to add Header and Footer to a report in excel?

Answer :
Header and Footer refers to information appearing at top and bottom margins, respectively. By default, excel prints 

the reports without headers and Footers. The concept of adding Header or Footer to a report enables user to identify the 
reports easily.
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1.

2

The steps for adding header and footer are given below,

Click on ‘View’ tab.

Select ‘Page Layout View’ from workbook views group. The worksheet is displayed in page layout view.

® B *>’ C*' * _ Boofcl-Excel 1 ffl - 0 X
« HOME INSERT PAGE LAYOUT FORMULAS DATA REVIEW ■ VIEW Sign in

I I : B Page Layout V Ruler B Formula Bar 3 H New Window

B Arrange All

□ Split 0 ffi1 -

100% Zoom to
L ;Hide

Switch Macros
Selection i Fteeoe Panes > LJ Unhide e® Windows’ • :

Zoom Window Macros *

Preview

A E C D E F G H I J

2 I

3 i

Click to add header

Clic) |
1

s- i --r 1 . !

-

’ 6 I

r 5 * 7 J

U 1
3. Click on the sections containing text “Click to Add Header” and “Click to Add Footer” to add Header and Footer 

respectively. Header and Footer sections includes with three alignments. They are left, center and right.
Center

4. Click on desired section of the Header and Footer. A “Header & Footer Tools => Design” tab appears on ribbon.

1 B *5’ €** ? Bookl-Excel HEADER & FOOTER TOOLS ? S
HOME INSERT PAGE LAYOUT FORMULAS DATA REVIEW VIEW 1 DESIGN

D D B Cfe S © B® U [□ - Different First Page 3 Scale with Document

Header Footer Page Number Current Current File File Sheet Picture Format Goto Goto { Q Different Odd & Even Pages 0 Align with Page Margins

" " Number of Pages Date Time Path Name Name Picture Header Footer

Header & Footer Header & Footer Elements Navigation Options
A B C 0 E F . G H I

5. In this contextual tab, options like ‘Page Number’, ‘Current Time’, ‘Current Date’ and other can be selected by the
user to automatically add page numbers, date, time and so on in Header and Footer section. User can also add header
and footer by following the steps given below,
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1.

2.

3.

Click on ‘Page Layout’ tab.

Select “Print Titles” command from page setup group.

A page setup dialog box appears on screen.

4.

i Page ] Margins | Htjder'Fcoter ~ Sheet I >

OK N Cancel

Choose “Header/Footer” Tab in page setup dialog box.
g B • iteS-toi ?. . E ~ 9 X
| HOME INSERT PAGE LA YOUT FORMULAS DATA . REWW 'YEW Sign in

f*

13

12

l.:
14

15

16

li
IS

IS

sh
23
?2
23

24

2:

E F G

26

5. Click on the Header or Footer drop-down and select the desired option. If user want to create specific Header or 
Footer, then click on either custom Header or “Custom Footer” button.
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□23. Explain the process of selecting predefined Header and Footer in excel.

\nswer :

The steps for selecting predefined Header and Footer are given below,

Choose ‘View’ tab on ribbon and select ‘Page Layout’ view from workbook views group. The worksheet view is 
changed to page layout view. Click on any of the Header or Footer section. A “Header & Footer Tools => Design” 
tab appears on ribbon.

B *5' ’ BooB [Group!-Excel

I HOME INSERT PAGE LAYOUT FORMULAS DATA REVIEW VIEW

dd 0 maim e

Header Footer Page Number Current Current Fife File Sheet Picture Format (io to Goto 
* * Number of Pages Date Time Path Name Name Picture Header Footer

Header & Footer Header & Footer Elements Navigation

5 X 

Sign in

j Different First Page Scale with Document

.. Different Odd & Even Pages Align with Page Margins

Options

= IX ft86 IT

E H I

Header

Name Department Qualification Age Gender Address Phone No
Sravanthi CSE DIPLOMA 24 F Secunderabad 9478925832

Mariya IT BTECH 28 F Hyderabad 9542587536

Pallavi EEE BTECH 32 F kavadiGuda 9632587412

Lima Bindt CSE MCA 27 F Meerpet 9546324517

Preethi IT MCA 26 F Mettuguda 9584256456

Lavanya CSE BCA 29 F Uppal 9784587623

Dwaraka ECE BTECH 26 F Musheerabad 9365281475

2. Click on any of the three parts of Header in which the predefined Header is to be inserted.

® H *>' C* 5 Bookl-Excel HEADER & FOOTER TOOLS

| HOME INSERT PAGE LAYOUT FORMULAS DATA REVIEW YEW DESIGN

D 0 b

? EE ? X

Sign i

©I

Current
Date

H

X -/

i Ld Different first Page S Scale with Document

Header Footer Page Number Current Current Tilt File Sheet Picture Toms! Goto Goto ig Differ Odd & Even Pages 0 Align with Page Margins
’ * Number of Pages Date Time Path Name Name Picture i H*oo# Footer

Header* Footer

C4

Header a Footer Elements

BTECH

Navigation Options

Header

Name Department Qualification Age Gender Address Phone No
Sravanthi CSE OIPLOMA 24 F Secunderabad 9478925832

Mariya IT BTECH 28 F Hyderabad 9542587536
Pallavi EEE BTECH 32 F kavadi Guda 9632587412

Lima Bindt CSE MCA 27 F Meerpet 9546324517
Preethi IT MCA 26 F Mettuguda 9584256456

Lavanya CSE BCA 29 F Uppal 97S45S7623

Dwaraka ECE BTECH 26 F Musheerabad 9365281475

.... ............................. ...................J....................

■Qic

13?
a
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3. Select the predefined Header, as desired from the “Header” drop down under Headers and Footers group.

Page 1 cf ?

Sheet!

Confidential, 5/26/2018, Page 1 j

Bookl

C:\Usei5\adrhin\Pocuments\8ooltl 

SheetJ,Pagel • ' E

Sheetl, Confidential, Page 1 

Bccld, Pagel .

CAUrers/admin/Dccumerts'' Bookl,Pagel J 

Pagel, Sheet!

Pagel, Bookl 

Pagel, Eockl

Pagel, C/.UsefslsaminWccumentsBcotl 

admin, Page 1, 5/26/2Q18 

Prepared by admin 5/26/2818, Pagel
i ,wrT__^

4. The selected predefined header is inserted into the selected area of Header section.

Predefined Header

Name Department Qualification Age Gender Address Phone No
Sravanthi CSE DIPLOMA 24 F Secunderabad 3478925S32

Mariya IT BTECH 2B F Hyderabad 9542587536

Pailavi EEE BTECH 32 F kavadi Guda 9632587412

lima Binds CSE MCA 27 F Meerpet 9546324517

Preethi IT MCA 26 F Mettuguda 9584256456

Lavarsya CSE BCA 29 F Uppal 3784587623

Dwaraka ECE BTECH 26 F Musheerabad 9365281475
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224. Discuss in detail the Header and Footer element codes in excel.

Answer .: Model Paper-ll, Q13(b)(ii)

Users can add any type of text data in Header or Footer section. In addition to this, users can also insert variable 
^formation by following the steps given below,

Click on any of the Header or Footer section in page Layout View. A “Header & Footer Tools => Design” tab ap
pears on the ribbon.

> B *5- d s f- >

HOME INSERT

Book! - Excel

FORMULAS DATA REVIEW VIEW

HEADER & FOOTER TOQLS

DEVELOPER OFRCETAB DESIGN

? ® - 8 X 

Sign in

D J2 m i ® © a i 0
, cc- O -

Header Footer Page Number Current Current File File Sheet Picture ;
’ ’ Number cf Pages Date Time Path Name Name Pv.ue

Header & Footer Elements

. Gctc 
do Footer

Navigation

... j Different First Page bd Scale with Document

.i Different Odd & Even Pages M Align with Page Margins

................................................................................ ;
V

Fcmtuls Bar
8 ■ BooU fi Nomal View Q1 V * X

......rT

G

T™ 'V r""r..1
I , U ......... K

4 i
5 | 

e I 
7 \ 

i i 
9 ; 
101

Hesde?
'i

Name Department Qualification Age Gender Address
Divya ece BTECH 25 F Abids

Sravanthl CSE DIPLOMA 24 F Secunderabad

Mariya IT BTECH 28 F Hyderabad

Paliavi EEE BTECH 32 F kavadi Gutia

&ma Bindt CSE MCA 27 F Meerpet

Preethi IT MCA 26 F Mettuguda

Lavanya CSE BCA 29 F UpoaS
Qwaraka ECE BTECH 26 F Musheerabad

Click to add hea

Phone No
6939212257

947S925832
9542587536
9632587412
9545324517

9584256456

9784587623

9365281475

r

2. Click on desired button, from ‘Header & Footer elements’ group inorder to insert related code of the button in either 
Header or Footer section.

Various buttons of Header & Footer elements group along with their associated code and functionality are given
below,

(a) Page Number

This button is responsible for inserting page number. Its related code is &[page].

(b) Number of Pages

This button is responsible for inserting number of pages. The related code is &[Pages].

(c) Current Date

This button is responsible for inserting current date. Its related code is &[Date].

(d) Current Time

This button is repsonsible for inserting current time. Its related code is &[Time].

(e) File Path

This button is responsible for inserting both workbook name and complete path of workbook. Its related code 
is &[Path]&[File].

(f) File Name

This button is responsible for inserting the current file name. Also related code is &[File].
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(g) Sheet Name

This button is responsible for inserting current sheet name. Its related code is &[Tab].

(h) Picture

This button allows user to insert a picture. No code exists for this button.

(i) Format Picture

This button enables user to format the picture. Excel provides the flexibility of inserting the following informa
tion in Header & Footer section.

(i) Combination of Text and Codes

User can insert combination of text as well as codes in Header & Footer section. No restriction is imposed 
on the use of number of codes.

(ii) Different Font and Size

In Header & Footer section, users can change the font and size of the text, as desired by the following steps 
given below,

❖ Select the text, whose font and size need to be changed and then click on ‘Home’ tab appearing on the 
ribbon.

❖ Select font and size from corresponding drop down controls in ‘Font’ group.

Another method for changing fonts and sizes is through Mini toolbar, which is displayed when the text in 
the header and footer is selected.

(iii) Multiple Lines

Header or Footer can be multiline. That is, user can enter multiple lines in Header or Footer section where 
each line break is enforced by pressing ‘enter’ button. The top and bottom margins need to be adjusted 

inorder to avoid overlapping of text present in Header or Footer with worksheet data.

Q25. Discuss briefly the Header and Footer options in excel.

Answer :
In Page Layout view, when user clicks on any of the Header or Footer section, Header & Footer Tools => Design 

tab appears on the ribbon. In this contextual tab, various controls or commands of “Options” group allows user to specify 
other options which include the following,

(a) Different First Page

When this option is selected, a different Header/Footer can be given for the first page. That is first page carries a 
different Header/Footer compared to other pages of workbook.

(b) Different Odd & Even Pages

When this option is activated, different Header/Footer can be given for odd numbered pages and even numbered 
pages.

(c) Scale-with Document

By default, this option is activated (or checked). When this option is enabled, the font size of Header/Footer follows 
the size of scaling percentage of the document.

(d) Align Width Page Margins

By default, this option is also activated when this option is enabled, left header and footer, right header and footer 
are aligned with left and right margins respectively.

Q26. How to copy page setup settings of source sheet to other work sheets in excel?

Answer :
Excel applies its default settings related to page setup to every newly inserted worksheet. However, if user want to 

apply page setup of an already existing worksheet, the following steps can be followed.

1. Click on the source worksheet, i.e., the sheet where user wants to copy the page setup settings.
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Choose the target worksheets i.e., the sheets where user wants to apply the page settings. This is done by pressing 
Ctrl key and clicking the descred sheet tabs.

as aHiSffll HOM

SsCo)ors”. ffljFontJ-Th'-nleS Effecti -

Book3 |Gr«i 
DATA REVIEW

9 xSjnwSORMUIAS

cs }**■*•' » ■$ ;

Biota S^'i^saw loerofcc •;Rnr-t ... ..... •< .
t«J« P Sow .■

;«wfc*9» ;• t«a;»««x4 • ff- Up •
'Cl hi* ’iSe'.te-

Choose ‘Page Layout Tab’ the ribbon. Click on ‘dialog box launcher’ appearing at lower right comer of page setup
group.

Ob- <*
saK"--

WSERT x AGE LAYOUT

C 8 Ci

BocW I'Aeuri E«H 
REVIEW .'ff'A

•*** • Sndknei
OnentMicn Sae Biota

Qualification} Age Gender Address |PhoneNo

Atasf-eerabag

• Sftvaii ; Sh«t2 Sheet3

a i ga i.B.

A page setup dialog box appears on screen.

raueavout

a x

Simply click on “OK” button and close the page setup dialog box. By this, the page settings of source sheet are 
copied to all target sheets.
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5.9 PREVENTING CERTAIN CELLS, OBJECTS FROM BEING PRINTED
Q27. How to prevent certain cells from printing in excel?

Answer : Model Paper-ll, Q13(a)

Some times, users may require to avoid printing certain cells of worksheet because these cells may include confidential 
or unnecessary information. Excel-2013 fulfills this requirement of not printing certain cells by following the techniques 
given below,

(i) Hiding Rows or Columns

The steps for hiding rows or columns are given below,

1. Select the rows or columns that users want to hide and then click ‘Home’ tab.

2. Click ‘Format’ command from cells group. A drop down list is displayed.
i ffl - s >

Sign

^Insert • Z ' A™ J 
^Delete ■ IS!’ ’

■ .........

■X Height...

AutoFit Row Height

iQ Column Width.,,

AutoFit Column Width

Default Width.,,

5©rt3t Find& 

Filter’ Select"

1 Hide & Unhide 

Onprnze Sheets

Rename Sheet 

Move or Copy Sheet,,,

. Tab Color 

hetectbs 

j-p Protect Sheet...

$$ Lock Cell

: Ej Format Cells,,.

3. Under Hide & Unhide Option, Choose “Hide Rows” for hiding rows and “Hide Columns” for hiding columns.
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Bind? CSE MCA 27 F Meerpet 954632- O deCoiut«3-.....
------—TTideRew
ds Sheet ••••• ••••—:•

wide

•vtde CcjiawiS

■ f

; Preethi IT MCA 26 F Mettuguda 958425i
i Lavanya CSE BCA 29 F Uppal S7S45S1

: Dwaraka ECE BTECH 26 F vUsheerabat 336528;

!* Delete ’

I CeSSw 

ltl_ height-. 

AvtcFitftcw Height 

Cciumn Width.. 

Auto^t Cehrwt WidtH 

t-tavt-.-.ifth..

5 x 

Sign ii

Fmd&
Select’

-Sheen 

"-'."i—u* Sheet 

Mcvt crCcpy Sheet... 

Tab Cckt 

ftrtertw,

C < Prcitc. Sfteet - 

8 l:d Ce8 

' FoemMCfb-

4. The selected row gets hidden to the user.
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(ii) Hiding Cells

Users can hide the cells using the following methods.

Method I: Changing the Color of Text to Color of Background

The steps for changing the text color to background color are given below, 

1. Choose the text or cells that is not intended for printing.
8! H *>- <♦ sst

HOME

■X- Cut

%Copy -

-'■V- 0 *
PAGE LAYOUT

Bookl - Excel

DEVELOPER OFFICE TABINSERT PAGE LAYOUT FORMULAS DATA REVIEW VIEW

iCilibri -116 A At ” • py Wrap Text i General

m, 6 1 » a- »• »- s sj® «« a*»aa«. ■ $ - %

Clipboard • •'51 Font r» Alignment -s i Nw

’ z" fr Phone No

l_li____________________________ .......................................................... .

ag, ef i§> Is i* ra lrSum' *T a

Insert Delete Fermat ’>°o Ccnditional Fcnnat as Cell 
i Formatting - Table ■ Styles '

? E0 ~ X 

Sign in

Normal View Q1 •

Name department Qualification Age Gender Address Phone No

Divya ECE 3TECH 25 F AOIds WS3M 2257
Srsvsnthi CSE DIPLOMA 24 p Secunderabad 94Z8525832

Mariva IT 3TECH 28 F Hyderabad 9542537536
Pailavi EEE ■ BTECH 32 F kavadt G uda M32387412

Hiroa Sincu CSE MCA 27 F Meerpet 9546324517
Preethi FT MCA 26 . f Mettuguda 9584256456
Lavanya CSE BCA 29 F uppal 97SM587623
Dwaraka ECE STECH 26 F Musheerabad 9365281475

iJRSli
Choose ‘Home’ tab and click on the small drop down arrow appearing to the right of “font color” ‘A’ button in font 
group. A drop-down menu with a palette of colors is displayed. Choose the color from the menu that matches with 
background color.

j Sheet! ;+)

ftfAPl *7 AW«*Gti97342«3» COUNT: 4 SUM: 738 74363MB sg 0

F 1 »ii

® a «>•<*• a &
HOME 

<X.-Cut 

' life Copy - 

•F Fcrniat Painter 

Clipboard ■

« H =

Parte

INSERT PAGE LAYOUT FORN

•iCalifcn -111 <A''

V - ffl - - A
Font H

Bookl - Excel

DEVELOPER OFFICE TAB

0 x

1 E*y Wrap Text K:
fe. *5 (S) Merge & Center - $ ' % * i ao Conditional Format as 

Formatting- Table’
Number r;i Sgses

zL AutpSum 
§4 fill ’

< Clear -

Cells ' EdSirtg

Insert Delete Fermat

Z T It,
Sort & Find & • 
Filter’ Select-

G2 » fx
Q Bookl S' Nc-ma ^ Qi *

593981225; s- :W BOOBIS

Name Department Qualification
ardCows

s %

C=e Colors.

""“"bs Phone No

Divya ECE BTECH ■ tt iiS 88 ■ M
Sravantht CSE DIPLOMA bad

Mariya 5T BTECH
- «&>' 5_

ad
Pailavi EEE BTECH 32 F kavadi Guda

Hiroa Bindu CSE MCA 27 = Meerpet
Preethi IT MCA 26 F Mettuguda
Lavanya CSE BCA 29 P Uppal
Qwaraka ECE BTECH 26 F Musheerabad

IT

Irud’ F AVERAGE: 9234295369 COUNT: 8 SUM: 738 74363108 (

Q- F LSlM ■

3. To see the preview of worksheet, choose ‘print’ option from File menu.
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The modified cells or text gets hidden as shown below,

©

. New

Ope«

• $***

M

Sfwe

tffKTt

CJose

Office Tab

Account

OfitKrflC "

Print

Print

Printer

. , Canon LBP6300

HLfe*... ....... ;.....
Printer Properties

Settings

• ppyi'j Print Active Sheets 
;0:«y print w«- >.<(-.« •he.!'.

Pages t to *

BccU - Excel fi? X

This technique is not suitable in most of the cases.

Method II: Using Three Semi Colors in Custom Number Format

The steps followed to hide the cells using three semicolons are given below,

1. Select the cells that are not required for printing. Right-click on the selected cells and select format cells from the 
shortcut menu.

® 8 * BnnH-Frcl

HHH HOME INSERT PAGEIAYOUT FORMULAS DATA REVIEW VIEW D " ■. • , ... ■..................... ....\................... jlig Copy i
............‘ Ml **»’•* 8

Fort rJS!« jjetiv.

Ci * • X 1X Phon* No 'Jedt.

i:i A 3 j .........C: 0. J E _ ■ F 6 Jj

I Name ApartmentQualification Age Gender Address Phone i

2 Oivya EC: 3TECH 25 ? Abids 63S81Z Serf
3 Srawntfct CSE DIPLOMA 24 ? * Secunderabad
4 Mariya IT BTECH 28 ? -yderabad
5 Paiiatf EEE BTECH 32 s kavadi Gcca 5S22SS?- ..J £«»*in.
e Hima Saida CSE MCA 27 • ? Meer pet qtjfijM" Fr<«»E«5-fc etiX

? Preetbi IT MCA 26 ? Mesujvtt 3584256- Cd^Hjme..
s Lavanya CSE BCA 23 = UOMi
5 Dwarafca EC: 8TECH 26 F Musheeraaad S3«281«» j

2. A “Format Cells” dialog box appears on screen. Choose ‘number’ tab and click on custom category.
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'. Goto “Type Text” box appearing on right side and enter three semicolons(‘44 44 .»? 44 . 44 . >5

4.

i the

Click on “Ok” button to close the format cells dialog box. 

The selected cells get hidden from the sheet as shown below,
® 0 *3 * C* ' Ssi * Li'S ' Ecofcl - Excel

ROME INSERT PAGE LAYOUT FORMULAS DATA REVIEW DEVELOPER OFFICE TAB

BMerae&Center ’ $ • % « $ ^^diticwl Formas; Cell Insert Delete Forma "
Formating- Table- Styles’ - •. CJear-

Alignment ", humbet iii Style; Cells

A B C D E ► S

Name departmentQualification Age Gender Address i

Divya ECE BTECH 25 f Abids

Sravanthi CSE DIPLOMA 24 F Secunderabad

Mariya FT BTECH 28 F Hyderabad

Pallavi EEE BTECH 82 . F kavadi Guda

Hi.’aa 3indu CSE MCA 27 F Meerpet
Preethi ' iT MCA 26 F Mettuguda

Lavanya CSE BCA 29 F Upoaf

Dwaraka ECE BTECH 26 F Musheerabad

? ® - b x 

Sign

Scrt& FindS 
Filter' Select •

f § Jr 1< B ' zt H

(iii)

1.

Hiding an Area

Users can hide a specific rectangular area of work sheet by following the steps given below,
Click on ‘Insert’ tab and choose ‘shapes’ button from ‘illustrations’ group. A shapes gallery is displayed.

B ? BooM - Excel

“ HOME ; INSERT PAGE LAYOUT FORNPJLAS DATA REVIEW VIEW

“ ffll « A *’*’*• fe Hy;
i'i' ~ F-Cetane ^Timeline

PnctTabe Recommended Table Burtnejons -PP'- Recommended „ PixwChart Power Hyperlink Text Symbols
View F-’:-Win/Loss • » -PivotTables

Tables
Chart;

e x 

Sign in

Pictures C
s k .# b,
e Shapes SmartAn Screenshot

h\\noozn.v$$G

AA { } £

A. \\1. LX c <• X-'X3

Rerungtes

□OQQOuuGO

soaixcoooo©®.* 
m-oODra^ooBS 

OO ( 3 I >

efeck fcnwn

4?wr.00o»l5S<3a

Shapes

Kewcter.

ooorWZ $&vuD 
OB 30

Staff’s and Banners
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In Shapes gallery, click, on rectangle (□) thumbnail and drag the mouse in the worksheet to get rectangle shape. 
The rectangle object can be dragged accordingly to get the desired size such that it covers the confidential area.

• Bookl-Excel OBVWGTOCC ? ffl - 0 X
H«S INSERT PAGE LAYOUT FORMULAS DATA REVIEW VIEW FORMAT Sign in

S'WDQO 
ATT.f>OG; 
i ~XA I 1 &

Insert Shapes

Rectangle 1 ’

A E

1

Boold - Excel DRAW^G TOOLS

INSERT PAGE LAYOUT FORMULAS DATA REVIEW VIEW FORMAT

- Aww-

|B||| ’ S^sPeOutline’

•...................... . ’ Q Shape Effects *

Sbsp« Styles Q

A
A- f.-.s

» A’ Or
’ q'L' Selection Psne T • *®* ..

WordArt Styles ss Arrange

Q28. Explain how to prevent objects from printing in excel.
Answer :

In MS-Excel, objects refer to smart arts, shapes, charts etc.

The steps involved in preventing these objects from getting printed are given below,

1. Select ‘Page Layout’ tab and choose ‘Pictures’ from illustrations group.

9 b ♦>’ <*' s a t
HI HOME INSERT i PAGE LAYOUT FORMULAS DA 

4 Store 

SMyApps -

□
6

0 1®
PivotTable Recommended Table Pictures Online

PivotTables Pictures ’

Tables ' Illustrations

from File
Oil ■ A

insert pictures from your computer

6 BeokS* 2
cr ffcm c}!l€r computers that you're

connected to.

A B

1
0 Tell me more

2. A ‘Insert Picture’ dialog box appears on screen.
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3. Select the picture from the dialog box and then click on “Insert” button. The selected picture will be inserted on the 
worksheet.

4. To prevent this picture from printing, right click on it and choose “Format Picture” option from the menu.

lX Cut
1
% Copy 

q Paste Options:

6

Change Picture.,.

H Group 
% Bring toy 

SendfcBack
——— .......— — ■■■

Hyperlink... 

ign Macro..,

°|] Sice and Properties,, 

Fermat Picture,,,

View Q1

Style Crop

5. A format picture pane appears typically on right-side of screen.

oLJ;
Format Picture

6 e ii

r SHADOW
r REFLECTION
t GLOW
r son EDGES
i> 3-D FORMAT
t 3-D ROTATION

i ARTISTIC EFFECTS

I Picture

» X

6. Click on ‘size & properties’ icon in format picture dialog box.
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7. Expand the properties section by clicking on the arrow beside it.

Format Picture

& o

SIZE

PROPERTIES

O Move and size with cells 

Move but don't size with cells

O Don't move or size with cells 

0 Print object 

0 Locked © .

. . ■ Lock text:

t> TEXTBOX

t> ALT TEXT

8.

9.

In properties section, uncheck or disable the checkmark that appears before print object.

Choose print option from file menu to see the preview of worksheet. The object or picture is not displayed in preview 
as shown below,

BccfeS - Excel

Sign in

We didn't find anything tc print

? - 5 X
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ION

5.10 CREATING CUSTOM VIEWS OF YOUR WORKSHEET

Q29. What are the steps considered while creating custom views for a worksheet in excel?

Answer : Model Paper-Ill, Q13(a)

In MS-Excel, custom views feature allows users to create multiple views for a worksheet. Every single view car
ries specific settings, so that user can easily move from one view to another as desired. The different settings that can be 
included in a custom view includes the following,

(i) A view with some hidden rows and columns

(ii) A view with selected cells and ranges

(iii) A view with frozen panes

(iv) A view with zoom factor
. - ' . ' ' ' 1

(v) A view with page and filter settings.

Custom views saves time when user need to repeatedly define particular settings.

The steps for creating custom views are given below,

1. Specify the desired view settings on a worksheet inorder to save it as custom view, (for instance, consider full display 
of worksheet without changes (or settings) as one custom view).

2. Click on ‘Page Layout Tab’ and choose custom views from workbook views group. A custom views dialog box 
appears on screen.

*>•<*• a !<•#• S » . ?-s

HOME INSERT PAGELAVOUT FORMULAS DATA REVIEW MEW I DEVELOPER OEHCETAS

□ fT ? 0 • ~ H s A ®p n,
— i-bi , n E...J u i “w i

s x

Sign in

1 Fbb . bd Formula Bar
P^Hide i ' S'ivlir-'.t S ' = p

Page Break Page Custom ■ iyi Gridlines B Headings Zoom 199% Zoom to New Arrange Freeze m; ; ' Switch Macros
Preview Layout Views Selection Window AH Panes’ 26 Reset Wmdcw Poston v/indews*

Workbook Views Show Window
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3. Click on ‘Add’ button in dialog box. An ‘Add View’ dialog box appears on screen. Type the name for the view in 
the name text box.

4. In “Include in View” section of add view dialog box, user can specify whether to include settings like “Print Set
tings” or “Hidden row, Column and Filter Settings” in the view. Check and uncheck as desired and click on ok 
button.

H *3' <* a I"®-0 = •
HOME INSERT PAGE LAYOUT FORMULAS DATA REW W DEVELOPER OFFICE TAB Sign in

a QS B "5 a E2”rid
CD View Side by Side

! k--:<Page Break Page Custom > Gndtme /Headings ‘■ccm Zecmtc New Arrange Freece 
Previe* Layout View Selection Window AB Panes'

Switch Macros 
Windows ’

Maaes

All the named views are included under view section in custom views dialog box. To see or view one specific view 
from named views, just select the view and click on “Show” button. The selected view will be displayed. The “Delete" 
button is used to delete specific view from the list. The custom view option do not appear in the workbook (i.e., disabled 
if the worksheet contains a table.
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5.11 CREATING PDF FILES------ —..........
Q30. How to save excel worksheet in PDF or XPS format?

Answer : Model Paper-Ill, Q13<b)(ii)

The concept of saving excel worksheet to PDF format allow users to open the file even without office installation. 
PDF stands for “Portable Document Format”. It is the most commonly used electronic file format providing fixed-layout. 
The contents of PDF cannot be modified easily. Microsoft developed an alternate file format to PDF called XPS(XML 
paper specification)

1.

The steps involved in saving excel worksheet to PDF/XPS format are given below, 

Click ‘File’ tab and select export option from the appeared screen.

Export

Mi Create a Docuraen!

* Presents layout. fc»rni«tin<i fonts, and image; 

8 Content oatftfce easily changed

* Free viewers are available on the webChange File Type

Create
PDF/XPS

2. In export gallery, click on “Create PDF/XPS” button. Upon clicking, “Publish as PDF or XPS” dialog box appears 
on screen.
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3. Click on “options” button to adjust the settings for PDF file. An options dialog box appears on screen. Adjust the 
settings accordingly and click “OK” button.

4. Type the name for PDF in FileName box.

5. Click on “Publish” button. A PDF is created for the corresponding excel file and it is displayed on the screen.

ft crating PDfRIcpcf-Adobe Reader

File Edit View Window Help X

a 01 @ i / i reels jgS ign i Comment [

A

fCftdc on Tools to convert 
PDF documents to Word or 

* Excel.

Name Department Qualification Age Gender
Divya ECE BTECH 25 F

Sravanthi CSE DIPLOMA 24 F

Mariya IT BTECH 28 F

Pallavi EEE BTECH 32 F

Hima Bindu CSE MCA 27 F

Preethi IT MCA 26 F

Lavanya CSE BCA 29 F

Dwaraka ECE BTECH 26 F
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INTERNAL ASSESSMENT
I. Multiple Choice Questions

1. ________ .view may or may not show page breaks. [ ]

(a) Normal

(b) Page Layout

(c) Page Break Preview

(d) None of the above

2. Excel provides___________quick margin settings.

(a) One

(b) Two

(c) Three

(d) Four

3. Click the show margins button in the___________comer to display the margins in the preview pane. [ ]

(a) Bottom-left

(b) Bottom-right

(c) Top-left

(d) Top-right

4. ___________ information appears at the bottom of each printed page. [ ]

(a) Footer

(b) Header

(c) Both (a) and (b)

(d) None of the above

5. ___________displays the worksheet and shows where the page break occurs. [ ]

(a) Normal View

(b) Page Layout View

(c) Page Break Preview

(d) None of the above

6. Vertical ruler is used to adjust___________margins. [ ]

(a) Top and bottom

(b) Left and right

(c) Top and left

(d) None of above
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7. ______ technique is used to prevent certain parts of work sheet from printing. [ ]

(a) Hide rows or columns

(b) Hide cells or ranges

(c) Mark an area

(d) All the above

8. A view includes settings for the___________. [ ]

(a) Hidden rows & columns

(b) Work sheet

(c) Zoom factor

(d) Both (a) and (c)

9. An alternative to PDF format is___________ . [ ]

(a) XPS

(b) XML

(c) HTML

(d) None of the above

10. The row and column headers can be printed by selecting Page Layout => Sheet options => _________=> print.

[ 1

(a) Row header

(b) Column header

(c) Headings

(d) None of the above

II. Fill in the Blanks

1. ________ are indicated by horizontal and vertical dotted lines.

2. ________ refers to how output is printed on the page.

3. ________ are the unprinted areas or white spaces along the sides, top and bottom of a printed page.

4. Move the cell pointer to the cell that will begin the new page inorder to insert________ page break line.

5. ________ information appears at the top of each printed page.

6. The properties tab of objects format dialog box need to be accessed inorder to prevent________ from being printed.

7. ________ feature allows user to give names to various views of worksheet.

8. ________ is electronic paper format used by excel to export worksheets.

9. Select page layout -> scaled to fit -> scale to enter a________ .

10. ________ ruler is used to adjust the left and right margins.
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KEY

I. Multiple Choice Questions

1- (a)

2. (d)

3- (b)

4. (a)

5- (c)

6. (a)

7. (d)

8. (d)

9- (a)

10. (c)

II. Fill in the Blanks

1. Page breaks

2. Page orientation

3. Margins

4. Horizontal

5. Header

6. Objects

7. Custom views

8. XPS (or) PDF

9. Scaling factor

10. Horizontal
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Q9. Explain the general process of creating a workbook by entering data into it.

Answer :

For answer refer Unit-I, Page No. 19, Q.No. 18.

Important Question

Q10. Discuss the steps involved in creating a new chart.

Answer :

For answer refer Unit-I, Page No. 25, Q.No. 20.

important Question

Q11. Write the steps involved in printing a worksheet.

Answer :

For answer refer Unit-I, Page No. 27, Q.No. 21.

Important Question

Q12. What are the different data types that a cell can hold in Excel?

Answer :

For answer refer Unit-I, Page No. 29, Q.No. 23.

Important Question

Q13. Explain the process of modifying cell contents.

Answer :

For answer refer Unit-I, Page No. 30, Q.No. 24.

Important Question

Q14. Explain how numbers can be entered and formatted in spreadsheets.

Answer :

For answer refer Unit-I, Page No. 38, Q.No. 26.

Important Question

Q15. Explain in detail about Auto formatting and Manual formatting.

Answer :

For answer refer Unit-I, Page No. 39, Q.No. 27.

Important Question

Q16. Explain the concept of styles in MS-Excel.

Answer :

For answer refer Unit-I, Page No. 39, Q.No. 28.

Important Question

Q17. Write short notes on the following,

(a) Formatting numbers using the Ribbon.

(b) Formatting numbers using the shortcut keys.

Answer :

For answer refer Unit-I, Page No. 40, Q.No. 29.

Important Question
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o
Unit- Z

SHORT QUESTIONS

Q1. List the different ways of closing windows.

Answer :

For answer refer Unit-II, Page No. 46, Q.No. 2.

Important Question

02. How to perform multisheet selection?

Answer :

For answer refer Unit-II, Page No. 46, Q.No. 4.

Important Question

Q3. Explain any four options present in go to special dialog box.

Answer :

For answer refer Unit-II, Page No. 47, Q.No. 5.

Important Question

04. Discuss the process of copying and pasting using shortcut menus.

Answer :

For answer refer Unit-II, Page No. 47, Q.No. 7.

Important Question

Q5. List some of the important facts regarding office clipboard.

Answer :

For answer refer Unit-II, Page No. 47, Q.No. 8.

Important Question

06. What are the steps involved in making the change shape option available?

Answer :

For answer refer Unit-II, Page No. 48, Q.No. 10.

Important Question

ESSAY QUESTIONS

Q7. Describe the process of adding, deleting and activating a worksheet in a workbook.

Answer :

For answer refer Unit-II, Page No. 50, Q.No. 12.

Important Question

□8. Write short notes on the following,

(i) Zooming worksheets

(ii) Viewing a worksheet in multiple windows

(iii) Comparing sheets side-by-side.

Answer : Important Question

For answer refer Unit-II, Page No. 54, Q.No. 16.
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Q9. List the different ways of selecting range of cells and complete rows and columns.

Answer :

For answer refer Unit-II, Page No. 55, Q.No. 17.

Important Question

Q10. How non-contiguous ranges can be selected in excel 2013?

Answer :

For answer refer Unit-II, Page No. 56, Q.No. 18.

Important Question

Q11. Discuss about the following,

(i) Drag and drop method of copying or moving

(ii) Copying to adjacent cells

(iii) Copying a range to other sheets.

Answer :

For answer refer Unit-II, Page No. 60, Q.No. 23.

Important Question

Q12. Describe the process of pasting using office clipboard.

Answer :

For answer refer Unit-II, Page No. 61, Q.No. 24.

Important Question

Q13. Discuss various paste options offered by excel 2013 for pasting in special ways.

Answer :

For answer refer Unit-II, Page No. 62, Q.No. 25.

Important Question

Q14. Write short notes on adding and formatting comments.

Answer :

For answer refer Unit-II, Page No. 65, Q.No. 27.

Important Question

Q15. Discuss the following operations on comments,

(i) Changing shape

(ii) Reading

(iii) Printing

(iv) Hiding and unhiding

(v) Selecting

(vi) Editing

(vii) Deleting.

Answer : Important Question

For answer refer Unit-II, Page No. 66, Q.No. 28.
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Unit-O

SHORT QUESTIONS ’

31. Write the steps for table creation in an empty range.

vnswer : Important Question

For answer refer Unit-III, Page No. 74, Q.No. 1.

32. Write a short note on navigation in excel.

Answer : Important Question

For answer refer Unit-111, Page No. 74, Q.No. 2.

33. Write the steps for removing a filter.

Answer : Important Question

For answer refer Unit-Ill, Page No. 74, Q.No. 3.

04. What are the steps involved in inserting slicers?

Answer : Important Question

For answer refer Unit-III, Page No. 74, Q.No. 4.

35. Write the steps for converting table back to range.

Answer : Important Question

For answer refer Unit-III, Page No. 74, Q.No. 5.

36. What are the different ways for performing sorting in excel?

Answer : Important Question

For answer refer Unit-III, Page No. 75, Q.No. 7.

ESSAY QUESTIONS

37 Define a table and write the steps involved in creation of a table in excel.

Answer : Important Question

For answer refer Unit-III, Page No. 76, Q.No. 9.

36. How can a user select various parts of a table?

Answer : Important Question

For answer refer Unit-III, Page No. 84, Q.No. 11.

39 Describe the method for moving a table to new location.

Answer : Important Question

For answer refer Unit-III, Page No. 88, Q.No. 13.
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Q10. Write short notes on working with the total row in excel.

Answer :

For answer refer Unit-Ill, Page No. 90, Q.No. 14.

Q11. Discuss the method for removing duplicate rows from a table.

Answer :

For answer refer Unit-Ill, Page No. 91, Q.No. 15.

Q12. Explain in detail about filtering a table.

Answer :

For answer refer Unit-Ill, Page No. 94, Q.No. 17.

Q13. Where are the cell formatting tools available in Excel?

Answer :

For answer refer Unit-Ill, Page No. 99, Q.No. 19.

Q14. List out the most commonly used alignment commands in the excel 2013.

Answer :

For answer refer Unit-Ill, Page No. 100, Q.No. 21.

Q15. Write the steps involved in changing the color of a text and background.

Answer :

For answer refer Unit-Ill, Page No. 102, Q.No. 23.

Q16. Write about adding borders and lines in Excel.

Answer :

For answer refer Unit-Ill, Page No. 103, Q.No. 24.

Q17. Write the steps involved in,

(i) Applying styles to a cell

(ii) Modifying an existing style

(iii) Creating new styles

(iv) Merging styles from other workbooks

(v) Controlling styles with templates.

Answer :

For answer refer Unit-Ill, Page No. 107, Q.No. 25.

Important Question

Important Question

Important Questio'

Important Quesbo*

Important Questo-

Important Quesaor

Important

Important Questio'
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Unit-4

SHORT QUESTIONS

Q1. Discuss any five options of opening a file from open dialog box.

Answer : Important 'Xrr. id

For answer refer Unit-IV, Page No. 118, Q.No. 2.

Q2. Write short notes on recovering versions of workbook.

Answer : Important Qo**

For answer refer Unit-IV, Page No. 119, Q.No. 4.

Q3. How to modify a template?

Answer : Important Oi* i—

For answer refer Unit-IV, Page No. 119, Q.No. 6.

Q4. What is the process of locating XLStart folder?

Answer * Important Que-s :

For answer refer Unit-IV, Page No. 119, Q.No. 7.

Q5. Write short notes on custom templates.

Answer : Important Quest:

For answer refer Unit-IV, Page No. 119, Q.No. 8.

ESSAY QUESTIONS

Q6. Explain how workbooks are created and opened in Excel-2013. Also discuss about filtering 
filenames.

Answer : Important Questior

For answer refer Unit-IV, Page No. 120, Q.No. 9.

Q7. Discuss various ways of saving workbook.

■Answer : Important Question

For answer refer Unit-IV, Page No. 123, Q.No. 10.

Q8. Write short notes on AutoRecover feature of Excel-2013.

.Answer : Important Question

For answer refer Unit-IV, Page No. 124, Q.No. 11.
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Q9. Discuss various options available in protect workbook drop-down list. Describe the process of passworc 

protecting a workbook.

Answer : Important Question

For answer refer Unit-IV, Page No. 125, Q.No. 12.

Q10. Write about checking compatibility of excel files workbooks.

Answer :

For answer refer Unit-IV, Page No. 127, Q.No. 14.

Important Questio-

Q11. Define a template. Discuss how a workbook can be created from a template. Also discuss the process 

of modifying a template.

Answer : Important Questior

For answer refer Unit-IV, Page No. 128, Q.No. 15.

Q12. Explain the three types of templates supported by Excel.

Answer :

For answer refer Unit-IV, Page No. 130, Q.No. 16.

Q13. Discuss in detail about creating and saving custom templates.

Answer :

For answer refer Unit-IV, Page No. 131, Q.No. 18.

Q14. List some of the settings that can be adjusted and used in custom templates.

Answer :

For answer refer Unit-IV, Page No. 133, Q.No. 19.

SHORT QUESTIONS

Q1. What are the different views of excel worksheet?

Answer :

For answer refer Unit-V, Page No. 140, Q.No. 1.

Q2. What are the steps followed for adjusting the printer settings?

Answer :

For answer refer Unit-V, Page No. 140, Q.No. 3.
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Q3. Discuss briefly about page breaks in excel.

Answer :

For answer refer Unit-V, Page No. 141, Q.No. 6.

■’j'iiO £.**•

Important Question

Q4. Discuss the steps involved in printing row and column headers in excel.

Answer :

For answer refer Unit-V, Page No. 141, Q.No. 7.

Important Question

Q5. How to scale the printed output?

Answer :

For answer refer Unit-V, Page No. 142, Q.No. 9.

Important Question

ESSAY QUESTIONS

Q6. Discuss briefly the page layout view of excel worksheet.

Answer :

For answer refer Unit-V, Page No. 145, Q.No. 12.

Important Question

Q7. Explain the steps followed in choosing the printer. Also explain the steps for specifying what to print.

Answer : Important Question

For answer refer Unit-V, Page No. 147, Q.No. 14.

Q8. Describe the process of changing page orientation.

Answer :

For answer refer Unit-V, Page No. 149, Q.No. 15.

Important Question

09. Explain in detail the process of adjusting page margins.

Answer :

For answer refer Unit-V, Page No. 152, Q.No. 17.

Important Question

Q10. Explain the process of inserting a page break.

Answer t

For answer refer Unit-V, Page No. 156, Q.No. 18.

Important Question

011. Explain how to specify the row and column titles on printed page in excel.

Answer :

For answer refer Unit-V, Page No. 158, Q.No. 20.

Important Question

Q12. List the steps involved in scaling the printed output in excel.

Answer : Important Question

For answer refer Unit-V, Page No. 160, Q.No. 21.
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Q13. Discuss in detail the Header and Footer element codes in excel.

Answer : Important Quest

For answer refer Unit-V, Page No. 165, Q.No. 24.

Q14. Discuss briefly the Header and Footer options in excel.

Answer : Important Questor

For answer refer Unit-V, Page No. 166, Q.No. 25.

Q15. How to prevent certain cells from printing in excel?

Answer : Important Questor

For answer refer Unit-V, Page No. 168, Q.No. 27.

Q16. What are the steps considered while creating custom views for a worksheet in excel?

Answer : Important Questxr

For answer refer Unit-V, Page No. 175, Q.No. 29.

Q17. How to save excel worksheet in PDF or XPS format?

Answer : Important Questor

For answer refer Unit-V, Page No. 177, Q.No. 30.
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